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Executive Summary 

This deliverable is intended as a collection of quantitative and qualitative methods for 
observing and analysing the needs and behaviours of road users, with the aim of making 
streets safer, healthier and happier.  In line with the JUST STREETS conceptual framework 
and definition of street justice (see D2.1), this deliverable emphasises inclusivity and 
diversity. It does this by combining different methodologies and approaches to street justice. 
It serves as a practical resource to inspire and guide cities in their data and knowledge 
collection processes. 

The document summarises the results of Task 3.1, which aimed to provide methods for 
analysing the needs, behaviours and mobility patterns of social groups that are more 
susceptible to traffic-related danger, underrepresented in mobility planning processes and 
less influential in the everyday appropriation and use of streets. This deliverable plays a 
crucial role in advancing the JUST STREETS project by providing methodologies and 
recommendations that align with its goal of creating inclusive, safe, and inviting urban areas. 
In addition to presenting the methods, the document provides practical examples and 
applications to the JUST STREETS project and its pilot cities, as well as recommendations. 
The outlined methods range from broad overviews of key approaches to detailed protocols 
for implementing selected methods, and an infographic summarising the method’s usability 
and requirements is provided at the end of each section. This document therefore acts as a 
valuable resource for city planners, urban designers, policymakers, community 
organisations, and researchers who aim to collect and analyse data and knowledge to 
improve street justice. 

Following the introduction, the document is structured into four sections. Section two, 
authored by Politecnico di Torino (PoliTO), illustrates methods for assessing road safety by 
observing and analysing the spatial-temporal trajectories of road users. Section three, written 
by the University of Amsterdam (UvA) and Politecnico di Torino (PoliTO), describes 
qualitative approaches, such as interviews, focus groups, participant observation, 
participatory mapping, experiments, and action research, which require direct interaction with 
people and are useful for understanding issues related to street justice. Section four, 
authored by the University of Western Norway (HVL), provides guidelines for collecting, 
processing and analysing spatial data, usage patterns and street user behaviour. The 
proposed protocol is based on syntactic methods such as Space Syntax, which allow us to 
examine how street structures influence urban use at network and street levels. Section five, 
authored by the Technion – Israel Institute of Technology, the Links Foundation (Links) and 
the IT University of Copenhagen (ITU), provides selected methods and tools for conducting 
GIS analyses on walkability, accessibility, visibility, safety and security. These methods and 
tools are available through open platforms, and the section provides step-by-step tutorials for 
performing these analyses. It also applies these methods in some of the JUST STREETS 
pilot cities. 
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1. Introduction 

1.1 Purpose and scope 

This deliverable is intended as a collection of quantitative and qualitative methods for 
observing and analysing the needs and behaviours of road users, with the aim of making 
streets safer, healthier and happier.  In line with the JUST STREETS conceptual framework 
and definition of street justice (see D2.1), this deliverable emphasises inclusivity and 
diversity, combining different methodologies and approaches to street justice. It serves as a 
practical resource, inspiring and guiding cities in their data and knowledge collection 
processes. It adds value to existing literature and research by providing a practical collection 
of methods that approach street justice from various perspectives and disciplines, ranging 
from transport engineering to the social sciences. 

JUST STREETS aims to support eight pilot cities and four followers in revolutionising public 
spaces and streets by prioritising sustainable and inclusive active mobility. The project 
addresses the urgent need to transform streets from infrastructural and behavioural 
perspectives, moving away from car-centric environments towards streets that prioritise the 
needs of all citizens. Particular attention is given to marginalised groups such as migrants, 
LGBTQI+ communities, and disabled individuals, ensuring their voices are heard and actively 
incorporated into the planning and development process. 

This document summarises the results of Task 3.1, 'Analysis of the needs and mobility 
behaviours of active road users and integration with cross-domain data', which forms part of 
Just Streets Work Package 3, 'Just Improve'. WP3 aims to establish methodologies for data 
collection and knowledge creation to reduce danger and increase justice on our streets in 
relation to traffic. Task 3.1 aimed to provide methods to analyse the needs, behaviours and 
mobility patterns of social groups that are more susceptible to traffic-related danger, 
underrepresented in mobility planning processes and less empowered in the everyday 
appropriation and use of streets. This deliverable plays a crucial role in advancing the JUST 
STREETS project, providing methodologies and recommendations that align with the 
project's goal of creating inclusive, safe, and inviting urban areas. It directly contributes to the 
project’s mission of transforming streets to prioritise active mobility and address the needs of 
marginalised groups. It will also help cities to collect and analyse knowledge to inform the 
implementation of actions in WP4 and the evaluation in WP5. 

In addition to presenting the methods, this text provides some practical examples and 
applications to the JUST STREETS project and its pilot cities (see sections 3, 4 and 5), as 
well as recommendations. The outlined methods range from broad overviews of key 
approaches to detailed protocols for implementing selected methods. Some sections 
explicitly state who the potential readers and beneficiaries of the work developed in those 
sections are. Section four, in particular, makes it very clear that the method can be useful for 
beginners, intermediate users and advanced users, and provides guidance for the different 
levels. The other sections do not provide such detailed guidance either because they require 
specialised knowledge and skills (Section 2), or because they can be applied by a broad 
spectrum of users without specific methodological boundaries (Section 3). An infographic 
summarising the method’s usability and requirements is provided at the end of each section. 
This document is therefore a valuable resource for city planners, urban designers, 
policymakers, community organisations, and researchers who aim to collect and analyse 
data and knowledge to improve street justice. 

In describing this, we acknowledge that any method of measuring or influencing it is never 
objective, neutral or value-free. By definition, they take a position on what is considered to be 
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the problem and limit what we see as solutions. While we take special care to make this as 
transparent as possible, particularly in Section 3, we strongly advise readers to reflect on the 
choices and implicit assumptions underlying each discussed method. They should also 
critically consider how these choices and assumptions might lead their thinking and actions 
towards more or less effective pathways to just streets. 

1.2 A balance between qualitative and quantitative methods 

The methods presented in this deliverable aim to improve knowledge of the needs and 
behaviours of road users, with specific emphasis on those who are too often overlooked in 
mobility planning, design and practice, including young people, children, women, people with 
disabilities, the elderly, non-white ethnic groups and more marginalised groups (see D2.1 for 
a more detailed overview).  The methods presented in the following sections will be both 
quantitative and qualitative. Both approaches have their own advantages and complement 
each other rather than being superior to one another. The JUST STREETS cities will choose 
to adopt one or more of these methods depending on their respective objectives, the nature 
of the data, and the expertise and skills required. 

Quantitative methods (e.g. statistical and data analysis, and surveys with numerical 
responses) allow numerical data reflecting the traits of a sample to be collected and 
generalised to a larger population. This is useful for identifying trends, patterns and 
correlations across different areas. For example, in the field of road safety, it is useful for 
determining the relationship between crash frequency and severity and speed limits and 
traffic volume. These methods offer precise, measurable results, enabling researchers to 
assess the effectiveness of specific interventions and identify relevant factors based on 
statistical significance. Quantitative data are also used to build predictive models that support 
proactive planning, design decisions, and policy-making. 

However, while quantitative data can identify correlations among relevant factors, it does not 
always fully explain why certain behaviours occur or how various contextual factors interact 
with personal competencies and capabilities. Furthermore, quantitative analysis relies on 
accurate and comprehensive data, which is not always available or fully reliable. 

Conversely, qualitative methods such as interviews, focus groups, case studies and 
observational research complement quantitative data by explaining the 'why' behind 
observed patterns. Qualitative research can capture human factors that are essential for a 
deeper understanding than mere statistics can provide. They can be adapted to different 
contexts and allow new issues or emerging trends to be explored that may not have been 
previously considered. Qualitative methods can also be considered tools for integrating the 
knowledge of planners and experts by incorporating the perspectives and voices of 
individuals and organisations who use and experience public spaces such as streets every 
day, through participatory approaches and action research. Reflecting and debating with 
diverse stakeholders can foster a positive cycle of social learning and professional growth, 
contributing to a better understanding of the different types of street justice (distributive, 
procedural and recognitional; see deliverable 2.1 for more information). 

Finally, quantitative methods enable outcomes to be measured and quantified on a large 
scale, while qualitative methods help us to understand the nuances of human behaviour, 
contextual factors, diverse perspectives, and voices. In JUST STREETS, these methods are 
therefore seen as complementary, and there is a constant effort to integrate and bridge 
different methodological approaches. Through this mixed approach, JUST STREETS 
combines the strengths of quantitative and qualitative methods to provide a more holistic 
view of how to redesign streets and encourage safer, more sustainable and active modes of 
individual mobility. 
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1.3 Structure of the document 

The document (D3.1 - draft 2) is structured in four sections following this introduction.  

Section two, authored by Politecnico di Torino (PoliTO), illustrates methods of assessing 
road safety through the observation of interactions between road users (e.g. pedestrians, 
cyclists and drivers) and the analysis of their spatial-temporal trajectories. These results help 
engineers redesign streets and traffic control systems to reduce the risk of collisions. Starting 
with a definition of some basic road safety concepts, this section proposes: (i) an objective, 
quantitative method of measuring traffic conflicts using LiDAR; and (ii) comparative before-
and-after methodologies for interpreting the benefits of street interventions.  

Section three, authored by University of Amsterdam (UvA) and Politecnico di Torino 
(PoliTO), illustrates qualitative approaches such as interviews, focus groups, participant 
observation, participatory mapping and experiments and action research that require direct 
involvement with people and are particularly useful for understanding both issues related to 
street design and use and, more generally, to street justice.  The choice of the method(s) to 
be used depends on the initial problems and knowledge needs, involving various 
stakeholders, skills and resources, and often the combination and integration of several 
methodological approaches allows for a more accurate and deeper understanding of the 
different perspectives and needs at stake in street design and planning processes. The 
methods presented help to generate different materials, such as audio recordings, 
transcripts, field notes, maps, artistic works or street experiments, which require specific 
analyses. The aim is to inspire experts and practitioners to integrate these methods with 
other available data, enhancing different ways of understanding street use and design to 
develop more just streets. 

Section four, authored by Western Norway University of Applied Sciences (HVL), provides 
guidelines for collecting, processing and analysing spatial data needs, usage patterns and 
street user behaviour. The proposed protocol is based on syntactic methods, such as Space 
Syntax, that allow us to examine how the structure of streets influences urban use from 
network level and at street level. This approach differs from more direct approaches, such as 
observing street users’ behaviour, focusing instead on urban organization and morphology to 
predict and identify user needs and behaviour. The proposed methodology is modulated for 
the needs of beginners, intermediate and advanced users, introduces the key principles of 
syntactic methods and microscale analysis, and describes what data to collect, the most 
suitable types of analysis and the most common GIS workflows for integrating different types 
of data, favouring open-source data. In addition, through practical guides and tips, a 
comprehensive protocol based on GIS and Space Syntax tools is proposed, standardizing 
procedures for data collection and analysis and establishing efficient workflows.  

Section five, authored by Technion – Israel Institute of Technology, Links Foundation (Links) 
and IT University of Copenhagen (ITU), provides selected methods and tools available 
through open platforms for conducting GIS analyses on walkability, accessibility, visibility, 
safety, and security. These are objective measures to evaluate public open spaces. It 
provides step-by-step tutorials for performing these analyses. The methods are intended to 
be applied in the evaluation of the JUST STREETS pilot cities. However, due to the limited 
availability of data from city partners or open portals at this stage, the section provides 
descriptions of the methods and tools to be used. In addition, it applies the methods in some 
of the JUST STREETS pilot cities. 
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2. Field data to measure objective safety 

This section provides an overview of the method to measure safety while observing road 
scenes (3). Current practice uses video sequences from which trajectories of pedestrians, 
cyclists, and drivers/vehicles can be obtained as per the image analysis techniques. 
Trajectory data are then analysed to extract information on how users interact with each 
other, and to understand if such interactions are safe or not. Road engineers use such 
quantitative and objective results to understand how to redesign the road environment, the 
road geometrics, and/or the traffic control systems to reduce the probability of observing a 
crash in the future. 

To explain why this method is proposed for JUST STREETS living labs, in this section we 
present (i) some basic concepts about road safety analysis, (ii) estimation and classification 
of road conflicts, (iii) technologies to detect conflicts with a specific emphasis on (iv) LiDAR, 
(v) field surveys, (vi) before/after safety studies. Finally, this Section ends with the proposed 
technology to measure objective safety for JUST STREETS. 

2.1 Sub-chapter title 

Road safety is a broad discipline that studies how to minimise the frequency and severity of 
crashes using all the tools, knowledge and technology currently available (4). Road safety is 
measured using a variety of indicators and methodologies, which include: 

1. crash data from official databases, that are used to estimate the amount, severity, and 
road crash types over a specific period. Through them, analysts can provide 
descriptive statistics, but more importantly, statistical models to estimate the likelihood 
of crashes based on various factors such as road type and geometrical 
characteristics, traffic factors, and environmental conditions. Statistical models 
provide insights on fatalities, injuries, and property damages to be expected on roads; 

2. conflict indicators from field observation, with the aim of monitoring near-misses and 
other risky interactions between road users, which can help identify potential hazards 
before they result in crashes; 

3. road user behaviour through field surveys or observational studies to provide data 
about speeding, seat belt use, driving under the influence, and other behavioural 
factors; 

 
3 Suggested readings on this topic follow: 
• Aldred, R., & Crook, L. (2018). "Understanding Road Safety: The Use of Conflict Data." Journal of 

Transport Geography, 69, 223-231. (This article discusses how conflict data can provide a more 
nuanced understanding of road safety issues compared to traditional crash data). 

• Elvik, R., & Vaa, T. (2004). "The Importance of Conflict Studies in Road Safety." Accident Analysis 
and Prevention, 36(5), 843-851. (This paper reviews various conflict studies and their implications 
for understanding and improving road safety). 

• Hauer, E. (1997). "Conflicts: A New Look at the Concept." Transportation Research Record, 1570, 
1-8. (This paper discusses the concept of conflicts and their relevance in predicting crashes). 

• Jiang, Y., & Wu, J. (2016). "Use of Traffic Conflict Techniques to Evaluate Road Safety." Safety 
Science, 81, 169-178. (This study evaluates how conflict techniques can be utilized to assess road 
safety and prevent crashes). 

• Valero, E., & Ares, E. (2020). "Near-Miss and Conflict Analysis: A Review of the Literature." Journal 
of Transportation Safety & Security, 12(3), 256-276. (This review highlights the effectiveness of 
near-miss and conflict analysis in road safety research). 

4 Adapted from: Carter, D., Gelinne, D., Kirley, B., Sundstrom, C., Srinivasan, R., & Palcher-Silliman, J. 
(2017). Road safety fundamentals: Concepts, strategies, and practices that reduce fatalities and 
injuries on the road (No. FHWA-SA-18-003). United States. Federal Highway Administration. Office of 
Safety. 
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4. road safety audits and inspections, where safety experts conduct systematic safety 
assessments of projects and existing roads to identify safety issues and recommend 
improvements. 

By using a single method or a combination of them, engineers gain an understanding of road 
safety, develop targeted interventions and evaluate objective benefits. 

It is worth noting that the frequency and severity of a site's crashes are considered the best 
indicators of safety for several reasons. They provide an objective quantitative measurement 
of the occurrence and impact of crashes over time. Historical crash data help identify 
patterns, enabling the evaluation of the effectiveness of safety measures and policies. When 
well geo-localized, crash data are used to identify hotspots, i.e., locations where crashes 
frequently occur, aiding in targeted interventions and resource allocation. When crashes are 
perfectly geo-localized, collision diagrams (5) provide a graphical representation of hazardous 
locations and characteristics of crashes over a specific period. These diagrams help identify 
patterns and trends in collisions, providing valuable insights for improving safety (6). 

However, crashes are rare and random events; therefore, crash data are subject to the 
regression-to-the-mean (RTM) effect (7). To obtain a reliable and stable safety indicator, 
either many years of data or statistical correction are necessary. Furthermore, due to rarity 
and randomness, some site may exhibit no crashes for a long time although they are not 
intrinsically safe. As a result, many sites are excluded from the safety analysis since they 
report no crashes in the time under observation. 

While crash data is crucial to address several safety issues, other indicators like conflict 
and/or user behaviour data could provide a more comprehensive view and understanding of 
road safety of a road site. A conflict on the road is any dangerous situation in which two or 
more road users approaching each other are likely to collide if their movements remain 
unchanged, but not because of an evasive manoeuvre (change of speed and/or direction) by 
one or more of them. 

Currently, conflict indicators are considered to assess road safety for the following reasons: 

• conflicts are not rare and random like crashes, so there is more data (Figure 1) to be 
analysed and interpreted (as a result, they do not suffer from the RTM problem); 

 
5 Key features of collision diagrams include: (i) location mapping (crashes on a map show where they 
occurred, helping to visualize problem areas), (ii) collision types (e.g., rear-end, head-on, pedestrian 
involved), (iii) time analysis (e.g., time of day, day of the week), (iv) severity indicators (e.g., minor, 
serious, fatal). 
6 Benefits of collision diagrams include: (i) guiding interventions like road improvements or increased 
enforcement; (ii) facilitates evidence-based decisions for safety enhancements, such as signage, 
signals, or roadway design changes; (iii) public awareness to inform the public about road safety 
issues, encouraging safer driving behaviour; (iv) resource allocation to prioritize safety improvements, 
focusing resources on high-risk areas or behaviours. 
7 Regression-to-the-mean (RTM) effect applied to road crashes explains why locations with unusually 
high crash frequency may see a return to more typical levels over time, even if no specific intervention 
or change occurs. It happens because road crashes are influenced by many factors that vary over 
time, e.g., weather conditions, driver behaviour, traffic flow, and even pure randomness. Sometimes 
high frequency at certain times or locations might result from a temporary combination of 
circumstances (e.g., weather, temporary distractions, or road construction sites). Once those specific 
factors dissipate, the crash frequency tends to return to a more typical level, below the reflecting the 
broader, long-term average value. Policymakers or road agencies might incorrectly interpret a 
reduction in crashes at a hot spot as a sign that an intervention (e.g., traffic light installation, speed 
limit reduction) was successful. That reduction could be simply due to the RTM effect. 
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• crash data typically captures only the most and few severe outcomes (8), while 
conflict indicators provide a more comprehensive view of road safety issues by 
including different conflict severity (e.g., no conflict, light conflict, severe conflict); 

• conflict data can be collected and analysed in real-time or shortly after events occur, 
allowing for quicker interventions compared to crash data, which may take longer to 
compile and analyse; 

• indicators based on conflicts identify potential hazards before crashes occur, so 
safety improvements based on conflicts can be made to prevent future collisions; 

• conflict indicators include users’ behavioural variables, offering insights into the 
underlying causes of risky conflicts that can be addressed through education and/or 
engineering solutions. 

 

 

Figure 1. The pyramid of traffic events from Hydén (1987). The blue field of the Hydén pyramid indicates 
interactions, while the red field indicate crashes with outcomes of different severity (this last hierarchy is 
based on Laureshyn et al. (2010). This figure is from Arun et al.9).  

By focusing on conflicts, safety analysts identify and address areas where potential crashes 
are likely to happen, leading to more targeted and effective safety interventions. By 
understanding where conflicts frequently occur, a more efficient allocation of resources is 
achieved. Overall, conflict indicators provide a more proactive and nuanced approach to 
improving road safety, helping to create a safer environment before accidents happen. As a 
result, conflict metrics are overall considered as a surrogate safety measure (10). 

 
8 In Italy and in many other countries, crashes include events where there’s at least one injury. 
9 Arun, A., Haque, M. M., Bhaskar, A., Washington, S., & Sayed, T. (2021). A systematic mapping 
review of surrogate safety assessment using traffic conflict techniques. Accident Analysis & 
Prevention, 153, 106016. 
10 Tarko, A. (2019). Measuring road safety with surrogate events. Elsevier. 
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2.2 Estimation and classification of road conflicts 

Conflicts are the result of (i) misunderstanding or ignoring traffic rules, (ii) aggressive or 
reckless behaviour, (iii) failure to yield or (iv) distraction while driving, riding, or walking.  

Severe conflicts are near crashes (7). A collision happens when the time and/or spatial 
separation between two road users reduces to zero, i.e., users that are at the same point at 
the same time. 

The most common measures that quantify a conflict are temporal separation indicators like 
time-to-collision (TTC) and post-encroachment time (PET) (11). 

If the first works for the pre-event phase, when both road users haven’t occupied the conflict 
zone yet, the second works for the post-event phase when one of the two users has already 
abandoned the conflict zone and the other one is entering in. Figure 2 depicts such situations 
for the conflict between a pedestrian and a vehicle. 

Based on the magnitude of proximity indicators, (i) undisturbed passage, (ii) normal 
interaction, (iii) light and (iv) serious traffic conflicts are identified. Their proportion in a road 
scene changes as depicted in Figure 1. The higher the severity, the lower the number of 
events. The classification of interactions of different magnitudes derives from the definition of 
specific thresholds as per a variety of methods presented by Arun et al. (12). 

(a)      (b) 

Figure 2. Example of pedestrian-vehicle conflict: (a) the pre-event and (b) the post-event phase.  

 

2.3 Technologies to detect conflicts 

Several technologies are used to monitor conflicts and assess safety (see Figure 3). With 
video analytics, video cameras or drones capture images that are analysed through video 
analytics software to detect conflicts in real-time by tracking the movements of vehicles, 
cyclists, and pedestrians. Some examples follow: (i) TrafxSAFE - Road Safety Video 
Analytics, (ii) DataFromSky - Deep Traffic Video Analysis, (iii) FLIR Systems - Traffic 
Sensors, (iv) Hikvision - Traffic Surveillance Solutions, (v) Iteris - Vantage Detection Systems, 
(vi) Miovision - Traffic Data Collection, (vii) Sensys Networks - Wireless Detection. 
Microwave and infrared sensors can monitor traffic flow and detect near-misses by 
measuring the speed and distance between vehicles (13) Finally, LiDAR (laser scanner) can 
be used to measure movement patterns and classify users with high accuracy, with 
dedicated software able to identify potentially dangerous interactions. More details on this 
technology are provided in the next Section. 

 
11 Please see deliverable D3.2 for more details on these two surrogate safety measures. 
12 Arun, A., Haque, M. M., Bhaskar, A., Washington, S., & Sayed, T. (2021). A systematic mapping review of 
surrogate safety assessment using traffic conflict techniques. Accident Analysis & Prevention, 153, 106016. 
13 https://rotech.com.au/microwave-vs-infrared-activation-sensors-whats-the-difference/  

https://rotech.com.au/microwave-vs-infrared-activation-sensors-whats-the-difference/
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(a) 

  (b)  (c) 
Figure 3. (a) Radar (14), (b) video camera and (c) drones used to track road users. 

2.4 LiDAR 

LiDAR (Light Detection and Ranging) uses laser light to measure distances to objects or 
surfaces. It works by emitting laser pulses and measuring the time it takes for the light to 
travel to the target and back to the sensor. These time measurements are used to calculate 
distances with high accuracy. In the context of traffic conflicts, LiDARs can be effectively 
used to collect the position of fixed and moving entities in the road environments, capturing 
the movements of vehicles, pedestrians, and cyclists with high precision (Figure 4). 

As objects move in the road environment, their positions change over successive frames, 
allowing the system to detect motion. By calculating the displacement of points over time, the 
system recognizes moving objects from the static background (Figure 5).  

The collected point cloud is segmented into clusters, with each cluster representing a single 
object. Using pre-determined models, the system classifies objects based on their 3D 
geometry, size and movement patterns. For example, pedestrians are identified as tall, 
narrow shapes with irregular walking patterns (Figure 5), while vehicles appear as larger, 
rectangular shapes with smooth and predictable movements. Tracking algorithms then 
monitor the trajectory of these objects over time. 

As a result, LiDAR can provide data on moving objects that can be interpreted by software to 
give traffic counts, users’ classification (Figure 6) and users’ trajectories. Such information 
needs to be treated in post-processing to extract traffic conflict indicators (i.e., surrogate 
measures of safety) for safety analysis.  

 

 
14 Peng, Z.; Ran, L.; Li, C. (2017). A κ-band portable FMCW radar with beamforming array for short-
range localization and vital-Doppler targets discrimination. IEEE Trans. Microw. Theory Tech., 65, 
3443–3452. 
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Figure 4. Tracking of a pedestrians 

 

Figure 5. Identification of moving objects (persons) from the static background (from 
https://quanergy.com/it/). 
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Figure 6. Road users' recognition and classification into cars, heavy vehicles, bicycles, and pedestrians. 

Figure 7 shows an example of LiDAR data outputs in which different road users are 
univocally identified and their trajectories recorded. Therefore, by analysing the spatial 
relationships and movement trajectories of different road users, LiDAR can be conveniently 
used to identify near-misses and conflicts of different severity. 

The use of LiDAR provides multiple and relevant advantages: 

• it allows the acquisition of moving objects with a centimetre-level accuracy which is 
significantly higher than alternative systems; 

• it does not collect personal information of people and vehicles that are detected in 
the surveyed area, thus avoiding any ethical implication for the investigation; 

• it significantly reduces the whole time for data acquisition and processing and 
offers a quick and reliable solution to alternative time-expansive conflict analysis 
techniques. 

 



 

 

 21 

 

Figure 7- Example of LiDAR data outputs with identification of users’ ID and trajectories. 

2.5 LiDAR technology for field observation in Just Streets project 

The suggested equipment for JUST STREETS is a high-performance LiDAR system, that 
can be used in all weather and lighting conditions. This technology consists of hardware (i.e., 
the LiDAR) and a dedicated software. LiDAR sensors emit pulse laser lights that are 
reflected from background objects and users moving in the road environment. By collecting 
dense point clouds, the software identifies objects and classifies them into different 
categories based on their size, i.e., different vehicle types, bicycles, and pedestrians (Figure 
8).  

By collecting this data, various metrics can be analysed, such as average speed per lane, 
vehicle counts per lane, stopping times, pedestrian counts, and average walking speeds. As 
previously stated, a key advantage of using LiDAR technology is its ability to ensure data 
anonymization and respect for privacy. The system collects point clouds, making it 
impossible to identify individual faces or vehicle number plates without collecting sensitive 
and private information about road users. 

Figure 9 shows the two-sensor LiDAR system installation for monitoring an intersection in 3D 
(Figure 9a) and plan (Figure 9b) view respectively. The software detects moving objects and 
categorizes them into different road users, i.e., vehicles, bicycles, and pedestrians, as shown 
in the 3D and plan views of Figure 10. Eventually, trajectories are tracked over time (Figure 
11) and conflicts are detected (Figure 12) as per the methods here introduced. 

Such installation reproduces the system we adopt in the pilot of the Metropolitan City of Milan 
to monitor traffic conflicts in a before/after observational scheme. 
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Figure 8. Operating principles of the LiDAR systems for road user detection and tracking. 
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 (a) 

 (b) 

Figure 9. 3D representation (a) and plan view (b) of a two-sensor LiDAR system for intersection analysis. 
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 (a)

 (b) 

Figure 10. (a) 3D view and (b) plan view of an intersection with road users’ detection and categorization. 
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Figure 11. Spatial-temporal trajectories for the different users in the scene. 

 

 

Figure 12. Potential conflict identification from spatial-temporal trajectory data. 
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2.7 Field surveys 

The collection of data aimed at investigating interactions and conflicts between road users is 
carried out through field surveys that are classified as observations. Planning a field study 
requires careful design to ensure that the data collected is both comprehensive and relevant. 
The combination of advanced technology and strategic data collection has proven to be 
effective in understanding road safety challenges thus reducing crash risk. 

If existing crash data is available, the survey is carried out in areas where more crashes 
occurred (i.e., high-risk areas such as crossings). Alternatively, surveys can be carried out in 
areas subjected to treatments with effects expected in terms of safety. 

It is important to collect data at different times of the day, covering both peak periods 
(morning and evening) and quieter periods, to analyse different traffic conditions. Weather 
conditions (e.g., rain, snow and fog) should also be considered as they can impact driving 
behaviour and crash risk. The duration of the study should also be carefully planned, typically 
over several days, to capture a statistically significant sample and to account for daily, weekly 
and even monthly variations in traffic patterns and conflicts of different severity. 

Collaboration with local authorities, public agencies and transport companies is essential to 
understand which strategic locations are best suited to improve the overall quality of the 
survey. 

2.8 Before/after safety study 

Decisions on the use of road safety interventions can only be effective when there is 
sufficient knowledge about their impact. A key source of reliable information on the 
effectiveness of safety interventions is the observational before/after study. This type of study 
is a quantitative evaluation method used to measure the safety effectiveness of an 
intervention by comparing crash or traffic conflict data from before and after its 
implementation. This approach uses statistical methods, which account for factors such as 
regression-to-the-mean and other confounding variables, helping to assess the real-world 
impact of the safety treatments more accurately. 

Treatment sites are not required to have been chosen using a specific methodology; they are 
generally locations where highway agencies have undertaken projects as part of their routine 
efforts to enhance the operational and safety performance of the highway network. However, 
if these sites were selected specifically due to abnormally high crash frequencies, this 
selection process could introduce selection bias. Consequently, this may lead to a significant 
regression-to-the-mean bias, as the treatments were not assigned to the sites randomly. 

Simple (Naive) before/after study 

The aim of conducting before/after studies is to compare the predicted number of traffic 
conflicts that would have occurred if the treatment had not been implemented with the actual 
number of observed traffic conflicts in the after period (usually the actual number of observed 
traffic conflicts) for the target conflict type (e.g., right-angle, pedestrian-vehicle, all conflicts) 
and their severity levels (e.g., serious conflicts, minor conflicts, potential conflicts, or a 
combination thereof).  

The naive method for conducting a before/after study evaluates the change in traffic conflicts 
by comparing the observed number of conflicts during the 'After' period with the predicted 
number of conflicts for the same period, had the treatment not been implemented. Since the 
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durations of the 'Before' and 'After' periods may differ across entities, an adjustment factor is 
applied. This factor for site j, 𝑟𝑑(𝑗), is calculated as: 

𝑟𝑑(𝑗) =
Duration of after period for site j

Duration of before period for site j
 (1) 

Using this adjustment, the expected number of target traffic conflicts for groups of entities in 
the after period if the treatment had not been implemented (the number is a predicted value) 
is calculated through Equation 2. The total number of observed conflicts in the 'After' period, 

denoted as 𝜆̂, is calculated as Equation 3. 

𝜋̂ = ∑ 𝑟𝑑(𝑗)K(j) (2) 

𝜆̂ =  ∑ L(j) (3) 

where K(j) is the observed number of conflicts in the 'Before' period for site j, L(j) is the 
observed conflicts during the 'After' period for site j.  

To account for variability, assuming that the conflict counts follow the Poisson distribution, the 

variance of 𝜋̂  and 𝜆̂ is calculated as Equations 4 and 5, respectively: 

𝑉𝐴̂𝑅{𝜋̂} = ∑ 𝑟𝑑(𝑗)2𝐾(𝑗) (4) 

𝑉𝐴̂𝑅{𝜆̂} =  ∑ 𝐿(𝑗) (5) 

The observational before/after evaluation can be performed by calculating either the (i) 
expected difference or (ii) the ratio, also called odds ratio in some references, as indicated in 
Equations 6 and 7, respectively: 

𝛿 = 𝜋̂ − 𝜆̂ (6) 

𝜃 = (𝜆̂/𝜋̂)/[1 + 𝑉𝐴̂𝑅{𝜋̂}/𝜋̂2] (7) 

Finally, the variances of 𝛿 and 𝜃 are estimated using Equations 8 and 9, respectively: 

𝑉𝐴̂𝑅{𝛿} = 𝑉𝐴̂𝑅{𝜋̂} + 𝑉𝐴̂𝑅{𝜆̂} (6) 

𝑉𝐴̂𝑅{𝜃} = 𝜃2 [(
𝑉𝐴̂𝑅{𝜆̂}

𝜆̂2 ) + (
𝑉𝐴𝑅{𝜋̂}

𝜋̂2 )] / [1 + (
𝑉𝐴𝑅{𝜋̂}

𝜋̂2 )]
2

 (7) 

The effects of changes during the before and after periods for measurable or well-understood 
factors, such as traffic flow, can be accounted for by adjusting the equations provided in the 
suggested references (15).  

In Just Streets, we will test the hypothesis about the probability distribution of observed 
conflict at each site studied, and we will adjust the estimation based on the set of equations 
reported above. 

 
15 Hauer, E. (1997). Observational before/after studies in road safety. Estimating the effect of highway 
and traffic engineering measures on road safety. Emerald Group Publishing Limited. 
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Before/after study with comparison groups  

To account for the impact of factors that have changed between the before and after periods 
but are not measured or understood, comparison groups with similar characteristics, where 
the treatment has not been implemented, should be used. Table 1 shows the steps that 
should be taken for conducting before/after safety evaluation with comparison-group. A 
detailed descriptions of the steps can be found in the suggested references (15,16, 17).  

Table 1. Overview of before/after safety evaluation with comparison-group. 

Step Description 

Step 1 Calculate predicted traffic conflict frequency at each treatment site, separately for before and after 
period. 

Step 2 Calculate predicted traffic conflict frequency at each comparison site, separately for before and 
after period. 

Step 3 Calculate adjustment factor for each combination of treatment and comparison site, separately for 
before and after period. 

Step 4 Calculate adjusted traffic conflict frequency for each combination of treatment and comparison 
site, separately for before and after period. 

Step 5 Calculate total comparison-group adjusted traffic conflict frequency for each treatment site in 
before period. 

Step 6 Calculate total comparison-group adjusted traffic conflict frequency for each treatment site in after 
period. 

Step 7 Calculate the comparison ratio for each treatment site. 

Step 8 Calculate the expected traffic conflict frequency for each treatment site in the after period, had no 
treatment been implemented. 

Step 9 Calculate the safety effectiveness expressed as an odds ratio at an individual treatment site. 

Step 10 Calculate the log odds ratio for each treatment site. 

Step 11 Calculate the weight for each treatment site. 

Step 12 Calculate the weighted average log odds ratio across all treatment sites. 

Step 13 Calculate the overall effectiveness of the treatment expressed as an odds ratio. 

Step 14 Calculate the overall effectiveness of the treatment expressed as a percentage change in traffic 
conflict frequency. 

Step 15 Calculate the standard error of the treatment effectiveness. 

Step 16 Assess the statistical significance of the estimated safety effectiveness. 

 

Observational before/after evaluation studies using safety performance functions — 
the empirical bayes method. The Empirical Bayes (EB) before/after safety evaluation 
method is used to compare traffic conflict frequencies at a group of sites before and after a 
treatment is implemented. The EB method explicitly addresses the regression-to-the-mean 
issue by incorporating traffic conflict information from other, but similar, sites into the 
evaluation. This is achieved by using a safety performance function (SPF) and weighting the 
observed traffic conflict frequency with the SPF-predicted average traffic conflict frequency to 
obtain an expected average traffic conflict frequency. The general steps of EB method are 
presented in Table 2. 

 

 

 

 

 
16 Lord, D., Qin, X., & Geedipally, S. R. (2021). Highway safety analytics and modeling. Elsevier. 
17 American Association of State Highway and Transportation Officials (2010). Highway Safety Manual 
(Vol. 1). 
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Table 2. Overview of EB Before/After Safety Evaluation 

Step Description 

Step 1 Calculate the predicted traffic conflict frequency for each site during each year of the before 
period. 

Step 2 Calculate the predicted traffic conflict frequency for each site summed over the entire before 
period. 

Step 3 Calculate the predicted traffic conflict frequency for each site during each year of the after period. 

Step 4 Calculate an adjustment factor to account for differences between before and after periods. 

Step 5 Calculate the expected traffic conflict frequency for each site over the entire after period in the 
absence of the treatment. 

Step 6 Calculate an estimate of the safety effectiveness at each site in terms of an odds ratio. 

Step 7 Calculate an estimate of the safety effectiveness at each site as a percentage traffic conflict 
change. 

Step 8 Calculate the overall effectiveness of the treatment for all sites combined in terms of an odds ratio. 

Step 9 Perform an adjustment to obtain an unbiased estimate of the treatment effectiveness in terms of 
an odds ratio. 

Step 10 Calculate the overall unbiased safety effectiveness as a percentage change in traffic conflict 
frequency across all sites. 

Step 11 Calculate the variances of the unbiased estimated safety effectiveness as an odds ratio. 

Step 12 Calculate the standard error of the odds ratio from Step 11. 

Step 13 Calculate the standard error of the unbiased safety effectiveness calculated in Step 10. 

Step 14 Assess the statistical significance of the estimated safety effectiveness. 

 

2.9 Conclusions and recommendations 

In the JUST STREETS project, the assessment of objective safety will be carried out by 
observing the area where the Living Labs will be built before and after the implementation of 
the transforming interventions. The choice of the observational method is justified by the 
limited time available in the JUST STREETS project (3.5 years) to carry out the safety 
evaluation based on crash data.  

Observations will be carried out with LiDAR instruments, which have the great advantage of 
limiting the data processing time for observations, which are normally carried out with the 
acquisition of video sequences and subsequent processing by image analysis. This 
innovative technology for conflict analysis on roads eliminates all the privacy issues and 
related ethical implications that arise when filming scenes in which people and vehicles are 
recognisable. Last but not least, LiDAR provides centimetre-level data accuracy that is 
currently unattainable by alternative systems. 

The process of data acquisition is summarized in Figure 13, while Figure 14 shows an 
overview about the benefits and the limitations for the implementation of objective road 
safety in JUST STREETS. 
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Figure 13. Flowchart for practical application of objective road safety in quantitative research. 

 

Figure 14. Infographic for implementation of objective road safety in quantitative research. 

Notes: Objective safety analysis through observation using LiDAR technology requires the use of 
advanced equipment and technical expertise. It has the great advantage of providing surrogate measures 
of safety based on user conflicts that are highly accurate and provide reliable results. Observations can 
be made at locations identified as worthy of observation and repeated at different times to capture the 
effects of specific environmental and traffic conditions. The ability to quickly repeat the observation 
makes this technique suitable for the study of individual sites or small to medium-sized areas, but it has a 
limited applicability to large urban areas or the whole municipality. 
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3. Qualitative methods to produce knowledge on street 
justice 

3.1 Introduction 

This section introduces five qualitative methods essential to explore issues related to street 
design and mobility justice including interviewing, focus group, participant observation, 
participatory mapping approaches, experiments and action research. Each method offers a 
unique lens for understanding how people experience and interact with urban spaces, 
addressing concerns of equity, accessibility, and justice. Individually and in combination, 
these methods provide a dynamic approach for uncovering the complexities of street use, 
adaptable to a wide range of contexts and needs.  

Sheller (2018) theories justice in relation to the concepts of distributive justice, deliberative 
justice, procedural justice, restorative justice and epistemic justice. Mobility as inspired by 
Lèvy (2000) and Rèmy (2000) and the reflections of Flamm & Kaufmann (2006) on the forms 
of mobility (Schuler et al., 1997) encompasses the various factors that determine a person’s 
ability to move through space. These factors include physical abilities, desires to be mobile or 
sedentary, the accessibility of transportation and telecommunication systems, and acquired 
knowledge (e.g., driver’s license). Mobility justice is a concept that seeks to address the 
inequities in access to transportation, movement, and urban spaces, ensuring that all, 
especially those from marginalised groups, have equal rights to safe, accessible, and 
sustainable mobility.  

Knowledge and information on transport and urban planning might often be dominated by 
quantitative and statistic data. Transport is often measured in terms of flows – how people 
travel from A to B and which modes (e.g. car, bicycle, public transport) they use. Surveys on 
the other hand often address people’s stated preferences by asking people things like which 
mode of mobility they prefer to use and what kind of journeys they would like to make.  

Statistics and surveys are both often important for understanding the system of mobility. For 
example, statistical data can be very handy in describing how transport opportunities are 
distributed among places and people in the city. However, those quantitative data alone 
cannot fully explain why this is the case. Despite its usefulness, quantitative data can 
sometimes sway attention from various phenomena affecting people’s mobilities. For 
example, statistical data might not be able to explain the various other uses of street spaces 
beyond transport flows – streets are also spaces of social encounter, children’s play and 
urban green.  

The point is that quantitative data can sometimes be trapped in existing understandings of 
what mobility and transport are and what they should achieve. For example, in surveys, 
every question or indicator is focusing on an aspect of street design and justice that the 
creator of the survey thinks is relevant. Even if the respondents wanted to provide more 
explanations for their choices it is often not possible. As in turn, it is not possible for the 
creator of the survey to pose follow up questions or ask about something that was not 
recognized when the research process started. 

This is why understanding what kinds of struggles and injustices people are facing in urban 
spaces often demands using more open-ended qualitative methods that very directly 
engaging with people and places. This means talking to people and observing them, but also 
creating something new in collaboration among diverse actors (e.g. maps and street 
experiments). This section discusses some of the approaches that demand intimate 
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engagement with people and that are especially relevant in understanding issues connected 
to streets design and uses:  

• Interviewing 

• Focus groups 

• Participant observation 

• Participatory mapping approaches 

• Experiments and action research 

We discuss multiple approaches together because a good knowledge creation approach is 
often a combination of different methods. Indeed, what people say, what they do and what 
they say they do are often totally different things, which is why applying certain qualitative 
methods with others or with quantitative methods is often useful to create a truthful picture of 
the situation. Thus, the methods and approaches below should not be looked as separate 
entities but something that can (and often should) be flexibly combined.  

The eventual approach to a certain project depends on the initial problems and knowledge 
needs, but also on the conceptual understanding of the subject of investigation, as well as 
the language used to describe it (for more details, see D2.1). An example is the Road 
Danger Reduction (RDR)18 approach, which is different from traditional road safety 
approaches as it avoids normalizing car dominance and shifting blame to active users.  

 

Challenging road safety improvements with road danger reduction 

The Road Danger Reduction (RDR) approach aims to call our attention to the systemic 
roots of danger which often seem to be implicitly accepted as a given. This could explain 
why decades of road safety interventions have had mixed results but by and large did not 
reduce these systemic roots; they arguably even worsened in parallel to our efforts. 
Consider that in most of our contexts, the danger represented by cars has increased with 
an increase in their numbers, their size, their weight, their speed, their acceleration power 
and the levels of distractions for drivers. In this context, RDR helps us to:  

- prioritize eliminating deaths caused by others over single sided falls; 
- highlight the preventable nature of deaths caused by others and advocates for 

systemic reforms to provide a safe and inviting environment for all road users;  
- reject cost-benefit analyses that undervalue marginalized lives; 
- advocate for more inclusive solutions;  
- challenge power dynamics to ensure equitable and sustainable transport systems; 
- focus on reducing road danger at the source - primarily the consequences of motor 

vehicles, rather than merely lowering casualties on our roads;. 
- encourage an increasing presence of non-motorised users on the roads that lowers 

the overall risk; 

 
18 Te Brömmelstroet, M. (2024). Increase road safety or reduce road danger: Challenging the 

mainstream road safety discourse. Traffic Safety Research. https://doi.org/10.55329/vfer7646.  

Verkade, Thalia, and Marco te Brömmelstroet. Movement: How to take back our streets and transform 
our lives. Island Press, 2024.  

Davis, R. (1993). Death on the Streets: Cars and the Mythology of Road Safety. Hawes Press. 
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- aim to shift from private motor transport to sustainable and less risk generating 
alternatives.  

RDR recognizes that next to actual violence that we tend to measure, there is also 
perceived danger that affects human behaviour. This shift makes us aware that focusing 
solely on "accident reduction" can shift risks to others, misleading safety perceptions. An 
RDR approach advocates for addressing systemic and cultural factors, promoting 
equitable and sustainable transport, and redefining road safety to prioritize the most 
vulnerable.   

Moreover, too often, the language surrounding both our studies and the public debates 
around “road safety” shapes perceptions and limits transformative solutions. We know that 
terms like "accident" obscure systemic harm caused by motor vehicle dominance and that 
dehumanizing this in our reporting and statistics makes the ongoing carnage more 
acceptable.   

In short, Road Danger Reduction offers an alternative frame to think and talk about, to 
measure, and to design for just streets. As such it can make us aware of the underlying 
assumptions and values that have largely been taken for granted in many efforts under 
the umbrella of road- or traffic safety, and that might explain the lack of truly 
transformational change we all work towards (Te Brömmelstroet 2024). We want to 
highlight that some cities, within and outside of the JUST STREET consortium are already 
embracing this RDR approach, such as the Lambeth Road Danger Reduction Strategy. 

  

The eventual approach to a certain project depends on the initial problems and knowledge 
needs too. Different approaches require the involvement of involving different stakeholders, 
skills and resources. Different approaches produce different data and materials, such as 
audio recordings, transcripts, fieldnotes and other documents, or even maps, artworks and 
physical street experiments. These materials of course also need to be analysed, and this is 
briefly discussed in the concluding section. The aim is that experts and practitioners can be 
inspired by these approaches and learn to appreciate them as complementary to other data 
and knowledge they have at hand. Appreciating different ‘’ways of knowing’’ street uses and 
designs are key in the quest of developing Just Streets.  

Qualitative methods and mobility justice 

As briefly mentioned in the above the application of qualitative methods should be able help 
explain and tackle mobility injustices. Mobility justice contains 4-6 analytically separable 
elements, four of which are especially relevant for this section. 

First, distributive justice means simply how the risks and opportunities of urban mobility are 
distributed across different spaces and groups. Regarding risks for example, air quality and 
traffic danger are higher in some urban areas and some groups of people are rendered more 
vulnerable than others by the transport system (e.g. children). Similarly regarding 
opportunities, certain places are better served by the public transport system and certain 
groups of people have often less access to certain mobility modes and spaces (e.g. disabled 
people’s access to cycling lanes). 

Second, beyond the distributive aspects, mobility justice is about recognition. Recognition 
justice demands deep understanding of people’s perceptions, feelings and embodied 
experiences – simply put, marginalized people’s voices are less well acknowledged and 
validated in public debate and planning processes. Tackling recognition justice demands 
collecting local and contextual knowledge that makes the vulnerabilities of certain 

https://www.lambeth.gov.uk/transport-strategy/road-danger-reduction/road-danger-reduction-strategy
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populations visible and understandable (e.g. interviewing women’s experiences of street 
harassment).  

Third, and closely connected to recognition justice, procedural justice entails how local and 
contextual knowledge is validated and accounted for. It encompasses also how different 
people are provided opportunities to participate in urban planning processes: notoriously for 
example ‘’participatory meetings’’ aiming to engage residents tend to collect the insights of 
only those people who have some spare time to participate (e.g. think of for example single 
parents) and who can speak the language of such meetings, both literally and figuratively 
(e.g. migrants and mentally disabled people).  

Finally, all these dimensions link back to epistemic justice, which means profoundly 
assessing what kind of knowledge is relevant for the management of street planning and 
uses. It is about acknowledging and acting on the current hierarchies of knowledge and often 
means reconciling different ways of knowing – think for example how to reconcile the migrant 
children’s accounts of street as an important social place with engineering knowledge on how 
streets can be built. It also means creating new ways of thinking about mobility (e.g. think of 
multiple uses of the street beyond transport and traffic). 

The below table offers a roadmap and an overview of the methods discussed in this section. 
All of them are relevant for the above discussed dimensions of mobility justices depending on 
the eventual research design. 

Table 3. Roadmap and overview of the methods 

Method Outputs Challenges and preparation Examples 
of use 

Interview Open ended accounts on 
people’s expertise or experiences 
that are not fixed to predefined 
questions 

Challenge of recruiting the participants; 
preparation of an interview guide  

1; 2; 3 

Participant 
observation 

Contexts sensitive understanding 
of people’s mobility practices and 
behaviors 

Sometimes time consuming; demands a 
high degree of reflexivity; preparation of 
a fieldwork plan 

1; 2; 3 

Focus groups Inclusive discussions revealing 
discrepancies among people or 
providing opportunities to seek 
consensus between groups 

Demands facilitation skills; attention to 
creating a safe space for participants 
with different interests and experiences 

1; 2; 3 

Participatory 
mapping 

Place based accounts on 
people’s experiences, aspirations 
and experiences of injustices 

Requires a map-based set-up (either 
digital or analogue) and a skill set similar 
to focus groups 

1; 2; 3 

Experiments 
and action 
research 

Concrete projects that can, when 
combined with other methods, 
provide important insights on the 
implications of change and 
transformation on different people 

Requires a practical experiment (e.g. a 
street renovation project) and/or 
intensive involvement of the researcher 

1; 2; 3 

 

3.2 Basic qualitative methods 

Interviewing - Background 

Interviews are a fundamental and widely used method of data collection in research. Unlike 
casual chats, which serve social functions, or interviews for media or psychological 
purposes, a research interview has a clear aim: to contribute to the completion of the 
research task.  

The very basic rationale behind interviewing is that, to gain insight into people's lives, it's 
often effective to ask them directly. However, interviews are not without their challenges, 

https://www.tandfonline.com/doi/full/10.1080/1523908X.2024.2422842#abstract
https://www.researchgate.net/publication/381626357_A_semi-structured_interview_to_capture_manual_wheelchair_use_for_mobility_activities_among_individuals_with_spinal_cord_injury_in_real-life_situations_development_and_content_validity_of_the_Wheelchai
https://www.researchgate.net/publication/374498384_The_adoption_of_go-along_interview_method_in_identifying_transportation_barriers_for_mobility-impaired_travelers
https://www.mdpi.com/2673-7272/4/1/15
https://www.tandfonline.com/doi/full/10.1080/17450101.2017.1292027#d1e163
https://www.researchgate.net/publication/352155496_Observation_for_Data_Collection_in_Urban_Studies_and_Urban_Analysis
https://participatorymapping.org/research_themes/participatory-urban-planning/
https://www.researchgate.net/publication/385003299_Qualitative_exploration_of_determinants_of_active_mobility_and_social_participation_in_Urban_neighborhoods_individual_perceptions_over_objective_factors
https://archpublichealth.biomedcentral.com/articles/10.1186/s13690-024-01408-z?utm_source=chatgpt.com
https://participatorymapping.org/research_themes/participatory-urban-planning/
https://nordregio.org/nordregio-magazine/issues/smart-and-green-cities-how-do-we-get-there/nordic-cities-mobilise-residents-to-improve-urban-planning/
https://link.springer.com/article/10.1007/s10708-021-10489-0
https://www.sciencedirect.com/science/article/pii/S2667091722000036
https://www.tandfonline.com/doi/full/10.1080/01441647.2020.1761907
https://www.tandfonline.com/doi/full/10.1080/13574809.2024.2320918?utm_source=chatgpt.com#abstract
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especially when it's assumed that participants always provide an accurate and truthful 
account of their experiences. On the contrary, participants can be prone to give socially 
desirable answers, want to portray themselves in a given way or have other personal “goals’’ 
in the interview. Similarly, errors can result from actions of the researcher – interviewing 
should be understood as a data collection method that demands preparation and rigor. 

Despite being widely applied, interviews are not always the best method to apply. Still, 
sometimes interviews are chosen as a data collection method without evaluating their 
appropriateness for the research topic or considering other methods. Additionally, the 
potential strengths and drawbacks of interviews may not be critically addressed in the 
research report, leading readers to accept interviews as the default method, often at the 
expense of alternative approaches. 

The interview has certain basic characteristics. Firstly, the interviewer takes the lead in 
starting and directing the conversation. The interviewer's role is clearly defined, while the 
interviewee gradually becomes aware of their role during the interview. The interview should 
be carefully organized, grounded in, and built around a clearly defined topic or problem. 
Especially in academic research, interviewees must feel assured that their responses will 
remain confidential. The interviewer is responsible for encouraging the interviewee and 
maintaining their motivation throughout the discussion. 

Beyond these basic characteristics, interviews can be categorized in different ways. But 
perhaps the most elemental distinction can be made between structured interviews and 
semi-structured (or unstructured) interviews. This means that depending on the format, the 
conversation between the researcher and participant can be either highly formalized and 
predefined or more informal and open-ended. In other words, a key distinction between these 
types of interviews is how much freedom the interviewee has in their responses and how 
rigidly the questions are posed. The level of precision or formality in an interview largely 
depends on the type of information the researcher aims to gather. But it is important to note 
that all research interviews should only be addressing issues that are directly related to the 
research topic. 

Interviewing - Implementation 

In urban studies, interviews often seek to generate knowledge about how certain people 
experience different places, other people in those places or interventions or changes in the 
streets. Interviewing demands basic social skills, but all the interaction becomes easier when 
the topic or research problem is clearly defined. In terms of the scope and scale, some 
researchers tend to consider that around 15-20 interviews are often enough to gain 
comprehensive understanding of a clearly defined phenomena or topic in a certain location. 
But rather than looking for a clear number of individual interviews, the researcher should 
assess the number of interviewees based on the quality and especially the saturation of the 
data. The latter means that interviews are not creating additional insights. If this is not the 
case after, for example 20 interviews, it is reasonable to reassess whether the topic or the 
research problem is formulated and delineated clearly enough. 

Generally, an interview study can be developed following these basic steps: 

1. Designing the study. The first step is to determine the objective of interviewing, what 
kind of interviews are going to be conducted and what is the sample (i.e. who should 
be interviewed, how many people etc.) This may mean focusing on a certain social 
group, on people engaged in certain practices or for example a certain community 
inhabiting certain area. At this step it is also useful to think of what other methods 
(see below) should be included in the study to create a holistic view on the problem or 
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issue at hand. At this stage it is also crucial to determine how the participants will be 
recruited and at which location the interviews will be conducted. 

2. Creating an interview guide. Once the purpose and scope of the interview is clear, it 
is time to create an interview guide. It is a document that outlines the structure of the 
conversation and a roadmap that helps the researcher to stay ‘’on track’’. Structured 
interviews use interview guides that contain a clear set of questions and semi-
structured interviews use guides that contain more broadly defined topics and issues.  

3. Executing the interviews. Just before starting the interviews, it is good to do a 
rehearsal interview. This is to test that the interview guide works properly, that the 
interviewer becomes confident and fluent in asking the questions and that for 
example the time of the interview can be accurately estimated. Finally, when 
conducting the interviews it is important to try to create a respectful and open social 
atmosphere where the participants can freely express their views. 

Participant observation - Background 

In addition to interviewing, street users, planners and other stakeholders’ views can be 
analysed by observing them. This can take place in any setting: on the streets, bars, schools 
and community spaces where people work, move, play and socialise; in meetings where 
street plans are discussed or for example in the professional practices of people who design 
and build streets (organisational ethnography).  

The broad family of approaches for observing and documenting people’s sayings, doings and 
behaviours are often referred to as ethnographic methods (this often includes for example 
interviewing and document analysis). Ethnography is a broad term encompassing various 
studies that explore culture "from within."  

Traditionally, ethnographies were descriptive accounts of foreign cultures from the 
researcher’s viewpoint, often involving long-term fieldwork on people and culture. 
Ethnographic approaches in urban research originate from anthropology and sociology, with 
the Chicago School of Sociology adapting it to examine urban phenomena such as 
urbanization, industrialization, and immigration. 

An ethnographer aims to observe, describe, and understand urban communities and 
phenomena by immersing themselves in the daily lives of the people. Crucially, ethnography 
aims to provide accounts that are context sensitive – the behaviors and practices of people 
are analysed and understood in relation to the specific social and urban settings where they 
are situated. Key aspects of ethnography include the researcher’s active involvement, the 
study’s longitudinal approach, and its focus on specific cultural context. Importantly, this type 
of research demands a commitment to reflection and adherence to ethical principles (see 
more in the concluding section).  

Participant observation - Implementation 

Ethnographic work can at best produce very rich and ‘’thick’’ insights on local scale 
phenomena, but even a strictly defined research tasks demands time. It is very difficult to say 
how much observation is enough, but it is very helpful to have the target of the study clearly 
defined: what is the group of people or practices that we want to study in certain place?  

Moreover, ethnographic work demands the researchers to be transparent about the who they 
produce their insights and knowledge. In other words, the approach demands a high degree 
of reflexivity: why do I come to these conclusions and how is my personality and identity for 
example altering my findings? One way to address this is through a reflexive dialogue with 
oneself and others: for example, having multiple researchers doing the same observations 
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and then comparing and reflecting on the findings. Another important aspect is to work in a 
planned and systematic manner, and briefly put, this can mean following the following steps: 

1. Determining the subject of the study (designing the study).  Before engaging in 
observations, it is crucial to determine the scope of the study: what are the exact 
phenomena or behaviour that we are willing to study. This helps making subsequent 
practical choices on how to conduct the observations and what kind of a fieldwork 
plan should be developed. The study can choose to focus for example on a specific 
group of people, a specific mobility practice in a specific space or a specific way of 
working in creating street designs.  

2. Creating a fieldwork plan. To ensure that observations are done in a rigorous and 
systematic manner, it is important to plan how they are done, where, by whom etc. 
This includes also outlining clear guidelines on how field notes are taken and how 
interviews are conducted: are they more informal encounters or more structured 
interviews as discussed in the previous section. Ethnography demands repeated 
observations over an extended period of time, which makes it important to have a 
clearly defined way of working that applies for each field visit. 

3. Doing fieldwork. Once we are clear about the subject of study and we have a made 
a plan to observe it, it is time to execute the field work. There is evidently a lot of 
discussion on how exactly this should be done. However, one practical guideline is to 
demarcate between three elements that also constitute three different data sets: field 
notes; research diary and a logbook19. 

• Field notes are memos or recordings on what the researcher sees and 
witnesses during fieldwork. These descriptions are supposed to be as objective 
as possible, without too many interpretations on the events. 

• Research diary, contrary to the field notes, is a means to include the 
researcher’s own interpretations and sensations in the research process. 
Although subjective and interpretive, this document can help in pointing out key 
aspects of the phenomena subject to study. 

• Logbook, summarises all the activities of the researcher and all the participant 
observations, in order to have a comprehensive overview of the study.  

 

 

Figure 15. Workflow for practical application of interviews and participant observation in qualitative 
research. 

 
19 Verloo, N. (2020). Urban ethnography and participant observations: Studying the city from within. 
Seeing the city, 37-55. 
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3.3 Interactive and co-creative methods 

Focus groups - Background 

Focus groups, originally introduced by sociologists and psychologists in the mid-20th century, 
are now widely employed in various qualitative research. Focus groups are a valuable 
research method for obtaining real-time, unfiltered responses or exploring feelings and 
perceptions that may not be easily captured through surveys or questionnaires. They allow 
for in-depth discussion and are particularly useful for uncovering new questions and ideas.  

A focus group normally assembles a target group of 6 to 10 participants (rarely exceeds 12 
participants) who have specific knowledge or interest in a particular topic (this does not mean 
necessarily ‘’expert’’ knowledge). These participants engage in a structured discussion led by 
a skilled facilitator. The basic idea is that a small group of participants allows a rich 
discussion and that no one is left out. The questions that the facilitator poses to the focus 
group are generally flexible and open-ended, with a predefined set of topics to lead the 
conversation.  

Focus groups are particularly effective for gathering qualitative knowledge on street justice. 
The aim of focus groups is to gain multiple insights and understand differing intersectional 
perspectives, rather than collect objective quantitative data. In addition, focus groups differ 
from other qualitative methods as they allow and foster interaction and mutual learning 
between the participants. They are also a great way to discuss disagreements and conflicts 
between people – conflicting interests can be negotiated emphatically.   

Focus groups - Implementation 

The following steps should be followed in the organization of a focus group: 

1. Planning. First it is necessary to identify the objectives and expected outcomes of the 
focus group, categories of actors (people, individual streets users, advocacy 
organizations, policymakers, public authorities, stakeholders, etc.) to get involved. 
Especially in studies on urban planning and transportation it is important to consider 
the scale that the discussions will be focused on (local, regional, national, 
international).  

2. Preparation. After having defined the objectives and the categories of actors, it is 
time to map the potential organizations/actors to contact and invite them. Creating a 
table with the potential participants, their category/groups and their contact details 
can facilitate the following step. Different tools can be used to contact and invite the 
selected categories of actors or organizations (from personal and direct contact when 
available, to e-mails and call to the organizations contacts). This step can require a lot 
of time to contact all the organizations and have a definitive list of the participants. 
Once the list of the participants is definitive it is necessary to define the structure of 
the focus group: number of participants per session and make sure that each focus 
group has a desirable mix of participants representing differing viewpoints. 

3. Organizing the focus groups. Focus groups can be organized live or online. The 
use of analogue and digital tools if often helpful to run the focus groups and 
document the insights generated (tools for online focus groups: e.g. PowerPoint, 
mentimiter, miroboard, etc.; tools for in presence focus groups: e.g. posters, postits, 
markers, pens, dashboards, etc.), but it is crucial that these tools should support the 
objectives of the study. Remember don’t forget to record the sessions.  
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Participatory mapping approaches - Background 

Beyond some of the basic qualitative methods such as interviewing and participant 
observation, there are a large variety of applications that combine, order, display and use 
qualitative data in a way that provides furthermore insight. For urban research, one such 
approach that is very relevant is using and creating maps. The basic rationale of mapping 
approaches is that things happen somewhere and knowing where they happen, might be 
very useful in understanding why things happen.  

Generally, there is a large amount of mapping methods that urban planners, developers and 
scholars apply. Geographical information science and systems (GIS) are well established in 
displaying and analysing especially quantitative information respective to spaces and places 
(see sections 4 and 5). But maps can be equally useful a tool for qualitative research and 
digitalised maps are not exclusively for quantitative information. These kinds of methods are 
called participatory mapping. In general terms, it is ‘a process in which community members, 
writ large, contribute their own experiences, relationships, information, and ideas about a 
place to the creation of a map’20. 

Under this large umbrella term, the so-called Public Participation GIS (PPGIS) methods have 
become very popular in recent years, allowing for practitioners and scholars to collect 
qualitative information that is placed on online maps by the subjects of the study21. Digitally 
shared maps allow research participants to provide open-ended responses about their living 
environments to explain what places are meaningful for them, what kinds of patterns of 
everyday movement they have or what kind of activities they engage in in certain places. 
This kind of participatory mapping can offer a valuable tool for integrating citizens’ 
perspectives (especially marginalised ones) into decision-making, bridging the gap between 
policy and the public. They can highlight the different voices of different stakeholders, 
understand the affordances that are currently available to people or identify areas where 
something a lacking or going wrong. PPGIS is often also directed towards the future, 
envisioning more just and sustainable streets and neighbourhoods. 

On the other hand, participatory mapping can also be an analogue and highly interactive 
data collection method, where maps are being used to facilitate and inform interviewing, 
observations or other methods that intimately engage with people. This kind of an approach 
often also called community mapping, where certain collective or community is invited to map 
their struggles and aspirations in urban space can aim for simultaneously studying and 
empowering the participants. 

Participatory mapping approaches - Implementation 

Here the focus is on the implementation of more analogue and interactive community 
mapping that can be combined with interviewing and participant observation. However, many 
of the implementation steps and principles here are relevant also for the digital and online 

 
20 Cochrane, L., & Corbett, J. (2020). Participatory mapping. Handbook of communication for 
development and social change, 705-713. 
21 Fagerholm, N., Raymond, C. M., Olafsson, A. S., Brown, G., Rinne, T., Hasanzadeh, K., ... & Kyttä, 
M. (2021). A methodological framework for analysis of participatory mapping data in research, 
planning, and management. International Journal of Geographical Information Science, 35(9), 1848-
1875. 
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approaches. Many tools and data sets are available for online participatory mapping, both 
open access22 and commercial23. 

Community mapping can begin with a pre-drawn map of certain area for participants to 
modify or by allowing them to create maps entirely from scratch. Mapping can be done with 
and individual or with a group. Mapping demands facilitation, not unlike focus groups (see 
section 3.4) and the facilitators prompts and questions are instrumental in fostering dialogue 
and the creation of the map. Participants can be for example encouraged to identify and 
mark locations they find significant or relevant to a street renovation project’s goal. 
Facilitator’s questions can be very specific—for instance, asking how certain streets are 
being used—or open-ended, allowing participants to highlight what they value or see as 
barriers to use and access. 

Participatory and community mapping can take many forms but here are some of the key 
steps to take: 

1. Determining the subject of the study. Just as with other methods discussed above, 
consider first what is the thing that you want to study. Regarding participatory 
mapping, it is crucial also to connect this scope of the study to certain places. 
Consider for example, what is the ‘’problem’’ or future development that is being 
studied and where it is situated? What is it exactly in certain places that you want 
people to discuss? 

2. Creating a plan. Not unlike with interviewing and participant observation, it is crucial 
to plan participatory mapping sessions accordingly. Consider the groups, practices 
and people you want to engage with but also the place where you want to do it. 
Sometimes it is beneficial to do it ‘’on the field’’, for example on the street but 
sometimes better to do it indoors. Consider also what kind of a template you want to 
use (i.e. is there a map to be ‘’filled out’’) and how much do you want to have people 
drawing, writing and engaging with the map. Sometimes it is also useful to use other 
elements such as sticky notes or play figures. Remember, ‘’a map’’ is always a 
distorted image of the reality and participatory mapping can be highly creative! 

3. Executing the exercise. During the exercise, make sure that you explain very clearly 
what the aim of the mapping is and prepare a set of very concrete questions, tasks 
and prompts. Participatory mapping can be an individual or a group exercise. In the 
latter case it is important to acknowledge that everyone involved gets to raise their 
concerns and properly engage with the map. And don’t forget to record what people 
say when creating the map, just like with a normal interview. Video recording can also 
be a good option because people often just point to the maps saying ‘’over there’’ or 
‘’this part’’. 
 

Experiments and action research - Background 

Action research is a broadly defined research approach that aims simultaneously to 
investigate and transform current street design and uses. Different from talking to people and 
observing them, it is focused on change —whether technical, social, societal, ethical, or 
professional. Another defining feature of action research is the active involvement of the 
people whose practices are being studied, making them participants in the change process. 
For instance, action researchers often collaborate with planners to analyse community 
feedback on proposed urban designs or assess the quality of public spaces through field 

 
22 See for example, https://participatorymapping.org/resources/open-source-gis/ 
23 See for example https://www.maptionnaire.com/blog/participatory-mapping-best-practices-tools-
examples 

https://participatorymapping.org/resources/open-source-gis/
https://www.maptionnaire.com/blog/participatory-mapping-best-practices-tools-examples
https://www.maptionnaire.com/blog/participatory-mapping-best-practices-tools-examples
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observations and surveys, which in turn should impact street designs. In iterative cycles of 
action and collaborative reflection the aim is to understand how street designs and uses 
could be better, more just and sustainable. 

Action research can focus on developing the practices of planners in designing streets and 
neighbourhoods or it can incorporate practical experimentation and action on the ground. 
Here street experiments and some forms of tactical urbanism have become a prominent 
method in urban governance. Generally, this means introducing more or less temporary 
changes in the street layout (e.g. transforming parking spaces into something else) or street 
uses (e.g. closing the street to traffic during certain hours of the day) and then studying 
peoples experiences. The point of such approaches is to challenge street users, planners, 
policymakers and other stakeholders’ understandings of what kinds of street designs and 
uses are ‘’good’’ or ‘’bad’’.  

Yet this is not to undermine people’s views but facilitate learning among them. The point of 
street experiments and action-oriented approaches is that when people get to experience 
different ways of moving and living, they might learn something new about themselves, their 
everyday lives or, in the case of professionals, about their established ways of thinking and 
designing streets. In other words, the aim of experimental and action-based approaches 
should be not only to test if something simply ‘’works’’ but also to test what kinds of reactions, 
ideas and imaginations they evoke24.  

Experiments and action research - Implementation 

Experimental and action-based methods usually consist of a sequence of steps: identification 
and problem statement; design and implementation; observation and data collection; and 
analysis and reflection. However, it is useful to think of this kind of a process as cyclical 
rather than linear, because after step 4 the process proceeds can start again from step 1 with 
a new line of action and a new problem statement. 

As a facilitator and catalyst for change, your role goes beyond mere participation; you 
actively assist individuals or groups in reshaping aspects of their reality, as seen in 
approaches like action research. 

1. Identification and problem statement. The first thing to do is to identify a place 
where experiment will be conducted. Simultaneously, it is important to understand 
different people’s viewpoints on what problems they think that the experiment might 
solve and how. It is important to note that different stakeholders’ views in this respect 
might vary significantly. 

2. Design and implementation. The design and implementation of the experiment is 
ideally a participatory process that pays attention to the specific context. For example, 
conducting street experiments on school streets are likely to be very different from 
those conducted on busy streets with restaurants, cafés and other amenities with a 
large variety of stakeholders.  

3. Observation and data collection. To understand the learning of different 
stakeholders, it is crucial to establish systematic and rigorous processes for collecting 
data on people’s experiences. This can involve for example interviewing, 
observations or participatory mapping as discussed in the above, or more quantitative 
methods such as surveying. 

4. Analysis and reflection. Finally, observations and experiences during the 
experiment should be analysed and reflected. This is, again, ideally a participatory 

 
24 Evans, J., Karvonen, A., & Raven, R. (2016). The experimental city: New modes and prospects of 
urban transformation. In The experimental city. Routledge. 
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process where different stakeholders come together to discuss why the experiment 
created certain consequences and effects and why they were experiences in a certain 
way (see section xx on Focus groups). After these reflections the action research 
cycle can start again: the experiment can be turned into a permanent street design, it 
can be modified, or it can spark other development processes on the level of the local 
community or planning professionals. 

 

Figure 16. Workflow for practical application of interactive and co-creative methodologies in qualitative 
research. 
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3.4 Practical example: International focus groups for advocacy organizations in 
Just Streets 

In JUST STREETS, an international focus group was organized with advocacy organizations 
representing street users that are often unheard in planning and policymaking processes, 
such as people with intellectual or physical disabilities, older people, children, homeless, and 
advocacy organizations for active mobility modes, such as cycling and walking. The following 
outline summarizes in a practical way the steps followed in the organization of the JUST 
STREETS international focus group, which can inspire cities to organize their local focus 
groups on street justice. The eventual focus and objectives should be determined respective 
to the local dynamics and aims. 

Planning 

Organizing a focus group to delve into the issues of street justice in street design and use 
can be related to a variety of context-based specific objectives. However, some general 
objectives should be considered when organizing focus groups on issues related to just 
streets. Three main objectives of the JUST STREETS international online focus group were: 

• To bring together a diverse range of stakeholders to discuss their intersectional needs 
and insights on justice in street design and uses. 

• To gain, generate and share intersectional knowledge of street justice and the needs 
of street users that are often unheard in planning and policymaking processes 
(identifying the mechanisms that can make streets more just, especially from the 
viewpoint of knowledge creation, data and design processes). 

• To involve stakeholders that are normally absent from the discussions and decision-
making arena around street design and planning and/or facilitate the advocates’ 
connections to cities, planners and policymakers. 

As well as the objectives, procedure and structure, also the expected outcomes are 
inherently context dependent. Given the flexible nature of focus groups, the outcomes may 
vary based on how the discussions are facilitated and the dynamics between participants in 
the plenary sessions and eventually in the breakout rooms. While this adaptability allows for 
diverse and tailored insights, having some anticipated and desirable results guide 
expectations and ensure a productive discussion. In JUST STREETS focus group, we set the 
following expected results:  

• To bring various organizations representing different views on street justice to share 
and discuss their perspectives in a constructive manner. This outcome is closely tied 
to ability, accessibility, and capacity to effectively engage and gather these 
organizations. 

https://doi.org/10.1080/13645579.1998.10846874
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• To enable meaningful interactions and exchange of experiences between advocates, 
planners, stakeholders, and policymakers, fostering and facilitating the connection 
among actors. 

• To produce a clear and accessible summary of the critical challenges that have 
emerged from the focus group. These summaries can be shared with participants, as 
well as other relevant stakeholders and policymakers. 

• To identify and prioritise the most critical issues for targeted actions and interventions. 

• To increase awareness of participants and actors to have an inclusive approach.  

• To identify the potential barriers which can hinder future collaboration and 
implementation of actions.  

• To inspire participants to take ownership of the issues discussed and commit to 
follow-ups and ensure the impact.  

Preparation 

After having defined the objectives and the categories of advocacy organization to ideally 
involve, it is necessary to set a date and choose a format. For the JUST STREETS focus 
group, we set the date 3 months in advance. Then we mapped the potential organizations to 
contact through online and desk research, LinkedIn contacts, Just Streets cities and partners’ 
contacts and suggestions. As a result, we created a preliminary list of potential participants 
with their contacts (1 month and half before the Focus Group). The following step, that 
required three weeks, has been contacting all these organizations through two rounds of e-
mails, the first to general addresses, the second by searching for specific contacts of people 
responsible for the organizations. Once we had the confirmation of most of the organizations 
and participants who filled up a brief questionnaire, we prepared the structure for the 
session. The questionnaire allowed us to start getting to know the participants, organise 
diverse and balanced breakout rooms, and have an initial idea of some specific elements to 
touch upon during the facilitation.  

An important part of the preparation is determining the division of work in the facilitation 
(taking notes, recording, managing online or analogue tools, etc.). There can be multiple 
facilitators or only one. In the Just Streets international focus group, since there were 20 
registered participants, after a short plenary session we defined three break-out rooms25 of 
6-7 participants (which were the actual focus groups). 

Conducting the focus groups 

The facilitation and organization of the focus groups aimed for an informed and structured 
but open exchange of views by involving participants from diverse and relevant international 
backgrounds. The focus group sessions fostered a meaningful dialogue that deepened the 
understanding of the JUST STREET project and integrating multiple viewpoints to a global 
perspective.  

Upon consent from the participants, who were informed about the purpose and use of the 
recording, the focus group was recorded. The recording is very useful for the analysis and 
processing activities of the results. In the case of in-person focus groups, it is recommended 
to involve more people who can take notes. 

The table below illustrates the steps and structure of the JUST STREETS international online 
focus group. 

 
25 If the focus group is organised in person, there must be separate tables for each group of 6-10 
participants. 
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Table 4. Overview on the structure of the JUST STREETS international online focus group 

Phase Tasks Content 

Plenary | 
facilitation 

General introduction; 
aims  
5 min      

• Why we are organizing this workshop, what the objectives are and 
how we intend to disseminate the results  

• What is Just Street Project   

Plenary | 
facilitation | 
mentimeter 

Warm up session and 
participant overview     
10 min  

• Mentimeter ice breaking  

• Overview of the participants, their organizations, target groups 
and main activities 

Plenary | 
facilitation 

Introduction of the 
Just Streets project 
10 min      

• Practical examples of what Just Streets does    

Breakout 
rooms | 
facilitation | 
recording 

Distribution  
30 min 

Introductions  

• Floor to everyone for 2 min. Emphasise that the aim is to build on 
each other’s thoughts and that people can also disagree.    

Discussion questions   

• What are the needs of different street user groups?     

• Why are street design and uses creating social injustices?    
Facilitating questions    

• Is mobility policy and urban planning an important agenda point 
for your organization?    

• Why are the different groups suffering injustices?    

• What kinds of street designs and uses are dominating / 
marginalised?    

• What kinds of uses/users/behaviours are harmful?    

• How and when do the needs of different actors’ conflict?    

• How can conflicts be resolved?    

Pause 10 min 

Breakout 
rooms | 
facilitation | 
recording 

Procedures  
20 min      

Discussion question  

• How can we incorporate the needs of different street users into 
design and planning?    

Facilitating questions   

• How are different groups interests, needs and experiences 
acknowledged in current planning and design processes?    

• What are the main principles of planning and design and how do 
they discriminate certain groups?    

• What is missing from street design / planning processes?    

• Who are the main actors dictating street uses and design?    

• How could your organisation become more active in the field of 
urban mobility? What would you need for this?    

• What kinds of experiments should we organise?    

Breakout 
rooms | 
facilitation | 
recording 

Recognition 
20 min       

Discussion question   

• What kind of knowledge is needed to support just and inclusive 
planning and design?    

Facilitating questions   

• Where are the biggest ‘blind spots’ of mobility planning?    

• What kinds of data (if any) currently explain the injustices?    

• What kinds of data could reveal the injustices but is not collected 
/ used?    

• What kinds of data creation processes should be created to 
counter existing injustices?    

Plenary | 
facilitation 

Debrief, conclusions 
and next steps  
10 min      

• Recap of the breakout rooms   

• Feedback form will be sent out    

• Results will be used to inform the Just Streets network 

• We are open for requests and follow ups 
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Conclusions and recommendations 

This case is an example of how focus group can be a valuable qualitative methodology to 
promote discussion between different advocacy organizations which can share their vision on 
issues and topics related to street justice. By promoting a debate between different 
perspectives and mobilizing a variety of know-how and skills, focus groups can allow a 
deeper understanding of issues related to just streets. Furthermore, focus groups represent a 
valuable opportunity to include people, organizations and voices that are not always 
considered in the decision-making processes regarding street design and use.  

The focus group discussion explored three key aspects of justice framework (EEA, 2024): 
distribution, procedure, and recognition. Participants emphasized the need for equitable 
street space prioritisation, focusing on pedestrians, vulnerable groups like families and 
individuals with disabilities (including the vulnerable individual such as autism with sensory 
sensitivities), and public transport over cars. The representatives also highlighted the 
importance of safe, accessible public spaces near schools and residential areas, strategies 
for balancing traffic flows and pedestrian needs, and tailored approaches such as 15-minute 
cities and pedestrian zones adopted to local contexts. The participants emphasized the 
knowledge required to support just and inclusive street planning including the necessity of 
both quantitative (statistical) and qualitative data to make decisions. Additionally, they 
identified a gap in disaster preparedness data, which should be considered when planning 
for safer and more inclusive streets.  

The following 10 practical steps outline the organisation of the JUST STREETS 
international focus group: 

1. Definition – Identify the objectives, expected outcomes, participant categories (e.g., 
street users, policymakers, advocacy organisations, etc.), scale (local to 
international), and typology (online, in-person, etc.). 

2. Mapping – Identify and list participants with their interest and contact details in a 
table, ensuring alignment with the aim and scale of the focus group. 

3. Inviting – Utilise the appropriate contact methods to invite participants, follow up to 
confirm attendance, and finalise the list. 

4. Structuring – Define the focus group structure based on participants numbers, 
availability, session formats (plenary or breakouts), required tools based on the format 
(e.g., powerpoint, miroboard, posters, dashboards, etc.), and division of 
responsibilities (facilitation, recording, etc.).  

5. Reminding – Share logistical details and the finalised structure with participants 
before the session.  

6. Adapting – Anticipate challenges and be prepared to adjust the structure of the focus 
group as needed. 

7. Summarising – Consolidate and share key takeaways from all sessions during a 
plenary/ breakout room discussion.  

8. Asking for feedback – Collect participant feedback using surveys or other tools post 
session. 

9. Analysing – Review discussions and insights to extract key findings. 
10. Inspiring – Encourage participants to collaborate further based on shared ideas and 

needs identified during the focus group. 

The above are intended as general steps necessary to organize a focus group to gain 
qualitative insights into justice in the design and use of streets. Each of these steps will take 
on connotations, content, timing and modalities that will vary depending on the specific 
context in which the focus group is organized. 
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RECOMMENDATIONS for the organization of a FOCUS GROUP 

Define and communicate very clearly the objectives and the expected outcomes of the 
Focus Group, already prior to the session. 

To get people talking it is good to start by introducing the topic and facilitators. Consider 
an icebreaker to create a welcoming environment. It is also a good idea to give invited 
organizations and people enough space to briefly present their work and thoughts and 
interest regarding the topics and aims of the focus group. 

Confirm the session's time (usually meet 45-90 minutes but some can last longer; 
schedule a few breaks), date, and format (in-person or online), ensuring a comfortable, 
distraction-free environment.  

During the sessions, note taking and recording are crucial for collecting the insights and 
having concrete data to analyse afterwards. 

Prepare a feasible timeline for organizing the focus group that considers the time needed 
to complete all the necessary steps. 

The facilitator is in charge that the session remaining a safe space where people are 
comfortable sharing their views and no-one is allowed to be hostile or disrespectful, even 
though the topics may sometimes be controversial. The exchange of views should be 
democratic. Try to keep responses time equal among participants. Maintain a balanced 
discussion by encouraging quieter participants and moderating dominant actors. 

Prepare for changes: often some people might not be able to join and think beforehand 
what kinds of issues may arise during the discussion or the overall logistics. If the focus 

group session does not flow properly, the results might be partial or non-usable. 

Prepare an interview guide that contains all the topics that need to be covered in all the 
focus group sessions. Additionally, prepare a list of facilitating and concrete questions for 
the facilitator(s). This is a way to keep the discussion going and provide differing entry 
points to the topics. 

Debrief the content of focus group discussion to consolidate the observations and 
impressions. After each part/section of the focus group session it is a good idea to 
summarize the debate and the main issues that emerged. This provides the session with 
more structure and a sense of purposefulness. 

After the session it is important to allow participants to provide feedback. This can be done 
for example with a simple online survey. Consider also how to nurture and inspire the 
participants to continue sharing their feedback and thoughts with the organizers or each 
other. At best the focus group can kick-start new collaborations based on shared insights, 
needs and ideas that emerged during the focus group. 
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Figure 17. Workflow for practical steps to conduce a focus group. 

3.5 Analysis and expected results 

The methods outlined above can produce a rich variety of information, data and insights. As 
discussed in the beginning the eventual research approach that can inform urban problems 
and transformations is often a flexible combination of methods. All methods shed light on 
some aspects of the issues at hand and not others. For example, relying too much on 
interviews (what people say) might sway the attention from actual behaviours (what people 
do). 

Subsequently the researcher ends up with certain concrete materials audio/video recordings, 
transcripts, fieldnotes and other documents, or as discussed things like maps or physical 
experiments with all connected documentation. The next step is evidently analysing that 
material and ‘making sense’ of what has been observed. Analysis of qualitative materials is a 
vast field with different approaches, methods and paradigms. But the term might also often 
sound more complex and fancier than it actually is.  

In the simplest form analysis involves simple tasks such as reading and organizing textual 
material, examining its content and structure, and reflecting on what it reveals. This process 
may include categorizing the material based on themes or topics to make sense of a diverse 
and often rich collection of texts. Analysis aims to summarize and structure content, such as 
interviews or narratives, while exploring how issues relevant to the research questions are 
represented and expressed. By scrutinizing and comparing the material, the researcher aims 
to turn information into knowledge – go beyond the data in its raw form. In any case the 
analysis should be driven by the research problem or the issue that a given project is aiming 
to solve. 
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After analysis, the results are reported. This can take any format from a conventional written 
report to more creative forms. It is important that the report contains information on how the 
research was done. Especially in qualitative studies, the practitioners and researchers need 
to openly document their fieldwork process, specifying the number of participants engaged, 
the meetings and environments observed, the timeframe of the study, and the methods used. 
This is to boost the credibility of the study and enable people to assess the relevance of the 
findings. Especially when it comes to issues of social justice, final reports should prioritize 
representing the voices of those in the field by including abundant direct quotes, firsthand 
expressions, and vivid descriptions.  

3.6 Reflexivity and ethics 

Analysis and reporting should also clearly distinguish where the researchers' perspectives 
align with or differ from those of the participants, with a commitment to transparency. 
Especially in ethnographic research, the person conducting and reporting the study should 
be reflexive. This means openly discussing one’s own worldviews and social positionality 
(e.g. gender, ethnicity, class position) respective to the results. The above discussed 
methods involve many choices made in the research process and things are ‘’measured’’ 
using the researchers’ human capabilities, critically reflecting the research process cannot be 
neglected. All research methods have their inherent problems and biases, and reflexivity is a 
means to control them. 

Reflexivity is part of the wider realm of research ethics. Regardless of whether the study is 
“academic” or “practical”, studying people has several ethical dimensions. The basic steps in 
the methods discussed above should in minimum involve the following ethical considerations 
and procedures. 

• Before data collection it is important to obtain informed consent in writing, or when 
not possible, a recorded verbal account. A good practice is to inform the participants 
with a letter on what the study is about; how their data will be used and how their 
privacy is protected; and that they have the right not to participate or to stop their 
participation at any point and withdraw their data. When working with diverse or 
marginalised people making sure that information about the study is provided in an 
understandable manner (e.g. with minors, disabled people and non-native language 
users). Moreover, if it is possible that the study is likely to cause any harm to them or 
instil distress of any kind the participants should be informed (e.g. it is always good to 
inform people on how long a participatory mapping activity will take). 

• During data collection it is crucial to make sure that the participants feel safe and 
valued and make sure that the study causes minimum harm to them (in terms of 
distress, time etc.) When working with marginalised groups it is important to be 
sensible about the struggles that they might be going through and use unoffensive 
and inclusive language. Sometimes it is a good idea to talk with experts working with 
the specific marginalised groups before engaging in field work with qualitative 
methods.  

• After data collection and in data processing and analysis, it is crucial to preserve 
the anonymity of participants and locations, honour privacy and confidentiality 
agreements (e.g. GDPR in the EU), secure sensitive information, acknowledge one's 
conflicts of interest and positionality, and ensure that data is not misused. In 
participatory, experimental and action-oriented research settings it is important to also 
keep participants informed about the subsequent steps of the project. 

By employing rigorously tested and standardized data collection methods, many potential 
ethical challenges can be identified and addressed before they arise. But as far as the 
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above-described methods are not providing a predefined and structured approach, there is 
greater moral responsibility on the researcher to address ethical issues. Importantly, the 
people and organisations conducting the research also bear accountability for the potential 
impacts of the research. Especially when studies are directly affecting urban transformations, 
residents living conditions or policy processes, the causal consequences of the knowledge 
creation are a crucial part of research ethics. In other words, ethics is not a ‘’task’’ that needs 
to be ticked off but an integral part of the research process from start to finish that is 
constantly reflected. Here is a minimum checklist for reflexivity  

• Personal reflexivity: How is my social identity and positionality (e.g. as a white 
middle class male) effecting the results? How are my worldviews effecting the 
research process? 

• Interpersonal reflexivity: What kind of a power-relation do I have respective to the 
research participants (e.g. the power of the street designer on the residents of the 
street)?  

• Methodological and contextual reflexivity: How can get different views on my data 
and findings (e.g. working with other people or in teams of diverse people)? How are 
other aspects of the research context influencing the research and people involved 
(e.g. socio-cultural meanings and histories of urban spaces)? 

3.7 Conclusions 

Doing research is complex. The above is a very superficial exposé of methods where 
practitioners and researchers directly engage with people who have stakes in urban 
planning, and this might seem even more complex or laborious a task than many other 
methods. This is especially since qualitative and action-based methods discussed here do 
not provide a directly implementable toolkit that works for every issue in every context.  

But still urban planners, experts and practitioners need these methods because they provide 
knowledge that is different and complementary to more quantitative methods and those kinds 
of methods that do not engage directly with people. In practical terms a good way to 
familiarise oneself with the procedures of certain method is to see how others did it. There 
are a lot of open access academic articles available on all the methods and approaches 
discussed here.  

But on a more profound level, the point is that these insights should not be thought of as 
tools for ‘’extracting’’ data, but rather to rethink the role of planners and experts. Especially 
when it comes to redesigning and changing the physical layout of urban space and the ways 
that people use it, the role of an action-researcher is potentially very valuable. Creating 
change, observing its consequences, reflecting it together with diverse stakeholders can 
create a positive circle of social learning and professional growth where the learnings are 
always informing subsequent actions.  
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Figure 18. Overview of requirements and applicability of interactive, co-creative, and participatory 
qualitative methodologies  
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4. Syntactical methods and microscale approaches  

4.1 Introduction 

This section provides guidance and knowledge for collecting, processing, and analysing 
spatial data to understand the needs, patterns, behaviours, and habits of streets and users 
across European cities. The proposed analytical protocol combines syntactical methods 
(Space Syntax) and microscale analyses (GIS) to understand how street networks and 
structures influence how our cities are used. The underlying assumption is that a city's form 
and structure (morphology) impact how people use, understand, and value urban spaces. 
This contrasts with more direct approaches, such as direct observations on how users 
navigate the streets. This approach looks at how the city is organised and formed and 
departs from that understanding to several key principles that can help to predict and identify 
user behaviour and needs.  

Key Objectives 

The protocol provided addresses how and which data to collect, which types of analysis 
fit best, and the most common workflow that can help combine the different types of data 
and analysis available using predominantly open-source data. This section aims to: 

• Introduce the key principles and approaches behind a syntactical method and 
microscale approaches. 

• Propose a comprehensive protocol using open-source data where possible with a 
combination of GIS and Space Syntax tools. 

• Create standardised procedures for syntactical and microscale data collection and 
data analysis. 

• Establish efficient workflow for data acquisition and provide workflow practical guides 
and tips. 

We start by first introducing i) basic concepts of syntactical methods and microscale 
approaches, highlighting key principles and analysis methods with applications across 
different scales, and important limitations and considerations. This is followed by a ii) data 
collection and analysis protocol that provides step-by-step guidance for spatial analysis, 
including data collection methods, analysis techniques, and visualisation. Next, a typical iii) 
workflow is shown that covers the entire analysis process implementation with quality 
control checkpoints. Here, we will also explain practical applications using QGIS and 
DepthMapX and suggest methods for effective stakeholder engagement. We close the 
section with an iv) implementation guide, addressing technical requirements and software 
setup, outlining best practices for cities and suggesting data organisation and management 
strategies. 

Intended Users 

This section will address three different levels of knowledge and skills. 

Beginner: Community stakeholders and organisations with no technical expertise in 
specialised software (GIS etc.)  

• Expected to read, interpret and understand analysis results, such as identifying areas 
needing better connectivity or locations for new facilities 

• Should be comfortable with everyday digital tools like, using web browsers or reading 
and navigating digital maps. 
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• Familiar with basic mapping interfaces such as Google Maps (or any from PPGIS), 
can understand basic map features (scale, legend, layers), and is comfortable using 
Google Street View to examine urban environments 

Intermediate: Policy makers, planners and designers with some technical expertise in 
specialised software (GIS etc.)  

• Expected to be able to conduct the basic level of data preparation and analysis 
followed by interpretation for decision making. 

• Should be comfortable using mapping or GIS software and working with datasets, 
some level of familiarity with basic GIS concepts such as projections 

• Understanding of urban planning principles and concepts related to travel behaviour, 
network science and morphology 

Advanced: Academic researchers and spatial analysis specialists with advanced technical 
expertise with spatial analysis software (GIS, Python, R etc.)  

• Expected to innovate methods and conduct advanced comparative analyses to 
generate new insights 

• Should have extensive experience and is skilled in programming languages (Python, 
R) 

Each section provides appropriate guidance and tools for these different user groups, 
ensuring the protocol can be implemented effectively regardless of technical background. 

4.2 What does this section mean for you? 

Beginners will be able to identify key features that make spaces feel safe and welcoming. 
They will learn to describe how different street layouts affect daily activities and participate 
effectively in community discussions about public space improvements. Through this 
knowledge, they will apply basic concepts to evaluate their own neighbourhood spaces. 

Intermediate users will be able to analyse how street design influences movement patterns 
and evaluate accessibility to key community services. They will apply analytical tools to 
assess street safety and develop solutions for creating more walkable environments. This 
knowledge will enable them to synthesise findings and recommend meaningful street 
improvements. 

Advanced Users will be able to design and conduct complex spatial analyses while 
evaluating relationships between urban form and social behaviour. They will create 
innovative methods to measure spatial accessibility and synthesise research findings to 
generate new insights. Through their expertise, they will develop and test hypotheses about 
urban space usage and propose evidence-based solutions for equitable urban access. 

4.3 Basic concepts of syntactical methods and microscale approaches 

Syntactical methods refer to the analytical approach of studying spatial relationships 
and patterns in a way similar to how we analyse the structure (syntax) of language. Just as 
language has grammar rules that govern how words connect to form meaningful sentences, 
syntactical methods in spatial analysis examine how spaces connect and relate to each other 
to form meaningful urban patterns. 

Space Syntax is the primary and most well-developed framework for conducting such 
syntactical analysis of space. Space Syntax is a method and tool developed in the 1970s-
80s by Bill Hillier and Julie Hanson and their colleagues at University College London to 
understand how spatial design influences human behaviour. As outlined in their seminal 
work "The Social Logic of Space" (Hillier & Hanson, 1984) and further developed in "Space is 



 

 

 54 

the Machine" (Hillier, 1996), the theory provides practical tools for analysing how people 
move through streets and use spaces in cities and buildings. Since then, the space 
syntax research has grown to include data from observed use, social media scraping, 3D 
analysis for height and terrain to improve beyond a 2D abstraction of a city. Recent advances 
in Space Syntax research have made it more accessible and practical. Previously manual 
data collection and analysis have been improving with more user-friendly software such as 
DepthmapX (open source) and ability to connect via various QGIS plugins that make it easier 
to analyse city layouts. These tools can now process larger datasets which is great for cities 
and work with common mapping formats to ensure ease of sharing data and combining with 
other data. For example, there are now web-based tools that let city planners and community 
groups visualise and analyse their neighbourhoods without needing specialised training. 

Microscale approaches used in relation to Space Syntax methodology looks at how 
physical details of our environment can affect how people move and behave. Think of it like 
studying the details of everyday spaces we use, such as streets and their intersections, non-
formal pathways around, in-between and through buildings, or even openings (doors and 
windows) in the facade of buildings. For example, let us look at a neighbourhood park to 
understand this better. If we wonder why people always gather at a certain place of the park 
and not equally spread out in the part, a microscale analysis might look at the position of 
benches, furniture, lighting objects together with ingress and egress routes and if there are 
clear sightlines between landmark objects or certain flora and fauna. The position and 
location of these objects can determine if users feel able to orientate themselves with ease or 
feel more safe walking along the paths of the park. The analysis might provide insights on 
where to add more lighting or furniture to improve use of the space. 

Key Principles 

Space Syntax 

• Space Shapes Movement: The layout of streets and buildings naturally guides how 
people move  

o Example: A straight, well-connected street typically sees more foot traffic than 
a winding, isolated one 

• Connectivity Matters: The value of a space depends on how it connects to other 
spaces  

o Example: A plaza with multiple entrance points is likely to be more active than 
one with limited access 

• Visual Access: People navigate based on what they can see and how directly they 
can reach their destination in an intuitive way 

Microscale 

• Proximity: The physical closeness of elements affects how people use spaces  
o Example: Benches placed near building entrances or along pathways tend to 

be used more frequently and can create natural gathering points. 

• Density: The concentration of spatial elements influences behaviour patterns  
o Example: Areas with higher density of street lighting often feel safer and more 

welcoming, while too many elements can confuse of create congestion. 

• Clustering: How elements are grouped together shapes movement and interaction  
o Example: Strategic grouping of benches, trees, and lighting can create natural 

social spaces and invite users to interact intuitively. 
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Analysis Methods 

Space Syntax uses several main types of analysis to help us understand cities' streets and 
public spaces: 

• Movement Lines: Mapping the longest straight paths through spaces 

• Visible Areas: Identifying spaces where all points are visible to each other 

• Connection Networks: Analysing how different spaces link together 

• Activity Nodes: Identifying where people tend to gather and interact or clustering 
(density) of points of interest 

• Network analysis: Measuring how well-connected different areas in distance or time 
costs 

Applications across scales 

Syntactic analysis (using Space Syntax) of street networks can be used in various ways and 
across scales and is therefore applied in different fields and areas (see Table 5 for an 
overview). In urban planning, it can help create better walking routes and safer 
neighbourhoods, as shown in Medellín, Colombia (Goodship, 2016). For buildings and 
airports, it improves how people find their way around, with British Museum, Tate Britain 
being a prime example (Tzortzi, 2011). In retail areas, it helps decide where to place stores 
and how to design walkways (Andi et al., 2021). For public spaces, it creates better 
community areas, like Melbourne's Federation Square (Daly, 2023). Finally, in historic sites 
like Jeddah's Old City, it helped balance tourism with preservation (van Nes and Yamu, 
2021). 

At the microscale level, GIS tools complement Space Syntax by analysing how small-scale 
configurations of physical objects and environmental factors influence behaviour. For 
example, the placement of benches, lighting, and pathways in a park affects how people 
navigate and use the space. In building design, microscale analysis optimises interior layouts 
for better wayfinding and social interaction. At the street level, it examines how elements 
such as building entrances, street furniture, and visibility between spaces shape pedestrian 
movement and safety. 

Table 5. Overview of application, key uses and real-world examples of analysis 

Application Key Uses Example 

Urban Planning Optimise pedestrian pathways 
Transit station placement 
Crime prevention through design 

Medellín, Colombia: Street network 
redesign reduced crime and improved 
social cohesion 

Architecture Wayfinding in complex buildings 
Space optimisation for interaction 

British Museum, Tate Britain: identify 
spatial layout to plan new wing. 

Retail & 
Commercial 

Strategic shop placement 
Shopping mall navigation 

Colchester: Designed for maximum 
movement and visibility for retail. 

Public Space 
Design 

Foster community gathering 
Enhance neighbourhood connectivity 

Redevelopment of Trafalgar Square, 
London; Federation Square, Melbourne: 
Enhanced connectivity to surroundings 

Heritage 
Conservation 

Balance visitor access with preservation 
Manage tourist flow patterns 

Old City of Jeddah, Saudi Arabia: 
Managed tourist movements while 
preserving historic fabric 

 
Key concepts, types of analysis and appropriate questions 

Space syntax, using the Depthmap software or equivalent plugin on GIS, offers a few 
complementary approaches to understand cities, their streets and how people may use 
them. These are usually on the basis of axial maps (studying longest sight lines), segment 
maps (examining street segments between intersections), visibility graph analysis 
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(studying visual relationships), or convex space analysis (analysing enclosed spatial units). 
Together, they can produce the following analysis and considerations. 

• Integration Analysis: "How 'accessible' (connected) is this location?" (derived with 
axial maps) 

o High integration: Which areas are natural destinations for shopping and social 
activities? 

o Low integration: Where are the quieter, more private spaces likely to develop? 

 

 

Figure 19. Example of a global integration (Radius = n) adapted in GIS 

Integration measures how 'accessible' or "close" a location is to all other locations, making it 
a better predictor of destination-oriented movement. This is also called 'To-movement' 
potential or Where are people most likely to go or where are common or popular destinations 
within the city? 

• Choice Analysis: "How likely is this route to be used with all things being equal?" 
(derived with segment maps) 

o High choice: Which streets will naturally become main transportation 
corridors? 

o Low choice: Where will we find quieter, neighbourhood streets? 

Practical	3	test_Segment_Map

Study	area	11

Connectivity

Low

Below	average

Average

Above	average

High

OpenStreetMap
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Figure 20. Example of an angular choice analysis (r = 400 m) 

Choice analysis, on the other hand, measures "through-movement" potential, making it a 
better predictor of route choice (hence the name). It asks which routes will people use to get 
there? 

• Betweenness Centrality: "How important is this space as a connecting route?" 
(derived from segment maps) 

o High betweenness: Which streets act as crucial links between different areas? 
o Low betweenness: Which streets mainly serve local access? 

Betweenness looks at how often a street is used as a "stepping stone" when moving 
between any two places in the city. Streets that connect different neighbourhoods or lead to 
important crossing points (like bridges) usually have high betweenness values. This helps us 
spot routes that might need better sidewalks or improved public transport because lots of 
people use them to get around. 

• Depth: "How many steps does it takes to reach this space?" (derived from segment 
maps) 

o High depth: Which spaces require many turns or connections to reach? 
o Low depth: Which spaces are easily accessible with few turns? 

Depth measures how many steps or turns it takes to get from one place to another in the city. 
Spaces that need many turns to reach (like quiet residential streets) have high depth values, 
while spaces that are easy to get to (like main streets) have low depth values. This helps us 
understand which areas might feel more private or isolated, and which ones are more 
publicly accessible. 

• Convex Space Analysis: "How do distinct spatial units connect and relate to each 
other?" (derived from convex maps) 
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o Creates a diagram where each convex space is represented by a point/circle 
o Shows relationships between spaces through connecting lines when spaces 

share boundaries 

Convex space analysis transforms spatial layouts into abstract diagrams that help 
understand spatial relationships. A convex map is created by dividing space into the largest 
and fewest possible convex units (where all points are visible to all other points within that 
unit). These are then represented as points in a diagram, with lines connecting points 
wherever their corresponding spaces share a boundary (face or part of a face, but not just a 
vertex). This creates an adjacency graph that reveals the underlying structure of spatial 
relationships and connectivity patterns. 

Additional analysis (for intermediate and advanced users) 

The following analysis are additional analysis that can help improve how the 2D street 
network data can be better understood and interpreted. They do not have to be conducted 
using only DepthMap. There exists plugins or tools in GIS platforms that can help us achieve 
the same or even better results. 

• Visibility Analysis: "What can people see from where they're standing?" (derived 
from building footprint map and other data such as heights)  

o High visibility: Which spaces naturally draw attention and feel more 
welcoming? 

o Low visibility: Which areas feel more private or hidden? 

Visibility analysis is derived either an isovist analysis which measures the visible area from a 
specific point in space or a Visual Graph Analysis (VGA), which analyses the intervisibility 
between multiple points across a space. This analysis type can help us predict where people 
are likely to gather and interact, which areas might need better lighting or security or how and 
where to place important signs or landmarks. 

• Microscale Analysis: "What physical and non-physical details affect how people use 
the space?" (derived from on-site observations and detailed mapping)  

o High activity areas: Which spaces have features that encourage people to 
stay and interact? 

o Low activity areas: Which spaces might need improvements to be more 
inviting? 

Microscale analysis involves examining specific features like street furniture, lighting, and 
sidewalk conditions, door openings and fenestrations along with observing how people 
actually use these spaces. This detailed approach helps us understand why people choose 
certain places to sit, walk, or gather, and helps identify where improvements like better 
seating, lighting, or safety features might be needed. This type of analysis works together 
with broader network or syntactical analysis to give us a complete picture of how streets work 
for people. 

Practical Applications 

In most cases, the use of syntactical methods is done through a process of i) building the 
spatial data (i.e. axial or segment map), ii) followed by a series of analysis, iii) which are used 
for showing findings (i.e. where certain problem areas are or where there is lack of 
connectivity), in some cases, iv) these findings are tested in real-life by changing the 
structure of the city by moving or closing streets and then repeating the process to v) prove 
results. This approach helps solve real-world problems: 
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• Urban Planning: Designing better-connected streets, public spaces and 
neighbourhoods  

o Example: The redevelopment of Trafalgar Square in London demonstrates 
this perfectly. By creating new pedestrian crossings and improving 
connectivity, the previously underused square became a vibrant public space 
with increased foot traffic 

• Safety: Identifying areas that might need better surveillance or lighting  
o Example: Medellín, Colombia successfully used Space Syntax to redesign its 

street network, reducing crime rates and improving social cohesion through 
better spatial integration. 

• Building Design: Creating more intuitive layouts  
o Example: British Museum used Space Syntax to optimise visitor movements. 

Limitations 

While these syntactical methods offer valuable insights into spatial configurations and 
movement patterns, several methodological limitations warrant careful consideration when 
applying these approaches. 

Validity and Reliability Concerns 

Internal Validity: Heavy reliance on geometric representations may introduce systematic 
measurement errors. For example, if making axial maps manually (drawing by looking at 
maps or by hand), different researchers will have different results which will affect 
reproducibility. Simply said, when different persons draw the same map, it is hard to get 
consistent and 'accurate' results. This is why we recommend the semi-automated approach 
for less advanced users. Also, reducing the city into an abstract of lines on two dimensions 
(flat) affects ability to capture three-dimensional spatial relationships and topographical 
variations. Cities with hills, or underground areas can only benefit from the analysis if extra 
steps to create more accurate maps are taken. 

External Validity: Findings are not always the same between cities due to difference in how 
people behave and use space being culturally and socially constructed. Space syntax 
scholars have always shown that there are differences between cities in the Global North and 
South. In this report, since most cases are in Europe, this limitation is reduced. However, 
scholars have studied the difference between cities with more modern street networks and 
those that have more medieval or unique street networks. This can be mitigated by changing 
the radius of the analysis is carried out in. Since cities are built differently around the world, 
we have to be careful about how we apply the insights when comparing cities with each 
other. 

Construct Validity: The approach operationalises or simplifies very complex socio-spatial 
relationships into a set of theories or principles (see Principles). People and society are 
complex systems that are affected by a constellation of factors such as weather, time of day, 
or events that can abruptly happen. For example, if there is sudden snowstorms or heavy 
precipitation, it is also not always true that the analysis will hold that users will take a high 
value segment. This is why it is also recommended to always connect syntactical approaches 
with more traditional spatial analysis methods such as a adding on statistical analysis of 
previous user patterns, activity hotspots, network analysis for routing with real-time and 
historical data and to overlay these with other spatial factors such as building age, 
typologies, land use pattern, natural points of interests etc. This is why we recommend 
always using Depthmap with GIS so that these add-ons can be added either retroactively or 
part of a larger analysis. 
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These limitations underscore the importance of employing these methods as part of a mixed-
methods approach, complemented by qualitative assessments and contextual analysis. 
Future research should address these constraints through methodological innovations and 
integration with other analytical frameworks. 

 

KEY TAKEAWAYS 

Here are some important lessons to keep in mind when analysing cities with syntactical 
methods: 

• Different people drawing the same map might get different results - this is why 
using computer-aided tools is better than doing it by hand 

• Flat maps don't tell the whole story - things like hills and underground areas need 
special attention to be understood properly 

• Cities are different across the world - what works in one place might not work in 
another because of cultural differences and how streets are laid out 

• Real life is more complex than maps - things like weather, time of day, and 
unexpected events can change how people actually move through a city 

• It's best to combine different types of analysis - looking at a 2D analysis alone isn't 
enough; you also need to consider things like:  

• How people actually use the space?  

• Where activities happen most?  

• Historical data about movement patterns  

• Building types and ages  

• Points of interest 

 

4.4 Data Collection and Analysis Protocol 

To implement syntactical methods and microscale approaches for understanding the needs, 
patterns, behaviours, and habits of streets and their users the following steps are crucial. 
This section outlines a comprehensive approach to analysing how streets and urban spaces 
are used and connected. It presents four main steps for conducting spatial analysis in cities. 
The steps are 

• Step 1: Define study area and boundaries - Determining the appropriate scope and 
scale for analysis 

• Step 2: Collect spatial data - Gathering street networks, local features, and relevant 
spatial information 

• Step 3: Conduct analysis - Combining technical analysis of street connections with 
detailed study of street-level features  

o Step 3a: Syntactical analysis of street networks 
o Step 3b: Microscale analysis of street features 

• Step 4: Create visual presentations - Mapping and presenting findings using 
appropriate visualisation techniques 

First, the process begins with defining the study area and its boundaries. Second, it involves 
collecting spatial data, including street networks and local features. Third, the approach 
combines technical analysis of street connections and patterns with detailed study of street-
level features like benches and crosswalks. Finally, it concludes with creating clear visual 
presentations of the findings using various mapping techniques. 
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The guide is designed to help urban planners and researchers understand how people use 
city spaces, from neighbourhood to city-wide scales. It provides practical steps that can be 
adapted based on available resources and technical expertise. 

Step 1: Determine scope and scale for study area 

Determining the scope and scale of your study area means defining several key aspects of 
your analysis. These decisions about scope and scale will directly influence the type and 
amount of data you need to collect, the computational resources required for analysis, the 
level of detail you can achieve, and ultimately, the types of conclusions you can draw from 
your study. 

First, you need to establish clear geographic boundaries - this could range from a single 
neighbourhood to an entire metropolitan region. When setting these boundaries which could 
also be political, it's important to include buffer zones (typically 5 km beyond your main study 
area) to account for edge effects and connections to surrounding areas. 

The level of scale is another crucial consideration. You might focus on macro-level analysis 
to understand entire city patterns, meso-level analysis for district or neighbourhood patterns, 
or micro-level analysis for street-level details. Some studies might require multiple levels of 
analysis. If in doubt, start with a city-wide model that allows you to zoom into specific areas 
for detailed analysis. The trade-off is that it will take more computing capacity and time to 
analyse. 

Time frame is also an important factor to consider. Your study might focus only on current 
conditions, require historical analysis to understand changes over time, or need to include 
projections for future developments. Consider if you want to have comparisons across time-
scales. 

Step 2: Data Collection 

Begin by gathering spatial data from your study area. This can involve collecting open 
source street network data from OpenStreetMap or proprietary (i.e. owned and not 
publicly available) from local databases, along with building information like floor plans and 
CAD files. For microscale analysis, collect on-site observational data or existing data or even 
sensor data about street furniture, pedestrian behaviour, and environmental conditions. 

If you are using QGIS, several plugins can help with collecting open source spatial data 
from European cities and regions. The QuickOSM plugin offers a user-friendly tool for 
accessing OpenStreetMap data, while other plugins can connect to CORINE and LULC 
databases via WFS/WMS connections. Additional useful plugins include OSMDownloader for 
bulk OpenStreetMap downloads, GRASS GIS plugins for accessing various open-source 
geospatial data, and GeoCoding for address and location data. 

Other helpful plugins are: ORS Tools for routing and accessibility analysis, HCMGIS for 
comprehensive spatial data handling, SRTM-Downloader for elevation data, OpenLayers 
Plugin for accessing various base maps, EU-DEM downloader for European terrain data or 
Eurostat downloader. 

Remember that there are also country specific plugins such as for GeoNorge (Norwegian 
Spatial Data) or PDOK Plugin (for Dutch Spatial Data). Since QGIS plugins are developed 
open source and grow quickly, new and more appropriate plugins might be available, or 
recommended ones may become obsolete 
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Step 3a: Data abstraction and analysis (Syntactical) 

Next, you should transform the collected data into analysable elements. This can be done by 
creating axial lines representing the longest lines of sight and movement, or segment maps 
showing street centre lines at intersections, or isovists displaying visible areas from specific 
points. There are three different ways to abstract the data for syntactical analysis with either 
a i) manual, ii) semi-automated and iii) automated process (see Table 6). 

Table 6. Overview of manual, semi-automated and automated process 

 
Manual Process Semi-automated Process Automated Process 

Description Manually drawing the 
longest and fewest set of 
lines that cover all convex 
spaces and their 
connections. Each line 
represents a line of sight 
and potential movement. 

Combines manual 
oversight with 
computational tools for 
axial maps, offering two 
main approaches using 
Space Syntax tools or GIS 
to Depthmap workflow. 

Relies entirely on algorithms 
using Python libraries like 
'momepy' for morphological 
analysis and 'osmnx' for 
network handling. 

Steps For axial maps: 
1. Import base map (aerial 
photo or street network) 
2. Draw lines manually 
using CAD or GIS tools 
3. Ensure all accessible 
spaces are connected 
4. Verify line intersections 
are correct 
 
For segment maps: 
1. Trace street centrelines 
2. Break lines at 
intersections 
3. Ensure proper 
connectivity 
4. Manually check topology 
errors 

Option 1 - Space Syntax 
tools: 
1. Generate initial lines 
from OSM shapefile 
2. Verify and correct 
generated lines 
3. Adjust parameters to 
optimise 
4. Finalise network 
 
Option 2 - GIS to 
Depthmap: 
1. Export network from 
OSM 
2. Clean and prepare in 
GIS 
3. Export as DXF file 
4. Import to Depthmap and 
run analysis 
5. Reimport to GIS as 
MapInfo 

1. Use specialised software 
(Depthmap X, Python 
libraries) 
2. Set parameters for line 
generation 
3. Process data through 
momepy.gdf_to_nx() 
4. Run automated validation 
checks 
5. Minimal human intervention 
needed 

Warnings • If using CAD, base map 
must be properly scaled to 
avoid errors 
• Projection issues when 
combining with microscale 
approaches in GIS 

• Requires understanding 
of both manual and 
computational methods 
• Must verify automated 
results 

• Requires high technical 
capacity and knowledge of 
Python libraries and tools 

Advantages • Complete control over line 
placement 
• Detailed understanding of 
spatial relationships 
• No specialised software 
needed beyond CAD/GIS 
• Suitable for small study 
areas 

• Balance of control and 
efficiency 
• Reduces manual work 
while maintaining accuracy 
• Flexible workflow options 
• Good for medium-sized 
areas 

• Fast processing 
• Consistent results 
• Highly reproducible 
• Efficient for large study 
areas 
• Minimal manual intervention 

Disadvantages • Time-consuming 
• Labor-intensive 
• Potential inconsistency 
between different users 
• Not practical for large 
areas 
• Risk of human error 

• Requires technical 
expertise in multiple tools 
• May need manual 
corrections 
• Learning curve for 
software 
• Potential file format 
compatibility issues 

• Limited human oversight 
• May miss nuanced spatial 
relationships 
• Requires programming 
knowledge 
• High computational 
requirements 
• Less flexible for unique 
spatial conditions 
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Each way has its benefits and trade-offs. Manual processes offer more control but are time-
consuming and potentially less consistent. Semi-automated approaches balance control and 
efficiency but require technical expertise. Fully automated methods are fast and consistent 
but may miss nuanced spatial relationships. The choice depends on project scope, available 
time and cost resources and human capacity, and the desired accuracy of the results. 

When using DepthMap (Axial) 

1. Import your prepared axial map into DepthMap 
2. Run basic connectivity analysis first:  

a. Select Tools > Run Graph Analysis 
b. Choose "Connectivity" measure 
c. Review results to ensure network is properly connected 

3. For Integration analysis:  
a. Select Tools > Run Graph Analysis 
b. Choose "Integration" measure 
c. Set radius (n for global, 3 for local analysis) 
d. Run analysis and review results 

4. For Choice analysis:  
a. Select Tools > Run Graph Analysis 
b. Choose "Choice" measure 
c. Set radius as needed 
d. Run analysis and examine results 

When using DepthMap (Segment) 

1. Import your prepared segment map into DepthMap 
2. Convert to segment map if needed: 

a. Use "Convert Map" tool 
b. Select "Convert to Segment Map" 

3. Run segment analysis: 
a. Select Tools > Run Segment Analysis 
b. Choose metrics (Integration, Choice, or both) 
c. Set radius types (metric or topological) 
d. Define radius values (e.g., n, 800 m, 1600 m) 

4. Export results: 
a. Save analysis results 
b. Export to GIS format if needed to combine with microscale analysis 

Note: We recommend that for most European cities, the values can be set as i) 250 - 500 m 
(walking) or ii) 1200 - 1500 m (cycling) or iii) 2500 m - 5000 m (car) depending on size of the 
city. A smaller radius value can better simulate how choice is done while walking (i.e. how 
often do you change direction or have to decide to change direction when walking). The 
larger radius will better simulate a user on a bicycle or equivalent mode, or a car driver or 
faster moving vehicles. 
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IMPORTANT TIPS 

• Always verify network connectivity before running analysis 

• Consider using both metric and topological radii for segment analysis 

• Document analysis parameters for reproducibility 

• Save work regularly during analysis process 

 

Step 3b: Data abstraction and analysis (microscale) 

For microscale elements, map locations of physical objects such as benches, lighting, 
crosswalks, and other street-level features. or environmental factors such as presence of 
flora and fauna or local temperature. 

Depending on the comfort level of skills and expertise of the persons carrying out the data 
analysis, we suggest the following processes. 

Overlay (Beginner) 

Visually comparing where clusters and location of microscale elements are with the 
visualised syntactical results within one map environment. 

1. Load your data layers:  
a. Import your syntactical analysis results layer 
b. Import your microscale elements layer (points showing locations of street 

furniture, environmental features, etc.) 
2. Set up visualisation:  

a. Style your syntactical results layer (typically using a colour gradient) 
b. Style your microscale elements using appropriate symbols 

3. Perform visual comparison:  
a. Adjust layer transparency if needed 
b. Use the zoom and pan tools to examine areas of interest 
c. Look for patterns between syntactical values and microscale element clusters 

4. Optional: Create a print layout to document your findings  
a. Include a legend 
b. Add scale bar and north arrow 
c. Export as image or PDF 

Hotspot (Beginner - Intermediate) 

Symbolising the microscale elements (if the shapefile are already points) using the heatmap 
option and then overlaying this with the visualised syntactical results within one map 
environment. 

1. Load your data layers:  
a. Import your syntactical analysis results 
b. Import your microscale elements point layer 

2. Create heatmap:  
a. Right-click on your point layer in the Layers panel 
b. Select Properties > Symbology 
c. Change the render type to "Heatmap" 
d. Adjust the radius and colour ramp settings to visualise density 

3. Style the syntactical results:  
a. Set appropriate colour scheme for your syntactical analysis layer 
b. Adjust transparency to allow both layers to be visible (recommend: Multiply) 
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4. Fine-tune visualisation:  
a. Experiment with layer ordering 
b. Adjust heatmap settings until patterns are clearly visible 
c. Use the transparency slider to balance visibility between layers 

5. Optional: Create a print layout to document your findings  
a. Include a legend 
b. Add scale bar and north arrow 
c. Export as image or PDF 

Multicriteria Analysis (Intermediate-Advanced) 

Symbolising multiple microscale elements (which can be points, polygons or lines with values 
attached) using intersect with a grid (fixed spatial units of analysis) and combined with 
syntactical results within one map environment. 

Here are the detailed steps for performing a Multicriteria Analysis combining microscale 
elements with syntactical results: 

1. Prepare Input Data 
a. Create a comprehensive database of all spatial data (microscale elements 

and syntactical results) 
b. Ensure all data is in the same coordinate system 
c. Assign values or weights to microscale elements based on importance or 

criteria 
2. Create Analysis Grid 

a. Generate a regular grid (rectangular or hexagonal) covering your study area 
b. Consider grid cell size based on your analysis needs (smaller for detailed 

urban analysis, larger for neighbourhood scale) 
3. Intersect Data with Grid 

a. Use GIS spatial intersection tools to combine microscale elements with the 
grid 

b. Calculate statistics for each grid cell (count, density, average values) 
c. Intersect syntactical results with the same grid 

4. Weight and Normalise 
a. Apply weights to different criteria based on their importance 
b. Normalise values to a common scale (e.g., 0 - 5 for no value, low, below 

average, average, above average and high) 
c. Calculate combined scores for each grid cell. 

Note: How the scores are combined is a matter for dialogue and discussion with 
policymakers, technicians and end-users. It can be as simple as a sum of values (i.e. score 
per cell is Value A + Value B…+ Value n). Or weighing can be used as a reflection of political 
and social goals. For example, if presence of green is deemed politically important and 
prioritised, the weighting can make use of multiplication factors to increase the scores (i.e. 
score per cell is Value A + Value B + 2 x Value Green…+ Value n). The key is to come to a 
joint decision and to transparently document the process. 

5. Visualisation and Analysis 
a. Create thematic maps showing the combined analysis results 
b. Use appropriate colour schemes to represent different value ranges 
c. Export final results for documentation 
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Step 4: Visualisation and presentation 

There are several key visualisation methods for spatial analysis using syntactical 
methods and microscale approaches (see Table 7).  

Heat maps effectively display density and intensity patterns, showing where activities or 
phenomena concentrate across space. They are particularly valuable for visualising 
pedestrian concentrations, temporal activity hotspots, and areas of high street integration. 
Cluster maps group similar features or activities, helping analysts identify concentrations of 
street furniture, behaviour patterns, and related urban functions. Flow maps represent 
movement and connections, effectively displaying pedestrian paths, traffic patterns, and the 
strength of connections between urban areas. Choropleth maps show variations across 
defined geographical areas, making them ideal for displaying integration values, activity 
levels, and accessibility scores by district. Point symbol maps represent specific locations or 
features, perfect for mapping street furniture, activity nodes, and infrastructure elements. 
Bivariate choropleth maps combine two variables using a matrix of colours, allowing 
simultaneous visualisation of two different phenomena, such as integration values and 
pedestrian density, or accessibility scores and land use intensity. 

Using diverse visualisation methods is crucial for effective urban analysis and 
communication. While traditional data visualisations from tools like Depthmap provide 
analytical insights, they often lack the clarity needed for professional presentations and 
broader stakeholder engagement. A thoughtful combination of different visualisation 
techniques helps reveal hidden patterns in urban data while enabling meaningful 
comparisons of various urban characteristics. This multi-layered approach to visualisation is 
particularly valuable when communicating with diverse audiences, as it helps bridge the gap 
between technical experts and other stakeholders. By presenting information in multiple, 
complementary formats, we can better facilitate understanding of complex spatial 
relationships and ultimately support more informed urban planning and design decisions. 

 

Table 7. Types of Visualisation Methods 

Visualisation 
Type 

Description Data Type 
Needed 

Purpose and 
Outcomes 

Example 

Point Symbol 
Maps 

Individual feature 
locations 

Point data Show specific 
element locations 

Location of benches 
and lighting 

Heat Maps Continuous surface 
showing 
density/intensity 

Point or line 
data 

Identify concentration 
areas and patterns 

Pedestrian activity 
density in city centre 

Cluster Maps Grouped similar 
features 

Point data Find spatial 
relationships and 
patterns 

Street furniture 
clusters near transit 
stops 

Flow Maps Directional movement 
visualisation 

Line data with 
attributes 

Understand 
movement patterns 

Main pedestrian 
routes between 
districts 

Choropleth 
Maps 

Colour-coded areas 
showing values 

Polygon data Compare areas 
based on attributes 

Integration values by 
neighbourhood 

Bivariate 
Choropleth 

Two variables shown 
through colour matrix 

Polygon data 
with two 
attributes 

Compare two 
phenomena 
simultaneously 

Integration values vs. 
land use intensity 
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4.5 Workflow 

Next, an example of a workflow for syntactical methods and microscale approaches is 
presented on a use case of a typical European city with mixed historical and modern districts 
(Figure 21). Here, we take a semi-automated process and use skillsets that are suited to the 
beginner-intermediate level of users and we will use the city of Riga as an example. 

Step 0: Project Setup and Data Requirements 

Required Data 

1. OpenStreetMap network data (street network or road centre lines) for building basis 
for syntactical analysis 

2. Microscale elements such as building footprints, Street furniture inventory, historical 
landmarks or land use data (if available) 

Required Software 

1. QGIS (recommended) for GIS operations 
2. DepthmapX for space syntax analysis 
3. QuickOSM plugin for QGIS to download OpenStreetMap data 

For detailed information about software installation, system requirements, and recommended 
configurations, please refer to Section 4.4 "Implementation Guide" under "Technical 
requirements". This section provides step-by-step installation instructions for each required 
software package, along with minimum system specifications needed to run the analysis 
effectively. 

  

Figure 21. Workflow for syntactical methods and microscale approaches   
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Step 1: Define Study Area 

Goals: Set city centre as focal point, i) include 5 km buffer zone beyond city limits to 
download street network data for syntactical analysis, ii) download microscale elements such 
as historical landmarks or tourist attractions. 

1. Create a new project in QGIS 
a. Open QGIS 
b. Go to Project > New 
c. Set CRS (Coordinate Reference System) by clicking the button in the bottom-

right corner 
d. For Riga, use EPSG:3059 (LKS92 / Latvia TM) as it's the official projected 

coordinate system for Latvia 

Note: Each country or region has a specific official projection system. For worldwide city 
analysis, use EPSG:3857 (Web Mercator) which is widely supported and commonly used for 
web mapping applications, though be aware it distorts areas at high latitudes. For more 
accurate area measurements, consider using UTM zones specific to your city's location. 

 

Step 2: Data Collection 

Goal: Obtain OpenStreetMaps street network data and other desired microscale elements 
1) Open QGIS and ensure the QuickOSM plugin is installed 

a) Go to Plugins > Manage and Install Plugins 
b) Search for "QuickOSM" 
c) Click Install if not already installed 

Note: Remember to frequently update your plugins. 

2) Download street network 
a) Open QuickOSM plugin again 
b) In the Query tab, select key= "highway" 
c) Leave value empty to get all road types 
d) Under Advanced, select "Around" and enter "Riga" with a distance of 5000 meters 
e) Run query 

Note: This generates a temporary layer. Please save this as a new shapefile in a location of 
choice. If not you will have to repeat the steps. This tip applies for all temporary layers. 

3) Download microscale elements (points, polygons or lines) 

a) Open QuickOSM plugin again. 

b) For tourist points of interest:  

i) Select key= "tourism" and value= "attraction" or "museum" or "viewpoint" 

ii) Set geometry in Advanced to "Points only" 

iii) Use canvas extent from your street network layer 

iv) Run query 

c) For historical landmarks:  

i) Select key= "historic" and value= "monument" or "memorial" or 

"archaeological_site" 

ii) Set geometry in Advanced to "Points only" 

iii) Use canvas extent 

iv) Run query 
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d) For building footprints:  

i) Select key= "building" and leave value empty 

ii) Set geometry in Advanced to "Multipolygons" 

iii) Use canvas extent 

iv) Run query 

Note: Given the size of the study area and the request for microscale elements. It could be 
that the plugin server is unable to handle the request. If QuickOSM plugin times out, try first 
by increasing the limit for timeout (default is 25, increase to 250 and more)l or try 
downloading data in smaller chunks by dividing your area into sections. Download one 
section at a time, then combine them using QGIS Vector tools. You can also download 
different types of features (like roads and buildings) separately or use alternative sources like 
the OSM website or Geofabrik to get the data directly. 

 

Step 3: Data abstraction 

Goal: Abstract the street network, after cleaning and verifying to be analysed in DepthMap 
and reimport it back to QGIS. 

Quality control checkpoint 1: Your analysis is as good as the input you have. Please check 
for duplicate lines, disconnected segments, islands or links and unlinks in the street network 

Using QGIS (syntactical) 

1) Clean and verify the network. There are multiple ways to do so:  
a) Manual cleaning  

i) Use the Select Features tool in QGIS to visually inspect and select disconnected 
segments 

ii) Enable snapping (Settings > Snapping Options) to help connect segments 
accurately 

iii) Use the Topology Checker plugin to identify network gaps and overlaps 
iv) Delete or modify road segments that aren't relevant to your analysis 

b) Space Syntax Toolkit  
i) Install and enable the Space Syntax Toolkit plugin in QGIS 
ii) Use the "Verify Network Connectivity" tool from the toolkit 
iii) Review the verification report for topology errors 
iv) Fix identified issues using the toolkit's repair tools (this requires manual work) 

c) Working' Quick and Dirty'  
i) Focus only on main roads and primary street network 
ii) Remove service roads, alleys, and other minor segments that won't significantly 

impact the analysis 
iii) Do a quick visual verification of major intersections 
iv) Accept some minor disconnections if they don't affect main movement routes 

2) Export OSM network shapefile in the DXF format 

Using Depthmap (syntactical) 

1) Start a new map in Depthmap:  
a) Open DepthmapX 
b) Go to File > New 
c) Set the window size according to your study area 
d) Save the new file with .graph extension 

2) Import the DXF file:  
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a) Go to File > Import 
b) Select your DXF file 
c) Choose appropriate import options (usually default settings work well) 
d) Wait for import to complete - larger files may take several minutes 

3) Check network connectivity:  
a) Zoom in and visually inspect major intersections 
b) Look for any obvious gaps or disconnections 
c) Use the 'Links' tool to verify connections at key junctions 

4) Convert to axial map:  
a) Select Tools > Make Axial Map 
b) Choose 'All Lines' option 
c) Click 'OK' to process 
d) Review the generated axial map for accuracy 

5) Convert to segment map: 
a) Select Tools > Segment Map 
b) Select appropriate segmentation options 
c) Review the generated segment map 

6) Run desired analyses 

Quality control checkpoint 2: Confirm appropriate radius settings for local analysis, think 
about which modes you want to highlight and analyse for. It is possible to repeat the same 
steps for multiple radii. 

1) Run global and local Integration (axial map)  
a) Select Tools > Graph Analysis 
b) Choose "Integration" 
c) Set Radius to "n" (for global) or "3" for local 
d) Run analysis 

2) Run Choice (segment map)  
a) Convert axial map to segment map first 
b) Select Tools > Segment Analysis 
c) Choose "Choice" metric 
d) Set radius to either 500m for walking analysis or 1500m for cycling analysis 
e) Run analysis 

3) Export the analysis results as Mapinfo file format (MIF) back to QGIS 

Using QGIS (microscale) 

Quality control checkpoint 3: Control for the smallest spatial unit of analysis that it is 
appropriate to your city. This can be best checked by looking at what is an appropriate cell 
size of your city (i.e. typical block size in metres). Pragmatic choices tend to be around 500 - 
1000 m for above average sized cities. Alternatively, you can also use the national statistical 
grid to ensure an even coupling of other microscale data and perhaps also demographic and 
economic data. 

1) Create a grid layer (hexagon or square)  
a) Go to Vector > Research Tools > Create Grid 
b) Set grid type to "Hexagon (polygon)" or "Rectangle (polygon)" 
c) Set grid extent to match your study area shapefile layer 
d) Set horizontal and vertical spacing to 500 meters 
e) Run to create grid 

2) Intersect input layer with grid  
a) Go to Vector > Geoprocessing Tools > Intersection 
b) Input layer: Your point/polygon layer 
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c) Overlay layer: The created grid 
d) Select minimal required fields 
e) Run intersection 

3) Calculate new field with area-weighted values  
a) Open attribute table of intersection layer 
b) Toggle editing mode 
c) Open field calculator 
d) Create new field named "Value_I" 
e) Set output field type to Decimal Number (real) 
f) Enter expression: "Value" * ($area/10000) 
g) Check all rows have values by sorting the new field 

4) Generate statistics by categories  
a) Go to Vector > Analysis Tools > Statistics by Categories 
b) Input layer: Intersection layer 
c) Field to calculate statistics on: "Value_I" 
d) Field with categories: "id" (from grid) 
e) Run to create summary table 

5) Join statistics to grid layer  
a) Right-click grid layer > Properties > Joins 
b) Click '+' to add new join 
c) Join layer: Statistics table 
d) Join field: "id" 
e) Target field: "id" 
f) Choose fields to join: "id" and "sum" 
g) Set custom field name prefix (e.g., "Shop_" or "Landmarks_") 
h) Click OK to apply join 

Step 4a: Visualisation and presentation 

Goals: Create a weighted grid combining syntactical and microscale elements using two 
approaches popular approaches. Organise a democratic and inclusive stakeholder workshop 
to discuss weighing factors based on desired political and social outcomes with a variety of 
stakeholders. 

Bivariate Choropleth Map (Beginner - Intermediate) 

1) Use Bivariate Renderer plugin to overlay two criteria  
a) Set colour ramps and number of classes (2-5) 
b) Choose fields for syntactical and microscale values 
c) Visualise areas of high/low performance for both metrics 
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Figure 22. Example of a bivariate choloropleth map 

Weighted Statistical Grid (Intermediate - Advanced) 

1) Classify values using Natural breaks (Jenks) or Standard deviation  
a) Create 5 classes: Low, Below average, Average, Above average, High 
b) Assign numerical values (1-5) to each class 
c) Calculate combined weighted score 
d) Generate map using this new score value variable using symbology. 
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Figure 23.  Example of a weighted grid outcome 

 

Figure 24. Example of a weighted grid outcome with multiple syntactical and microscales values 

 



 

 

 74 

Step 4b: Stakeholder Workshop for Weighting Factors 

1) Organise a structured workshop session:  
a) Invite diverse stakeholders including policy makers, urban planners, designers, 

technical experts, and resident representatives 
b) Present the analysis methodology and preliminary findings using clear visualisations 
c) Explain the purpose of weighting and its impact on final results 

2) Facilitate group discussions:  
a) Divide participants into mixed groups to ensure diverse perspectives 
b) Use structured worksheets to rate importance of different factors (1-5 scale) 
c) Ask groups to justify their weightings based on policy goals 

3) Build consensus:  
a) Present each group's proposed weightings to all participants 
b) Facilitate discussion on major differences in proposed weights 
c) Use techniques like Delphi method to reach agreement 

4) Document and validate:  
a) Record final agreed weightings and their justifications 
b) Document any dissenting views or concerns 
c) Validate weightings against existing policy documents 

5) Follow-up:  
a) Share workshop results with all participants 
b) Allow for feedback and adjustments 
c) Document how weightings align with policy objectives 

Outputs and deliverables 

Potential final outputs for this workflow could include: 

• PDF maps or online interactive GIS maps designed for stakeholder presentation and 
consultation. 

• GIS layers that can be used for further analysis and made available to other 
stakeholders. 

• Technical documentation of the process, the data collected, cleaned and analysed. 

4.6 Implementation Guide 

This section provides a practical companion guide for implementing spatial analysis tools for 
syntactical methods and the microscale approach, with a focus on QGIS as the 
recommended free software option. The guide covers three main technical requirements for 
software QGIS, ArcGIS (a commercial alternative), and DepthmapX for specialised analysis. 

The section emphasises using open-source solutions and data, particularly OpenStreetMap, 
which offers advantages like regular updates, standardised formats, and comprehensive 
coverage. It includes practical guidance on data organisation, troubleshooting common 
issues, and best practices for cities looking to build their technical capacity. Special attention 
is given to data management within the EU context, ensuring compliance with GDPR and 
following FAIR principles (Findable, Accessible, Interoperable, and Reusable). 

Technical requirements 

QGIS (Recommended Free Option) 

• Download the Long Term Release (LTR) version from the official QGIS website: 
https://qgis.org/en/site/forusers/download.html 

• Choose the appropriate version for your operating system (Windows, macOS, or 
Linux) 

https://qgis.org/en/site/forusers/download.html
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• Follow the standard installation wizard 

• After installation, set the interface language to English (US) through Settings > 
Options > General 

ArcGIS (Commercial Option) 

• Purchase a license from Esri (https://www.esri.com/en-us/arcgis/products/arcgis-
pro/overview) 

• Educational institutions may have free licenses for students and staff 

• Download ArcGIS Pro from your Esri account 

• Install following the provided instructions 

DepthmapX 

• Download the latest version from: 
https://github.com/SpaceGroupUCL/depthmapX/releases 

• For Windows users: Download the .exe file from the latest release 

• For Mac users: Follow the compilation instructions in the GitHub repository 

• For QGIS integration: Install the Space Syntax Toolkit plugin through QGIS Plugin 
Manager 

System Requirements 

• Minimum 8 GB RAM (16 GB recommended for larger datasets) 

• 64-bit operating system 

• At least 10GB free disk space 

• Updated graphics drivers for 3D visualisation 

 

Working with QGIS 

To use the above recommended methods, you will need a GIS platform to collect, combine, 
operate and manipulate spatial data to provide analytical insights 

For those who are not familiar with GIS, we recommend using QGIS instead of ArcGIS 
which is more user-friendly, has more resources and tutorials and is also free of licenses. It is 
very important that when you set up your QGIS for the first time that you set the application 
to English (US). It is also wise to have your computer operating system using English as 
QGIS has difficulties working with different languages. We will also be working with 
predominantly shapefiles (.shp) and geopackages (.gpkg). Be aware that when you 
exchange files with each other, gpkg are advised. Also make sure that all the file types with 
the same name are compressed before sending. 

For those getting to know QGIS or getting reacquainted, we recommend that you go 
through the QGIS tutorial for the following using the recommended LTR version and the 
sample datafiles (Download via: https://github.com/qgis/QGIS-Training-
Data/archive/master.zip) and the following steps: 

Following the QGIS Training manual: 

• Module: Creating and Exploring a Basic Map  
o Lesson 1: An Overview of the Interface 
o Lesson 2: Adding your first layers 
o Lesson 3: Navigating the Map Canvas 
o Lesson 4: Symbology 

• Module: Classifying Vector Data  
o Lesson 1: Vector Attribute Data 

https://www.esri.com/en-us/arcgis/products/arcgis-pro/overview
https://www.esri.com/en-us/arcgis/products/arcgis-pro/overview
https://github.com/SpaceGroupUCL/depthmapX/releases
https://github.com/qgis/QGIS-Training-Data/archive/master.zip
https://github.com/qgis/QGIS-Training-Data/archive/master.zip
https://docs.qgis.org/3.34/en/docs/training_manual/basic_map/index.html
https://docs.qgis.org/3.34/en/docs/training_manual/basic_map/overview.html
https://docs.qgis.org/3.34/en/docs/training_manual/basic_map/preparation.html
https://docs.qgis.org/3.34/en/docs/training_manual/basic_map/mapviewnavigation.html
https://docs.qgis.org/3.34/en/docs/training_manual/basic_map/symbology.html
https://docs.qgis.org/3.34/en/docs/training_manual/vector_classification/index.html
https://docs.qgis.org/3.34/en/docs/training_manual/vector_classification/attribute_data.html
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o Lesson 2: Labels 
o Lesson 3: Classification 

• Module: Laying out the Maps  
o Lesson 1: Using Print Layout 
o Lesson 2: Creating a Dynamic Print Layout 

• Lesson: Installing and Managing Plugins 

• Open Street Maps (QuickOSM) - to download road/street networks and other open 
source data such as points of interest or buildings. 

• Depthmap - to conduct various analysis such as global and local integration with axial 
maps, or choice analysis with segment maps. 

 

WHY SHOULD WE USE OPEN SOURCE DATA? 

Using open source data like OpenStreetMap offers several key advantages for this 
analysis: 

• Accessibility and Cost-effectiveness: Open source data is freely available, making 
the analysis reproducible and feasible for different stakeholders regardless of 
budget constraints 

• Regular Updates: OpenStreetMap is continuously updated by a global community, 
ensuring the data reflects recent changes in urban infrastructure 

• Standardised Format: The data follows consistent formatting standards, making it 
easier to process and analyse across different cities and regions 

• Comprehensive Coverage: OpenStreetMap provides extensive street network 
data, including pedestrian paths, cycling routes, and other relevant features 
needed for space syntax analysis 

• Interoperability: Open source data can be easily integrated with various GIS tools 
and space syntax software, facilitating smooth workflow implementation 

• Comparative analysis: Given the uniform source of data, it allows for comparative 
analysis across cities and regions and reduces the issue of subjectivity when 
manually drawing axial maps. 

 

Data Organization and Storage 

When managing spatial data within the European Union, it is crucial to comply with GDPR 
where relevant and other relevant data protection regulations, particularly when handling 
sensitive location-based information. Following the FAIR principles (Findable, Accessible, 
Interoperable, and Reusable), organisations should implement robust data management 
strategies that ensure both data privacy and scientific transparency. This includes clear 
documentation of data ownership, access rights, and usage permissions. 

• Create a clear folder structure separating raw data, processed files, and final outputs, 
ensuring GDPR compliance 

• Work with a data management protocol that follows FAIR principles and aligns with 
your organisation's privacy policies 

• Use consistent naming conventions for files and layers (e.g., 
cityname_datatype_date) while avoiding personally identifiable information 

• Keep a detailed log of data sources, processing steps, and data ownership 
information 

• Regularly backup your work using secure, GDPR-compliant storage solutions 

https://docs.qgis.org/3.34/en/docs/training_manual/vector_classification/label_tool.html
https://docs.qgis.org/3.34/en/docs/training_manual/vector_classification/classification.html
https://docs.qgis.org/3.34/en/docs/training_manual/map_composer/index.html
https://docs.qgis.org/3.34/en/docs/training_manual/map_composer/map_composer.html
https://docs.qgis.org/3.34/en/docs/training_manual/map_composer/dynamic_layout.html
https://docs.qgis.org/3.34/en/docs/training_manual/qgis_plugins/fetching_plugins.html
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Common Troubleshooting Solutions 

Working with open-source software like QGIS can sometimes require creative 
troubleshooting. While this might seem challenging at first, there are numerous reliable 
resources available online. The key is knowing where to look and how to validate solutions. 
Professional forums like GIS Stack Exchange, official QGIS documentation, and even ESRI 
knowledge banks (despite being for a different software) often provide valuable insights. 
When using YouTube tutorials, prioritise content from recognised institutions from recent 
years or content creators with a large following, GIS professionals, or official QGIS channels. 

• If QGIS crashes during analysis, try reducing the size of your dataset or splitting it into 
smaller sections 

• For projection issues, ensure all layers are in the same coordinate system 

• When importing fails, check file permissions and verify data formats are compatible 

• If plugins aren't working, update QGIS to the latest LTR version and reinstall the 
plugin 

Artificial Intelligence tools like ChatGPT can be particularly helpful for troubleshooting. When 
using AI, frame your questions with specific details about your QGIS version, operating 
system, and exact error messages. Request step-by-step instructions and always validate AI 
suggestions against official documentation. Be cautious of outdated or incorrect information 
by testing solutions in a safe environment first. 

For example, some effective prompts you could use are: 

• "Using QGIS [version number], I'm getting [specific error message] when trying to 
[specific action]. My operating system is [OS details]. What are the step-by-step 
solutions?" 

• "Can you explain how to [specific QGIS task] in QGIS [version], providing detailed 
steps that I can validate against the official documentation?" 

• "What are the common causes and solutions for [specific QGIS issue] in [your OS], 
particularly when working with [data type/plugin]?" 

• "I'm using QGIS [version] for space syntax analysis. How do I troubleshoot [specific 
problem] with the Space Syntax Toolkit plugin?" 

Best Practices for Cities 

Cities across the globe find themselves at different stages of technical capacity and spatial 
analysis capabilities. While some municipalities have advanced GIS departments, others 
struggle with basic spatial data management. Much of this technical knowledge has 
traditionally been locked within expensive consulting services, creating barriers for cities with 
limited resources. However, the rise of open-source software like QGIS presents an excellent 
opportunity for cities to build internal capacity. 

Cities can enhance their technical capabilities through several approaches: 

• Embrace open-source solutions that offer extensive online resources, tutorials, and 
community support 

• Establish partnerships with knowledge institutions and universities for training and 
knowledge exchange 

• Follow FAIR principles (Findable, Accessible, Interoperable, and Reusable) in data 
management 

• Utilise AI tools and online forums for troubleshooting and continuous learning 

• Validate analysis with local knowledge and stakeholder input to ensure relevance to 
local context 
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By investing in these practices and maintaining up-to-date knowledge of spatial analysis 
tools, cities can gradually build their technical expertise while ensuring sustainable, cost-
effective spatial planning practices. 

 

Figure 25. Overview of requirements and applicability of syntactical methods and micro-scale approaches  

 



 

 

 79 

SUGGESTED READINGS 

Andi, A., Abednego, I. A., & Gultom, B. J. B. (2021). A Space Syntax Guide to Optimize Shopping 
Mall: A Systematic Review. International Journal of Environment, Architecture, and Societies, 1(01), 
19-30. 

Daly, J. (2023). In and out of place in Federation Square. Journal of Urbanism: International 
Research on Placemaking and Urban Sustainability, 16(2), 142-167. 

Garau, C., Annunziata, A., & Yamu, C. (2020). A walkability assessment tool coupling multi-criteria 
analysis and space syntax: the case study of Iglesias, Italy. European Planning Studies, 10(3), 1–

23. https://doi.org/10.1080/09654313.2020.1761947 

Goodship, P. (2016) "Understanding the role of spatial connectivity in integrating informal 
settlements, through the case of Medellin’s urban cable-cars." In Proceedings of the International 
Conference on Education and Research in Computer Aided Architectural Design in Europe, vol. 2, 
pp. 79-88. 2016. 

Hillier, B., (1996), Space is the Machine. Cambridge, Cambridge University Press. 

Hillier, B., and Hanson, J. (1984), The Social Logic of Space. Cambridge, Cambridge University 
Press. 

Hidayati, I., Tan, W., & Yamu, C. (2020a). How gender differences and perceptions of safety shape 
urban mobility in Southeast Asia. Transportation Research Part F: Traffic Psychology and 

Behaviour, 73, 155–173. https://doi.org/10.1016/j.trf.2020.06.014 

Hidayati, I., Yamu, C., & Tan, W. (2021). You have to drive: Impacts of planning policies on urban 
form and mobility behavior in Kuala Lumpur, Malaysia. Journal of Urban Management. 

https://doi.org/10.1016/j.jum.2020.12.004 

Jiang, B., Claramunt, C., & Batty, M. (1999). Geometric accessibility and geographic information: 
extending desktop GIS to space syntax. Environmental International, 23, 127–146. 

de Koning, R. E., Heldal, R., & Tan, W. (2022). Spatial data and workflow automation for 
understanding densification patterns and transport energy networks in urban areas: The cases of 
Bergen, Norway, and Zürich, Switzerland. Data in Brief, 42, 108290. 

https://doi.org/10.1016/j.dib.2022.108290 

Penn, A. (2003). Space Syntax And Spatial Cognition. Environment and Behavior, 35(1), 30–65. 

https://doi.org/10.1177/0013916502238864 

Tzortzi, K. (2011). Space: interconnecting museology and architecture. The Journal of Space 
Syntax, 2(1), 26-53. 

Van Nes, A., & Yamu, C. (2021). Introduction to space syntax in urban studies (p. 250). Springer 
Nature. 

Yamu, C.  (2010). Space Syntax Understanding, Hiller's Concept of a Spatial Configuratiın and 
Space Syntax Analiysis. Unıversite de Franche-Comte. 

Yamu, C., Nes, A. van, & Garau, C. (2021). Bill Hillier's Legacy: Space Syntax—A Synopsis of 
Basic Concepts, Measures, and Empirical Application. Sustainability, 13(6), 3394. 

https://doi.org/10.3390/su13063394 

 

 

https://doi.org/10.1080/09654313.2020.1761947
https://doi.org/10.1016/j.trf.2020.06.014
https://doi.org/10.1016/j.jum.2020.12.004
https://doi.org/10.1016/j.dib.2022.108290
https://doi.org/10.1177/0013916502238864
https://doi.org/10.3390/su13063394


 

 

 80 

5. GIS analysis on walkability, accessibility, visibility, safety 
and security  

5.1 Introduction 

This section provides selected methods and tools available through open platforms for 
conducting GIS analyses on walkability, accessibility, visibility, safety, and security. These are 
objective measures to evaluate public open spaces. It provides step-by-step tutorials for 
performing these analyses. The methods are intended to be applied in the evaluation of the 
JUST STREETS pilot cities. However, due to the limited availability of data from city partners 
or open portals at this stage, the section provides descriptions of the methods and tools to be 
used. In addition, we demonstrate here the application of walkability methods in the city of 
Corsico (Italy) and in the city of Haifa (Israel), and the application of visibility method in 
Westminster (United Kingdom) and Corsico (Italy). Recommendations/requirements for the 
application of these methods in other cities are provided. 

Key Objectives 

• Introducing the key principles and recommended approaches behind the following 
urban measures: walkability (at neighbourhood level and at street-level), visibility, 
accessibility, safety and security 

• Proposing a comprehensive protocol and step-by-step tutorial using open-source 
data where possible with a combination of GIS analysis 

• Demonstrating some of the measures on city samples 

For each of the measures we introduce:  

1. The aim and basic concepts behind the measure 
2. The methodology for calculating the measure 
3. Data needed and data sources 
4. Step-by- step tutorial  
5. Examples for selected measures (case studies)   
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Figure 26. Workflow for online platforms for conducting GIS analysis. 

5.2 Walkability  

Basic concept 

The term ‘walkability’ is often used to describe the extent to which walking and/or other non-
motorized means of mobility are enabled by the surrounding built environment and so 
promote an active and healthier lifestyle. Walkability is made achievable by compact urban 
planning that includes mixed land uses, a suitable built density (to ensure that destinations 
are within walking distance of each other), high street connectivity, structural designs that 
encourage walking, pedestrian and bicycle infrastructure.   

The empirical literature identifies three major variables of the neighbourhood’s spatial layout 
that determine its walkability level, including: (1) Land uses composite. It is determined by 
the placement of shops, schools, workplaces, health and other public services. Walkability is 
improved when a variety of land uses are located in conjunction with one another. and with 
residential areas. Thus, creating proximity between different activities; (2) Density—high 
residential density increases the proximity of different destinations to each other and creates 
compact environment that improves walkability. (3) The street pattern— walkability is favored 
when streets are organized in a grid network, thus creating high levels of connectivity and 
continuity. This pattern provides short and direct routes between the different destinations. 

It is worth noting that the definition of walkability variables often varies among different 
studies, resulting in different walkability scores and results for a given area. This issue is 
further addressed in:  Shashank, A., & Schuurman, N. (2018). Unpacking walkability indices 
and their inherent assumptions. Health and Place, 55(June 2018), 145–154. 
https://doi.org/10.1016/j.healthplace.2018.12.005 

Here we elaborate on two most popular measures: Walkability Index (which refers to the 
neighbourhood level) and Walk Score (which refers to the street level). 

https://doi.org/10.1016/j.healthplace.2018.12.005
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Walkability Index (a neighbourhood level measure) 

Aim – to develop and validate an integrated walkability index that leverages parcel-level data 
and census-level demographics to systematically characterize the neighbourhood-built 
environment and examine its relationship with walkability. 

Reference - https://bjsm.bmj.com/content/44/13/924 

Methodology 

• The study uses a GIS-based tool, which is used to objectively measure walkability.  

• The index considers objective measures of the built environment to assess such as 
Net Residential density, Retail floor area ratio, Intersectional density and land-
use mix. 

• Most of the data needed to evaluate can be sourced from public GIS repositories, 
Open Street map, open data portals of city governments, or urban planning 
databases. 

• This tool shall help cities in identifying its problem areas for the walkability and 
generated maps shall establish the neighbourhood wise areas of intervention. 

Case study 

The case study used in the Corsico city which is a part of the metropolitan city of Milan. 
For this particular city a specific street is being considered for JUST STREETS project called 
Via Alzaia Trento. 

 

 

Figure 27. The case study in Corsico - Via Alzaia trento. 

Via Alzaia Trento has “Linea traghetti Gaggiano Milano” (Gaggiano Milan ferry line) on one 
side and “Parco ex area pozzi” (Park) on the other. The street itself is not directly connected 
to any residential areas. Some part of it though connected to an industrial site. The 
neighbourhood around it shall be taken as “Focus Study Area”. 

Needed Data 

1. Net residential density 
a. Number of residential units  
b. Area of residential land use 

2. Retail floor area ratio 
a. Retail footprint floor area  
b. Retail land floor area. 

3. Intersection density 
a. The number of true intersections  
b. land area of the block group.  

4. Land use mix, or entropy score  

https://bjsm.bmj.com/content/44/13/924
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a. The degree to which a diversity of land use types is present in a block group.  

Step-by-Step Tutorial 

Walking index method has been applied and tested in phases to validate the material from 
open portals and the results. It is also to explain the advantages and disadvantages of using 
open portals such as open street maps for using its material. In this document for 
demonstrating the method QGIS 3.32.3 software has been used.  

Phase 1 – Open street map data for selected focus study area. 

Step 1: Collect the Data for your City 

As shown in the Figure 28, the following data shall be downloaded from open street map. 

 

Figure 28. Download the data for desired area in open street map. 

1) Land use. 
2) Roads (Highway vector line in OSM) 
3) Intersections (Highway point vector in OSM) 
4) Building shapes. 

Furthermore, the administrative layers of the city and its block wise boundaries shall be 
downloaded from https://www.istat.it/  website. (This step might differ for different cities 
according to available data. In some cases, these limits can be determined manually by 
drafting on GIS software.) 

Step 2:  Adding the data on GIS software 

• Next step shall be to upload these files on GIS. Choose a geographic unit, such as 
neighbourhoods or administrative regions, to which you will apply the walkability 
index. 

• Ensure the data is consistent for all the layers for selected region. (Land use, 
Intersections, Building shapes, Roads). 

• Then Clip/crop all the shapefiles for the study area so that extra data is omitted. 
Prepare your data as shown in Figure 29. 

https://www.istat.it/
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Figure 29. Put the downloaded shapefiles in the QGIS and crop it for the desired study area. 

Step 3: To measure the net residential density 

• First step is to calculate the ratio of residential units to the land area devoted to 
residential use per block group. The logic is that denser residential blocks tend to 
have good pedestrian access.  

• This step specifically asks for the number of residential units per block, but OSM does 
not provide such information. So, it is one of the major setbacks of using OSM. But 
just to test the methodology we are using the number of residential buildings per 
block. 

• For this step we need – Residential buildings, Residential land use and Block 
boundaries in the neighbourhood:  
1. First export only “Residential buildings” and “Residential land use” from all the 

other types of buildings and land uses for the study area. Make the separate 
shapefiles for each.  

2. Next step would be to add a field in the attribute table of “Residential buildings” 
called “Number” and add the number “1” for all the buildings. 

3. Now next step is to add “Area” field in attribute table of “Residential land use” 
using the field calculator. Make sure it is executed for all the land use types.  

4. Then using vector processing tool called “Join attributes by location” join the 
Residential building file to the block files and name it “Join Residential buildings”. 
Fill the information as follows:  

• Join to feature in – Block layer 

• Where the features – Intersects 

• By comparing to - Residential building layer 

• Fields to summarize – Number 

• Summarise to calculate – Count 
5. Next repeat the process using the same tool and name the file “Residential 

density”. Fill the information as follows - 
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• Join to feature in – Join Residential buildings 

• Where the features – Intersects 

• By comparing to - Residential land use 

• Fields to summarize – Area 

• Summarise to calculate – sum 

• Now in the attribute table of this newly formed file, you will have the number of 
residential buildings and area of residential land use by block. So now, add a new 
field using field calculator and divide the number of buildings by land use area. 
Finally, we have residential density per block. 

Step 4: Measure retail floor area ratio 

• The next step is to calculate the retail building floor area footprint divided by retail 
land area footprint. The rationale is that a low ratio indicates a retail development 
likely to have substantial parking, while a high ratio indicated smaller setbacks and 
less surface parking; two factors thought to facilitate pedestrian access. 

• For this step we need – Retail buildings, Retail land use and Block boundaries in the 
neighbourhood (We will use Residential density file to have all the data by block in 
same shapefile).  
1. First export only “Retail buildings” and “Retail land use” from all the other types of 

buildings and land uses for the study area. Make the separate shapefiles for each. 
But while cross checking the data we found out that the land use marked as 
commercial does not match on ground. Figure 30 shows the google street view of 
an office building present on designated retail land use area. This demonstrates 
there are major problems in accepting OSM data to its truth value. But for the 
sake of conducting the methodology we go ahead.   

 

Figure 30. Office building present on the designated retail land use 
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2. Now next step is to add “Area” field in attribute tables of “Retail buildings” and 
“Retail land use” using the field calculator. Make sure it is executed for all the 
rows.  

3. Then using vector processing tool called “Join attributes by location” join the 
Retail buildings to Residential density and name it “Join Retail buildings”. Fill the 
information as follows: 

• Join to feature in – Residential density 

• Where the features – Intersects 

• By comparing to - Retail buildings 

• Fields to summarize – Area 

• Summarise to calculate – sum 
4. Next repeat the process using the same tool and name the file “Retail floor area 

ratio”. Fill the information as follows: 

• Join to feature in – Join Retail buildings 

• Where the features – Intersects 

• By comparing to - Retail land use 

• Fields to summarize – Area 

• Summarise to calculate – sum 

• Now in the attribute table of this newly formed file, you will have the number of retail 
building floor area and area of retail land use by block. So now, add a new field using 
field calculator and divide the retail building floor area by area of retail land use. 
Finally, we have Retail floor area ratio per block. 

Step 5: Measure Intersection density data:  

• Next step is to measure the connectivity of the street network, represented by the 
ratio between the number of true intersections (three or more legs) to the land area of 
the block group. The rationale is that a higher density of intersections corresponds 
with a more direct path between destinations. 

o For this we need Intersections layer, and block layer (We will use “Retail floor 
area ratio” to have all the data by block in same shapefile).  

o Add the intersection layer in the QGIS, where you might see too many 
intersections for the same point.  

• As shown in Figure 31, OSM shapefile has marked way too many point vectors for an 
intersection. So, there is no other way but to edit the file and cross check all the 
intersection. All the extra points shall be removed or even the new shapefile can be 
made all together.   

• The next concern is regarding the number of vector points to be given in an 
intersection. Ideally it should be 1 for each but as in next steps we have to calculate 
the number of intersections per block, all of them shall be marked according to the 
number of blocks that share that same intersection. 

• As shown in Figure 32 all the intersections shall be marked individually and manually.  
o Once when we have the “Intersection” shapefile ready we can move ahead 

with counting the number of intersections per block. Add a field in the attribute 
table of “Intersection” called “Number” and add the number “1” for all the rows. 
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Figure 31. The number of intersections marked in OSM shapefile for one true intersection. 

 

 

Figure 32. All blocks sharing the intersections shall be marked with one vector point each for correct 
results 

• Then using vector processing tool called “Join attributes by location” join the 
“Intersection” shapefile to the block files and name it “Intersection Density”. Fill the 
information as follows - 

• Join to feature in – Retail floor area ratio 

• Where the features – Intersects 

• By comparing to - Intersection 

• Fields to summarize – Number 

• Summarise to calculate – Count 

• Next step is to calculate the area of each bock. Add “Area” field in attribute tables of 
“Intersection Density” using the field calculator. Make sure it is executed for all the 
rows. 

• Add a new field using field calculator and divide the number of intersections by area 
of blocks. Finally, we have Intersection density per block. 

Step 6: Measure Land-use mix or entropy score:  
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• In this step we shall measure the degree to which a diversity of land use types is 
present in a block. These use type shall change according to the available data but 
broadly the data available on OSM in our case study we have considered in six land 
use types: education, green, industrial, residential, retail and religious. 

• In the data from OSM there were some inconsistencies in the data where some of the 
land uses were overlapping as shown in Figure 33 which is not supposed to happen.  

 

Figure 33. Inconsistencies in OSM data where land use types are overlapping. 

• So, before calculating diversity index we need to remove overlapping areas. This step 
is completely depending on the case-to-case basis. There might not be this issue so 
you can overlook this step.  

• For diversity index here we will use Land Use Mix (LUM) diversity index:  

 

where: Pi = Proportion of each land use type area within the total area of the block; 
n = the total number of land use types. 

• The Land Use Mix (LUM) Index is a measure that quantifies how evenly distributed 
land use types are within a defined area, such as a block group.  

• So, to start this process we need to give a unique “id” to all the blocks if its already 
not given. It can be given from field calculator. 

•  Then the “Land use” shall be intersected with the blocks. Which means to use 
“Intersection” vector tool and put –  

Input Layer: Intersection Density 

Overlay Layer: Land Use Layer. 

• Now once we have all the intersected blocks as per their various land use types, we 
shall measure the areas of each one of them. Use field calculator and calculate area. 

• Next Go to Processing Toolbox > search for Group Stats (May need to install and 
enable it via the Plugin Manager if not already installed). Where we shall put –  

Layer: Select your Intersected_Land_Use layer (from the intersection step). 

Rows: 
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a. Drag Block Group ID (or the field identifying each block group) into the Rows 
section. 

b. This ensures the results are grouped by each block group. 

Columns: 

a. Drag Land Use Type into the Columns section. 
b. This will create separate columns for each land use type. 

Value: 

c. Drag Area (the field you created earlier containing the area of each land use 
feature) into the Value section. 

d. In the drop-down below the Value field, select Sum to calculate the total area 
for each land use type within each block group and calculate. 

• Now export it as a CSV file and again add it to your GIS software. Now, open 
the properties of “Intersection Density” and make a join with new CSV file with 
Id. Now in the attribute table of “Intersection Density” you shall have the areas 
of different land use within the block. (This data may be in the form of text form 
and could not be processed. In that case you shall copy the data in decimal 
form via field calculator. If the data from CSV is already in decimal form, then 
we can directly go to next step.) 

• Now, we shall add the various land use types in a block. Use field calculator 
and create “Total Land use”. E.g. Total Land use = sum ("Area1", "Area2", ..., 
"AreaN") 

• Now we shall measure the proportion of all the land use areas. e.g. 
Prop_LandUse1 = "Area1" / " Total Land use ". Repeat this process for all the 
land use types and calculate the proportion of all of them. 

• Now the next step would be to calculate diversity index which is  

• DI = -1 * ( "Prop_LandUse1" * ln("Prop_LandUse1") + "Prop_LandUse2" * 
ln("Prop_LandUse2") + ... + "Prop_LandUseN" * ln("Prop_LandUseN") ) 

• Now divide the result the total number of land use types (e.g., 6 in our case) 
and finally we have the Diversity index. 

Step 7: Normalize Each Measure Using Z-Scores 

• Once the values for each component are calculated, they need to be standardized to 
allow fair comparison across different regions and scales. This is done using z-
scores. 

• A z-score tells you how far a specific value (like the net residential density for a block 
group) is from the average value (mean) for that component across all block groups in 
the region. 

• Z-score = 0 means the value is equal to the average. 

• Positive z-score means the value is above the average. 

• Negative z-score means the value is below the average. 

• The z-scores are calculated separately for each of the components i.e. Residential 
density, Retail ratio, Intersection density and land use diversity. 

• For example, for residential density open the field calculator of “Intersection Density” 
or where all the four components are and put – 
("residential density " - minimum ("residential density ")) / (maximum ("residential 
density ") - minimum ("residential density ")) 

• Repeat this to other components as well. 

Step 8: Calculate the Walkability Index 
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• In the same attribute table of the overall walkability index using this formula: 
Walkability = [(2 x z-intersection density) + (z-net residential density) + (z-retail floor 
area ratio) + (z-land use mix)] 

• (Intersection density has the highest weight (multiplied by 2) because of its strong 
influence on walkability.) 

Step 9: Map the Walkability Index 

• Classify the walkability scores into quartiles or similar groupings (e.g., low, medium, 
high) to map and compare walkability across the selected area. 

 

 

Figure 34. The result of the first phase walking index. 

Interpretation of results  

In the given focus study area, it can be inferred that it is divided into two distinct parts. The 
southern section primarily consists of residential blocks, while the northern section is mix of 
Residential, industrial and commercial areas. The focus street acts as a dividing line between 
these neighbourhoods. The southern residential blocks are significantly more walkable 
compared to those in the north. The resulted "High walkable" blocks are mostly dense 
residential areas with a high concentration of intersections.  While these bocks are mostly 
only residential the entropy score for land use has no effect. Also, there is only one 
designated retail land use space, so this also does not have weight in overall walkability 
index results. 

Phase 2 – Open street map data for the city. 

After thoroughly analysing the focus study area, it is essential to validate these findings by 
comparing them to a larger area, in this case, Corsico city. This comparison will provide a 
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more holistic perspective on the overall walkability evaluation. The focus study area featured 
limited land use types and a relatively small sample size, which might restrict the 
generalizability of the results. 

In the next phase, the study will expand to include Corsico city, ensuring a broader context 
for comparison. The data for this phase will also be sourced from OpenStreetMap to maintain 
consistency in methodology. The procedure will be exactly as same as the Phase 1. So 
please refer the previous description and just change the scale to the city level. 

 

Figure 35. The result of the Second phase walking index 

Interpretation of results  

The results from Phase 2 establish that the initial focus study area was a dense residential 
settlement. At the city level, there are a few other high-walkability areas outside the focus 
study area; however, they remain relatively sparse. Expanding the study area in Phase 2 
introduced some degree of variation to the results of the Phase 1 focus study area, even 
though the attribute table data values remained unchanged. This variation is due to the data 
normalization process used during the evaluation of the Walkability Index. Specifically, 
minimum-maximum normalization was applied, a method commonly used to scale values 
within a specific range. When the study area was widened in Phase 2, the minimum and 
maximum values shifted, altering the normalized scores. As a result, this adjustment 
indirectly impacted the walkability scores of the Phase 1 focus study area. 

 Limitations in Phase1 and 2 

Phases 1 and 2 were primarily based on the data collected from OSM. During these phases 
it is been established that there are some major inconsistencies and inaccuracies in the data, 
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which have had a considerable impact on the overall results. Examples of these issues 
include:  

• Incorrect Mapping of Intersections: Many intersections are misrepresented, 
leading to inaccuracies in the calculation of intersection density. 

• Lack of Data on Residential Units: The absence of information about the number of 
residential units in buildings has caused errors in calculating residential density. 

• Inaccuracies in Land Use Mapping: Land use types are often misclassified or 
overlapping, which results in errors in determining the retail area ratio and entropy 
score. 

All these reasons call for another phase with more accurate data. 

Phase 3 – Data from geoportal of the municipality for focus study area. 

To overcome the inaccuracies in the previous phases we strongly recommend using the 
updated records from local municipality. For the case study of Corsico, we used the records 
from Geoportal of Lombardi region (https://www.geoportale.regione.lombardia.it/ ) and from 
https://www.istat.it/.  

The downloaded data –  

• Residential density:  
a. Municipality records did not provide information on the number of residential 

units in buildings. However, the ISTAT website offered block-level data on the 
number of families. 

b. For this phase, it was assumed that each family corresponds to one 
residential unit. Therefore, the number of families was used as a proxy for 
residential density. 

• Retail density –  
a. Municipality records provided more accurate land use data, which revealed 

that there is no dedicated land for retail use in the focus study area. 
b. However, since the municipality did not supply building use data, the building 

use information from OSM was retained for this phase. But since there is no 
retail land use in the focus study area this data shall remain null. 

• Land use data: 
Land use data from the municipality records was used to calculate entropy scores, 
offering a more reliable and accurate measure compared to the previous phases. 
Intersection density – 
The municipality did not provide intersection data, so the intersection data manually 
recorded during earlier phases was reused for this phase. 

https://www.geoportale.regione.lombardia.it/
https://www.istat.it/
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Figure 36. Phase 3 results for the focus study area. 

Interpretation of results  

The results from Phase 3 gives more accurate data compared to phase 1. Because the more 
accurate data has been used for this phase. The results however are more or less similar 
and shows southern residential blocks as highly walkable neighbourhoods. Along with it, 
these results show walkable neighbourhoods along Via Alzaia Trento, and it helps to figure 
out the problem areas.  

Limitations 

The Walkability Index, while it is a good tool for assessing the walkability of urban areas, has 
notable limitations that must be acknowledged to contextualize its results. While it is based 
on measurable physical infrastructure such as intersection density, residential density, and 
land use mix, it does not comprehensively account for the quality or usability of walking 
infrastructure.  

• The index does not evaluate the condition or quality of walking infrastructure. For 
example: 

a. Pedestrian Comfort and Safety: Factors like shading, lighting, and protection 
from vehicular traffic are not assessed, even though they heavily influence a 
person’s willingness to walk. 

b. Sidewalk Quality: It does not measure whether sidewalks are well-maintained, 
free from obstacles, or sufficiently wide to accommodate pedestrians. 

c. Traffic Safety: Critical elements such as pedestrian crossings, speed limits, or 
the presence of traffic-calming measures are entirely overlooked. 
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• The index fails to address the accessibility of walking infrastructure for all users, 
including: 

a. Individuals with mobility impairments, such as those requiring wheelchairs or 
walking aids. 

b. Parents with strollers or elderly pedestrians, for whom steep gradients, steps, 
or narrow paths can be barriers. 

Walk Score Index (a street-level measure) 

Aim: Walkability indices are valuable tools for assessing how conducive an area is to 
walking; However, their utility is often constrained by the need for extensive data collection, 
such as detailed land-use or infrastructure data, which may not always be readily available, 
especially in resource-limited or diverse urban contexts. A more accessible alternative is the 
Walk Score index, which leverages open data to provide a rapid assessment of walkability 
potential at the street level.  

Methodology: Walk Score evaluates the walkability of specific locations based on the 
proximity and accessibility of amenities, as well as other factors influencing pedestrian-
friendly environments. Its methodology considers several key aspects. First, it measures the 
distance to various categories of amenities such as grocery stores, schools, parks, 
restaurants, retail stores, and entertainment facilities. The closer the amenities, the higher 
the Walk Score, with diminishing returns for distances that exceed a certain walkable range. 
The tool uses a road network analysis to calculate walking distances rather than straight-line 
distances, providing a more realistic assessment of accessibility. Factors such as block 
length and the presence of pedestrian pathways are also considered, as they influence the 
practicality of walking in a given area. Additionally, areas with diverse land use—such as a 
mix of residential, commercial, and recreational spaces—tend to score higher because they 
support a range of activities within walking distance. Population density is another variable, 
as higher density often correlates with greater walkability due to the increased availability of 
services and infrastructure.  

The scoring system assigns a numerical value from 0 to 100: 

• 90-100 (Walker’s Paradise): Daily errands do not require a car. 

• 70-89 (Very Walkable): Most errands can be accomplished on foot. 

• 50-69 (Somewhat Walkable): Some errands can be accomplished on foot. 

• 25-49 (Car-Dependent): Most errands require a car. 

• 0-24 (Car-Dependent): Almost all errands require a car. 

Case studies  

Since Walk Score provides a score for each specific street separately, mapping and 
analysing walk-scores at a larger context, such as a neighbourhood or district, requires some 
manual work. This report exemplifies and outlines the use of Walk Score for walkability 
assessment in two neighbourhoods in Haifa, Israel- Kiryat Eliezer and Carmel Center (Figure 
1) - showcasing its potential for urban research and planning. 

Carmel Center, also known as Merkaz HaCarmel, is a vibrant neighbourhood situated on the 
slopes of Mount Carmel in Haifa. It serves as a cultural and recreational hub in the city, 
combining residential buildings with commercial areas, including shopping centres, cafes, 
restaurants, and hotels. Approximately 21,500 residents live in the neighbourhood. Nearly a 
quarter of the population is aged 65 and older (24.2%). Accordingly, the neighbourhood hosts 
several senior citizens' facilities, including a day centre for the elderly, senior clubs and 
nursing homes. The area is characterized by a hilly topography.  
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Kiryat Eliezer is a residential neighbourhood located in the northwestern part of Haifa. The 
neighbourhood is characterized by its flat topography (which is relatively uncommon in 
Haifa), making it easier for residents to navigate the area on foot. Kiryat Eliezer is 
predominantly residential, featuring a mix of older apartment buildings and newer 
developments. The area includes a large commercial centre that caters to various needs, 
such as restaurants, cafes, clothing stores, health clinics, and schools, all within walking 
distance. Approximately 14,200 residents live in the neighbourhood. Some nearby attractions 
(outside the neighbourhood, but within a walking distance) include Bat Galim Beach and the 
German Colony. The neighbourhood is undergoing urban renewal projects aimed at 
revitalizing the area. 

 

Figure 37. Case study neighbourhoods’ location 

Step-by-Step Tutorial 

To map the walk-scores of the streets in large contexts (e.g., neighbourhood or district), it is 
suggested to use ArcGIS Pro software (a desktop application), or the GIS-Online platform 
(aimed at sharing GIS data and enabling collaboration). It is worth mentioning that the work 
done in ArcGIS Pro can also be shared with others or uploaded to ArcGIS Online at any 
point.  

Step 1 – download or create the street network layer 

At this stage, the street network can be downloaded from Open Street Map (OSM) or, if 
available, from the municipality’s online GIS portal. If the area in question is not very big, a 
manual drawing of the street network might also be considered, as OSM data might contain 
unwanted “dirt”, such as multiple lines representing each street. In our example, we manually 
created the street network of each neighbourhood in ArcGIS Pro software, as shown in 
Figure 38. At the end of this stage, add a new field to your street network layer, called 
“walkscore”. 
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Figure 38. Creating the street network layer 

 

Step 2 – go to https://www.walkscore.com/  

At this stage, search for the street in question in the Walk Score website and enter the data 
into the new field created at the end of stage 1. An example is shown in Figure 39. 

  

Figure 39. Entering the walk score of each street 

https://www.walkscore.com/
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Step 3 – defining the symbology 

Adjust the symbology of your data according to the Walk Score scoring system and analyse 
the results. An example is shown in Figure 40. 

 

 

Figure 40. Walk score values displayed at the two case study neighbourhoods 

Interpretation of results 

In Kiryat Eliezer, most streets fall within the "very walkable" category, with scores ranging 
from 70 to 89. This indicates that most errands can be accomplished on foot, reflecting a 
relatively high level of walkability across the neighbourhood. While few streets show slightly 
lower scores, placing them in the "somewhat walkable" category (50–69), the general pattern 
suggests that Kiryat Eliezer supports pedestrian activity to a high degree. The prevalence of 
"very walkable" streets points to a neighbourhood structure that provides a reasonable level 
of connectivity and access to key amenities, making walking a convenient mode of transport 
for residents. 

Merkaz Hakarmel, however, surpasses Kiryat Eliezer in walkability, with most streets 
classified as "walker's paradise" (90–100) or "very walkable" (70–89). This reflects a highly 
pedestrian-oriented environment where daily errands can be completed without requiring a 
car. The walkability of Merkaz Hakarmel may be attributed to its centrality and access to 
amenities, but the scores suggest there could be some limitations in terms of street 
connectivity or pedestrian infrastructure that prevent it from achieving uniformly high 
walkability. It is worth mentioning at this point one of the limitations of walk score, as it 
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ignores the topography of the neighbourhood, which might impact the walkability level of 
certain streets. 

The comparison between the two neighbourhoods highlights the varying degrees of 
walkability that urban design and infrastructure can create. These findings might suggest that 
further enhancements in Kiryat Eliezer, such as improving pedestrian infrastructure or 
increasing the density of local amenities, could elevate its walkability even further. Merkaz 
Hakarmel, on the other hand, exemplifies the benefits of integrated urban planning that 
prioritizes pedestrian access and connectivity. 

Limitations 

Walk Score presents several limitations to consider. First, it does not directly measure the 
quality of sidewalks, traffic safety, topography or pedestrian comfort, nor does it account for 
temporal variations like time-of-day access or seasonal factors. Furthermore, as a tool 
cantered on the availability of amenities, it may overlook other essential aspects of 
walkability, such as accessibility for people with disabilities. In addition, Walk Score is 
available for cities and towns worldwide, though its accuracy depends on the quality of local 
data. It is most comprehensive in North America, where robust datasets about amenities, 
land use, and transportation networks are more readily available. For less-developed areas, 
Walk Score may be less precise, as it relies on public datasets, business listings, and 
mapping technologies like Google Maps. Despite these limitations, Walk Score provides a 
rapid, accessible, and comparable metric for evaluating walkability in urban areas worldwide. 

Perspective on Objective Walkability Indexes 

While objective walkability indexes provide valuable, standardized measures to assess and 
compare built environments, their advancement and application should be approached 
cautiously and with balance. Objective walkability indexes have become a central tool in 
urban planning, transportation research, and public health, offering quantifiable and 
comparable measures of how conducive an area is for walking. They typically integrate 
spatial indicators such as intersection density, land-use mix, resides and population density, 
proximity to destinations, and street design characteristics.  There are neighborhood-Level 
and street-level walkability indexes, both are diagnostic tools that should be interpreted in 
conjunction with one another and with field observations. The integration of both scales, 
macro-level structural analysis and micro-level experiential data, provides a more complete 
and balanced understanding of urban walkability. By translating complex urban form 
attributes into measurable values, these indexes enable planners and policymakers to 
monitor trends, compare neighborhoods, identify investment priorities, and evaluate the 
effects of interventions aimed at promoting active mobility.   

However, walkability is inherently contextual and experiential. Objective measures may 
overlook qualitative dimensions such as safety perceptions, comfort, aesthetics, or cultural 
and social dynamics influencing walking behavior. Furthermore, indicators derived from GIS 
or remote sensing data may carry spatial or temporal biases, depending on data quality, 
scale, and variable selection. Overreliance on such indexes, without considering subjective 
or local perspectives, may thus yield misleading conclusions or reinforce inequities. 

Such indexes must be advanced cautiously, with a balanced perspective that recognizes 
both their analytical power and their limitations. 

Conceptual Cautions 

Walkability is not only a function of the built environment, but also shaped by social, cultural, 
psychological, and environmental dimensions. Objective indexes may fail to capture aspects 
such as perceived safety, aesthetic appeal, shade, noise, traffic stress, or social cohesion, all 
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which influence whether people actually choose to walk. Moreover, walkability is context-
dependent: the same urban form features may have different implications in a dense city 
center versus a suburban area, or across different cultural and climatic settings as well as 
age and gender related. Thus, advancing an index without sensitivity to context risks 
oversimplifying a complex and multi -perspective human experience. 

Methodological Considerations 

Developing walkability indexes involves numerous methodological choices including 
selection of indicators, data sources, weighting schemes, normalization methods, and spatial 
scales. Each choice can significantly influence outcomes. For instance, the choice of network 
versus Euclidean distances, or the scale at which destinations are aggregated, can alter 
results. Indeed, there are many objective walkability indexes, and they don’t always reflect 
the same level of walkability in the same geographical area. Similarly, data quality and 
temporal misalignment between datasets (e.g., land use from one year and demographic 
data from another) can introduce bias. Transparency and reproducibility in these 
methodological decisions are therefore crucial to maintain scientific rigor and comparability. 

Interpretation and Application 

While objective indexes are powerful for benchmarking and evidence-based decision-
making, they should not be treated as definitive measures of walkability. Overreliance on 
composite indexes may obscure trade-offs among individual dimension, for example, an area 
might score high on density but low on safety or comfort. In practice, objective walkability 
metrics should be interpreted as diagnostic tools rather than final judgments. They are most 
valuable when used to guide further qualitative inquiry or community engagement, helping 
identify where lived experiences align, or conflict, with modelled outcomes. 

Toward Integrated Approaches 

A balanced approach to walkability combines both objective and subjective perspectives. 
Integrating objective measures with perception-based surveys, participatory mapping, field 
audits, or sensor-based data (such as pedestrian counts or mobility traces) can provide a 
more holistic understanding of walkability. Recent advances in technology and data science, 
including high-resolution spatial data, street-level imagery, artificial intelligence, machine 
learning, and computer vision enable richer assessments that bridge quantitative indicators 
with experiential data. These tools enhance traditional indexes by incorporating new 
dimensions such as micro-scale urban design, greenery, and the quality of pedestrian 
infrastructure. Equally important is the inclusion of subjective and behavioral data, which 
reveal how different groups experience and navigate their environments. Future walkability 
research should therefore strive toward adaptive, transparent, inclusive, and context-
sensitive frameworks that reflect both physical environments and diverse human perceptions. 

Policy and Ethical Implications 

Finally, promoting objectivity should not obscure the equity and ethical dimensions of 
walkability measurement. Walkability improvements guided solely by index scores may 
inadvertently prioritize already well-resourced neighborhoods, reinforcing spatial inequalities. 
The socio-economic characteristics should be taken into consideration.  A balanced 
perspective entails ensuring that measurement frameworks are inclusive and responsive to 
diverse community needs, especially in marginalized or underserved areas. 

In summary, objective walkability indexes provide valuable analytical tools for assessing 
urban environments, but they must be applied critically and contextually. Their true value lies 
in informing decision making, dialogue, and participatory planning.  When used thoughtfully, 
they can serve as a bridge between quantitative assessment and qualitative experience, 
guiding cities toward more walkable, equitable, and sustainable futures. 
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5.3 Accessibility (Neighbourhoods as Service Providers) 

Basic concept 

Accessibility concepts are increasingly acknowledged as fundamental for grasping how cities 
and urban region function. Accessibility measures are able to provide a framework for 
understanding the reciprocal relationships between land use and mobility. The ability of 
various population groups to reach daily activities by different modes of transport bares 
significant impacts on equity and efficiency issues.  This has an important value for urban 
planning practice.  

Accessibility Measure 

Aim – to develop a methodology for evaluating pedestrian accessibility within 
neighbourhoods by analysing spatial proximities to essential facilities, considering the needs 
of diverse populations, and identifying areas with accessibility gaps to inform equitable urban 
planning.  

Reference - https://journals.sagepub.com/doi/epdf/10.1068/b12977 

Methodology   

• The study develops an accessibility measurement and lays out the methodological 
steps for its practical application in planning.  

• The idea is based on the ability to reach urban places. Also to evaluate the quantity 
and quality of places that can be reached.  

• The study calls for at minimum GIS based data consist of three types: locations and 
characteristics of origins (places of residence), destinations (for example, facilities, 
shops, or places of employment). 

• There are five approaches suggested in the city which are Number of facilities 
available, number of facilities within given distance from origin, minimum distance, 
travel cost and an index.  

• This tool also presents an opportunity to combine results with demographic data to 
identify areas where populations in need (e.g., children, low-income, elderly etc) have 
lower access to services 

• The data needed to evaluate can be sourced from public GIS repositories, open data 
portals of city governments, or urban planning databases. 

Data Needed   

• Origins: Locations where people live (census block centroids). 

• Destinations: Facilities that serve daily needs (parks, schools, stores etc). 

• Travel routes: Characteristics of the paths between origins and destinations (streets, 
sidewalks). 

• Population attributes: Demographic data such as age, income, and car ownership 
for evaluating access needs. 

Step-by-Step Methodology 

Step 1: Define the Purpose of Accessibility Analysis 

• Focus: Decide on the type of accessibility to analyse—pedestrian access for 
neighbourhoods. 

Step 2: Data Collection 

https://journals.sagepub.com/doi/epdf/10.1068/b12977
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• Origins: Collect data on residential locations (block groups). 

• Destinations: Gather data on neighbourhood-level facilities such as parks, schools, 
and stores. 

• Routes: Include travel route characteristics (e.g., sidewalk quality, traffic levels, 
safety). 

• Population Data: Collect socio-demographic information like age groups, car 
ownership, and income levels. 

Step 3: Compute Distances Between Origins and Destinations 

• Use GIS software to calculate distances: 

• Street network distance: Calculate travel distance along actual routes. 

• GIS software such as ArcView or ArcGIS can be used. In the case of ArcGIS an 
extension can be run to compute distances between multiple origins and destinations. 
The procedure is very straightforward. In ArcGIS, the user is prompted to enter two 
coverages representing origins and destinations in addition to a network coverage 
consisting ideally of streets. 

Step 4: Compute Accessibility Measures 

• Use two primary approaches: 
a. Minimum Distance: Measure the distance from each origin to the nearest 

destination. 
b. Coverage: Count the number of facilities within a specified walking distance from an 

origin. 

• Apply these measures to determine how many destinations can be reached within a 
certain distance. 

Step 5: Analyse Results 

• Citywide Access: Measure overall access across the city and evaluate how well 
neighbourhoods perform in providing services. 

• Intraurban Variation: Identify areas with varying levels of access. Look for patterns 
of high or low access across different neighbourhoods.  

• It is to determine what kind of variation exists in access levels for different parts of the 
metropolitan area. The purpose of such an investigation is to identify areas with more 
or less access, such that relative comparisons of access can be made. 

• Targeted Access: Combine access measures with demographic data to identify 
areas where populations in need (e.g., low-income, elderly) have lower access to 
services. 

5.4 Visibility  

Basic concept 

An urban space is examined from a number of perspectives in order to determine its optimal 
performance. One of these aspects is visibility to open views in the built environment. 
Visibility refers to the ability to measure and evaluate the open space visible from different 
points on the plan, namely- visual openness to the view. 

In the built environment, visibility is closely related to the aspect of walkability. While walking, 
people often follow their line of sight, which guides them to the nearest visible point on the 
one hand and allows them to also take in the scenery surrounding them on the other. 
Through the use of these two elements of visibility, individuals can gain a better 
understanding of the urban environment surrounding them and make better decisions about 
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how to navigate and perform within it. Visibility is also related to being present in a location 
that provides a view, where people prefer to be in a location with a view. It may be possible to 
enjoy a closer, more enclosed view, but the aspiration is usually to enjoy a more expansive 
and open view. 

Visibility in the built environment can be measured quantitatively, spatially, geometrically, and 
numerically. It is possible to measure the amount of visible landscape in three dimensions, 
and in planning, the polygon of visible landscape can be measured by calculating its area 
and the perimeter that surrounds it. It is possible to measure visibility in the built environment 
quantitatively, spatially, geometrically, and numerically. In planning, a polygon of visible 
landscape can be measured by calculating its area and its perimeter. Also, measurement of 
the amount of visible landscape can be conducted in three dimensions. Here we 
demonstrate two methods for visibility assessment. One is based on Google Earth (and easy 
to apply) the other is a visibility measure through Isovist area. 

Visibility assessment using Google Earth 

A visibility assessment in urban environments can be easily achieved using the Google Earth 
viewshed tool. The tool, which is open access and applicable within the Google Earth 
platform, provides a viewshed calculation from any desired point in the map, while 
considering topography and buildings in 3-D. An example for using the tool, including 
explanations, in Westminster, London, UK, is shown in Figures 41-44. An additional example 
from Milan is shown in Figure 45. 

 

Figure 41. Adding a new landmark in Google Earth in the desired street\location for visibility assessment 

(an example from Westminster, London, UK) 
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Figure 42. The street view from the selected landmark in 3D 

  

Figure 43. Activating the "Viewshed" tool to map the visibility from the selected landmark 
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Figure 44. Viewshed results 

 

Figure 45. An example of using the "viewshed" tool in Piazza degli Affari, Milan, Italy 

Visibility measure (through Isovist area) 

Aim – to develop and apply visibility analysis models as evaluation tools, using a 
morphological approach to assess and improve spatial configurations for enhanced visual 
permeability. 

Reference -  http://dx.doi.org/10.1080/17549175.2010.502002 

Methodology - 

• It measures the openness of a view from specific vantage points, considering 
desirable views. 

• The visual openness is defined using three indexes reflecting 
a. The measured length of built façades where the view can be observed 
b. The measured area of built façades where the view can be observed 
c. The measured landscape area being viewed at street level and at every built 

story 

http://dx.doi.org/10.1080/17549175.2010.502002
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• The model given in the study measures the visual openness to the view from the 
urban fabric. 

• The visible area from a specific vantage point, typically used at ground or street level 
and at each building level is called as Isovist and it is being used for the analysis. 

• Isovists capture the extent of open space visible from selected points, providing a 
quantitative basis for comparing openness. 

• In order to encompass three-dimensional reality visual openness is measured at 
different levels of the built volumes facing the view. 

Step-by-Step Tutorial 

Step 1: Data Collection and Preparation 

1. Site Layout and Building Data - Detailed site plans, elevations, and building sections 
for the area under study. 

2. Identify Key Viewpoints and Open Spaces: 
a. Determine which areas or vantage points within the site will be used for 

openness measurements (e.g., facades, windows, public spaces). 
b. Highlight areas of particular interest, such as scenic views, green spaces, 

or water features that enhance visual openness. 
3. Landscape and Topographical Data - Obtain data on any topography and landscape 

elements (e.g., trees, slopes) that may affect visibility. 

Step 2: Model Development for Visual Openness 

1. Facade Lengths and Areas - For each building level, calculate the length and area of 
facades that have access to open views.  

2. Define Isovist areas — the visible area from a specific vantage point, typically used at 
ground or street level and at each building level. 

3. Categorize Facade Openness as (S) - This measurement represents the total facade 
area (S) that provides views of open spaces, measured in square meters (m²). 
Facade openness is assessed independently for each level to capture the unique 
openness at varying building heights. 

4. Isovist Openness (S1Isovist) - The Isovist area (S1Isovist) is the total visible open 
area from a viewpoint or facade section, also measured in square meters. Isovist 
openness can vary with building height and orientation, requiring separate 
calculations for different levels and facade orientations. 

Step 3: Conducting the Visual Openness Analysis 

1. Measurement at Street Level - Draw view lines (sightlines) extending from key points 
along the ground-level facades toward open spaces or notable landscape features. 
Calculate the Isovist area at street level by tracing the boundaries of the visible area 
from each vantage point and summing these areas. 

2. Measurement at Upper Levels - For each building level, measure the lengths of 
facade sections that directly overlook open spaces or offer unimpeded views. Record 
the total visible facade length (Lsum) and visible facade area (S) for each level. Draw 
view lines at each level to define the boundaries of visibility for Isovist calculations, 
then measure the Isovist area (S1Isovist) for each level. 

Step 4: Data Recording 

1. Facade lengths (Lsum): Summed for each level to understand the proportion of each 
level's facade that contributes to openness. 
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2. Facade areas (S): Total area of facades with open views, allowing a comprehensive 
comparison of openness across levels. 

3. Isovist areas (S1Isovist): These values capture the spatial extent of visible open 
space from each vantage point or building level. 

Step 5: Data Visualization and Analysis 

1. Diagramming Visual Openness - Create annotated diagrams or visual maps showing 
the openness results, with clear labelling of visible facade lengths and Isovist areas. 
Use color coding or shading to indicate varying levels of openness at each facade 
and floor level. 

2. Organize Measurements into a Comparative Table - Compile all visual openness data 
into a table for easy reference, summarizing: 

a. Total visible facade lengths (Lsum) at each level. 
b. Total visible facade areas (S) across building levels. 
c. Isovist area (S1Isovist) at each level.  

5.5 Safety Measure 

Aim – to develop and apply a flexible, pedestrian safety analysis that integrates multiple data 
sources and techniques to evaluate crash patterns, pedestrian infrastructure, and contextual 
factors, ultimately informing safety interventions and policy decisions. 

Reference -  https://www.researchgate.net/publication/262603174 

Methodology  

• Measuring perceived safety is a very subjective matter so it is not possible to conduct 
the analysis without field work. 

• This particular study uses composite method of on field observational methods and 
GIS mapping.   

• It provides a framework for a comprehensive, pedestrian safety analysis incorporating 
multiple data sources and analysis techniques.  

• The methodology includes an evaluation of available crash records, an audit of 
current pedestrian facilities, collection of pedestrian count data, and an assessment 
of relevant contextual factors. 

Step-by-Step Tutorial 

Step 1: Collection 

1. Crash and Incident Data: 

• Location (using geocodes or nearest intersections), 

• Crash Severity (fatalities, injuries, property damage), 

• Time and Date (to identify temporal patterns), 

• Lighting and Weather Conditions during each incident, and 

• Demographic Information of those involved (if available). 

(Sources for this data may include transportation departments, police reports, or 
national crash databases.) 

2. Pedestrian Volume and Behaviour Data: 

• Gather pedestrian count data to understand foot traffic volumes and usage patterns. 

• Record observations during peak and off-peak hours to capture a representative 
sample. 
Optional: Include demographic information like age, gender, and travel behaviour 
(e.g., crossing mid-block versus at crosswalks). 

https://www.researchgate.net/publication/262603174
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3. Environmental and Infrastructure Data: 

Assess physical infrastructure and environmental conditions that may impact 
pedestrian safety. Key data include: 

• Sidewalk Condition: Width, obstructions, and surface quality, 

• Crosswalk Markings: Visibility, presence, and maintenance of crosswalks, 

• Signalization: Traffic signals, pedestrian signals, and crossing times, 

• Lighting Quality: Intensity and coverage at intersections and along pathways, 

• ADA Compliance: Availability of curb ramps and other accessibility features. 
4. Area Contextual Data: 

Obtain socio-economic and land-use data to contextualize the pedestrian 
environment: 

• Land Use: Residential, commercial, or mixed-use, which may influence foot traffic, 

• Transit Access: Proximity to public transport stops or stations, 

• Demographics: Information on neighbourhood population, income levels, and car 
ownership rates. 

Step 2: Data Collection Techniques 

1. Crash Data Mapping: 

• Government or open data sources can be used and with GIS software the data can 
be geocoded. 

• Map crash incidents to visualize clusters and high-risk areas, which can aid in 
identifying hotspots for pedestrian incidents. 

2. Pedestrian Volume Counts: 

• Conduct manual or automated pedestrian counts at predetermined locations (e.g., 
intersections, mid-block crossings). 

• If using manual counts, standardize the data collection process to ensure 
consistency. The National Bicycle and Pedestrian Documentation Project offers 
guidelines on count timing and extrapolation methods for estimating annual or daily 
volumes. 

• For automated data collection, use video analysis software or sensors to continuously 
record pedestrian volumes over time. 

3. Environmental and Infrastructure Audits: 

• Conduct on-site audits using structured checklists that assess the pedestrian 
environment’s quality. Essential elements to audit include: 

o Crossing Facilities: Visibility, markings, signalization, and proximity to key 
pedestrian destinations, 

o Sidewalk Quality: Continuity, width, maintenance status, and potential 
obstructions, 

o Lighting: Intensity and adequacy for visibility at night, 
o Standards Compliance: Evaluate curb ramps, tactile indicators, and 

accessible paths. 
o The audit process should provide quantitative scores (e.g., poor to excellent) 

or yes/no assessments to facilitate analysis. 
4. Contextual Data Collection: 

• Collect socio-economic data from sources such as census data, public records, or 
GIS databases. Demographic data help contextualize the pedestrian safety needs 
and highlight areas that may require additional consideration due to population 
density or lack of private vehicle ownership. 
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• Compile land-use and transit data by mapping zoning information, land-use plans, or 
transit routes, identifying locations with high pedestrian generator potential (e.g., 
schools, parks, commercial centers). 

Step 3: Data Processing and Normalization 

1. Data Normalization: 

• Standardize data formats, especially for variables that vary significantly in magnitude 
(e.g., pedestrian counts versus crash counts). Normalize values to facilitate 
comparison across different data types. 

• Normalize pedestrian volume data by adjusting for factors such as day of the week 
and time of year, using seasonal and daily adjustment factors if available. 

2. Weighting Criteria: 

• Use a weighting method such as the Analytic Hierarchy Process (AHP) to assign 
importance to various criteria based on expert input. 

• Weights should reflect the relative impact of each criterion on pedestrian safety, 
ensuring that high-impact factors like lighting or crosswalk visibility are prioritized in 
the final evaluation. 

Step 4: Analytical Methods 

• Spatial Analysis of Crash Clusters - Identify pedestrian crash clusters through 
spatial analysis tools. This involves calculating the density of incidents in specified 
geographic areas and identifying hotspots. Tools such as kernel density estimation or 
CrimeStat software can help visualize crash concentrations and assess spatial 
relationships between crashes and surrounding infrastructure. 

• Scoring and Aggregation - Assign scores to each data point or location based on 
the collected data. For example, a crosswalk with poor visibility and missing signals 
would receive a lower score than one with adequate visibility and signalization. 
Aggregate scores across multiple factors to develop an overall safety score for each 
evaluated area. 

• Trend and Pattern Analysis - Analye pedestrian volume data and incident patterns 
over time to detect trends. For example, determine whether crash rates increase 
during certain times of day or specific weather conditions. Evaluate infrastructure 
audit results alongside crash and volume data to identify correlations between poor 
infrastructure and higher incident rates. 

• Benchmarking and Threshold Definition - Establish baseline safety scores by 
defining a “minimum safety standard” based on thresholds from industry best 
practices or historical data. Compare each area’s score to this benchmark to classify 
areas as meeting, exceeding, or falling short of the minimum safety standard. 

5.6 Security Measure (the Security Rating Index weighted scale table) 

Aim – The study aims to develop and implement the Security Rating Index (SRI), a GIS-
based quantifiable system, to measure the sense of security in urban spaces, evaluate 
insecure environments. 

Reference - https://doi.org/10.1016/j.landurbplan.2018.08.022 

Methodology  

• This research deals with the sense of security, in quantitative terms based on a geo-
spatial system, and then relate it to human-scale urban form.  

• The Security Rating Index (SRI) establishes a GIS-based, quantifiable system to 
identify and rate insecure urban spaces. 

https://doi.org/10.1016/j.landurbplan.2018.08.022
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• The system is based on measurements of urban elements that influence the sense of 
security in the built environment and can be used to identify characteristics and hot 
spots of unsecured spaces in a city.  

• The study is based on mixed land use or entropy score, The condition of street 
lighting, The proximity of building and Intersection density. 

• Post-analysis can validate the effectiveness of the SRI by comparing its predictions 
with actual crime hotspots. 

• This approach demonstrates that the SRI could help urban planners identify insecure 
areas and plan even in places where historical crime data might not be available. 

Step-by-Step Tutorial 

Step 1: Data Collection 

• Building uses: Information on the different uses (commercial, residential, etc.). 

• Street layouts and intersections: Details of streets, intersections, and junctions. 

• Streetlights: Location and distribution of street lighting. 

• Proximity and distances between buildings: Measuring the distance between 
various structures. 

• Public open spaces: Locations and layouts of parks, squares, and other public 
areas. 

• Crime data (if available): Information on past crime incidents to help in evaluation. 

Step 2: GIS-Based Analysis 

Mixed Land Uses 

• GIS Tool: A land use layer shall be created in GIS where different land use types are 
mapped. Each area (pixel) shall receive a score based on the number of land use 
types within it. 

• Weighted Scoring: A high number of different uses in an area (e.g., commercial, 
residential, and public spaces together) shall score higher on security, whereas 
single-use zones (e.g., purely industrial or residential) shall score lower. 

Street Lighting 

• GIS Tool: The kernel density tool in GIS should be used to assess lighting density by 
mapping each streetlight and analysing its distribution over the area. 

• Layer Scoring: Points with high concentrations of streetlights within a 25-square-
meter area shall score higher (more secure), while areas with fewer or no streetlights 
shall receive a lower score. This layer primarily shall impact the nighttime security 
index. 

Building Proximity 

• GIS Tool: Euclidean Distance shall be used to measure the straight-line distance 
between building edges across the map. 

• Proximity Scoring: Distances shall be divided into intervals (e.g., 0-5m, 5-10m, up to 
over 50m), with closer distances rated as more secure (scoring lower on the 
vulnerability scale) and longer distances rated as less secure. 

Intersections and Distance Between Junctions 

• GIS Tools - Count Tool: This can be used to calculate the number of intersections 
within a given area, with higher counts contributing to higher security. 
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• Euclidean Distance: Also, can be used to calculate distances between intersections, 
with closer junctions scoring as more secure. 

• Layer Scoring: Areas with more intersections and shorter distances between 
junctions shall be scored higher, promoting surveillance opportunities and ease of 
access for security measures. 

Step 3: Collecting the Necessary Data 

Raster Integration and Final Security Index (SRI) Map 

• Creating Individual Layers: Each of these elements (land use, lighting, proximity, 
and intersections) shall be represented as a separate GIS raster layer, with pixels 
scoring based on the element’s weighted security score. 

• Combining Layers: Using the Raster Calculator tool, all layers should be summed 
to create the integrated SRI map. Each pixel in this map now represented a 
cumulative security rating based on the combined influence of all elements. 

• Daytime vs. Nighttime Maps: For nighttime maps, the street lighting layer shall be 
given additional weight to reflect its greater importance at night. 

Step 4: Comparative Evaluation using available crime data 

• Purpose of Crime Data: Crime data itself is not part of the SRI calculation. Instead, it 
can be used post-analysis to validate the effectiveness of the SRI by comparing its 
predictions with actual crime hotspots. 

• Visual Comparison: The SRI maps generated by the model can visually compared 
with crime hotspot maps to see if areas identified as low security in the SRI (darker 
zones) are matching with recorded crime data locations. 

5.7 GIS analysis with OSM data and application in Amsterdam 

Introduction 

This section presents a method for the GIS analysis of walkability, accessibility, visibility, 
safety and security. The method is tested in the JUST STREETS pilot cities, and the results 
are presented/showcased in this section. Recommendations/requirements for the application 
of this method in other cities are provided.  

This subtask report is structured in the following way: we first describe the method and 
results in the 12 partner cities. Then, as a representative case for the pilot cities, we report 
the concrete results for Amsterdam where additional public data sources have been used, to 
showcase what could be done for all city partners. Finally, from the analysis and examples 
shown previously in the literature, we expand on what could be explored with access to more 
data.   

As we did not receive pedestrian data from WP4, the analysis was carried out with public and 
open data from OpenStreetMap (OSM) and other sources mentioned below. All the code 
used for the analysis presented below is accessible at 
https://github.com/csebastiao/walkability_JS .  

General analysis for all 12 cities  

We extracted the administrative polygon of each city, when possible, on OSM or from 
authoritative data by contact with the cities, and else resort to a manual delimitation. If the 
administrative area is composed of multiple non-intersecting polygons, we take only the 
largest and most central one. For instance, we exclude Weesp out of the administrative 
boundaries of Amsterdam. This filtering ensures the connectivity of the extracted network.  

https://github.com/csebastiao/walkability_JS
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The use of administrative areas has limitations. They represent the area on which the city 
partners have agency on, but the administrative area is not isolated in practice and multiple 
city definitions exist in the literature, for example based on the built area or on social and 
economic flows. These different definitions could lead to diverging results (Oliveira et al., 
2014).  

Intersection density  

In cities, the share of walking trips is well correlated with intersection density (Ewing & 
Cervero, 2010). In our simplified street network created with the OSMnx Python package, 
each node is an intersection, and each link is a street segment connecting two nodes. By 
computing node density, we can compute the density of intersections, acting as a proxy for 
the walkability of an area.  

We show as an example Southwark in Figure 46, where we can clearly identify by the 
intersection density that the northern part is closer to the highly walkable downtown area in 
London, whereas the southern part is more suburban.  

We observe multiple limitations:  

• The network is simplified as only intersections are nodes, but not all intersections 
would be called intersections in practice. A two-way street crossing another two-way 
street could create 4 intersections for a single crossing, as each link would represent 
a different road. To avoid this issue, we should simplify topologically the network, but 
it is a very time-consuming task to do manually and still an open problem in the 
literature to do reliably automatically.  

• We do not account for a buffer zone beyond the boundaries of the administrative 
area, which likely underestimates the accessibility and walkability of peripheral areas. 
An extension of the method to account for a buffer is straightforward.  

• We use the road network as a proxy for the pedestrian network to be able to 
consistently extract it, but not every road has sidewalks on both sides that are wide 
enough for everyone to walk on, including wheelchair mobility, leading to an 
overestimation of walking accessibility. Creating a reliable pedestrian network within 
cities is still an active area of research (Merlin & Jehle, 2023).  
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Figure 46. Intersection density in Southwark (kernel density estimate). No coloring indicates an 
intersection density below 40% of the maximum density.  

Accessibility  

Following the 15-minute city concept, living in a feel free to cut or merge it with 3.1.2 if 
needed walkable neighborhood is described here as living in an area where you can fulfil all 
necessary urban functions by foot in 15 minutes. In the original definition, these urban 
functions include “(a) living, (b) working, (c) commerce, (d) healthcare, (e) education and (f) 
entertainment.” (Moreno et al, 2021).  

We assume that if we measure a link being populated, then (a) is fulfilled. Concerning (b), 
“working”, this is a too context-sensitive function that also correlates or depends on all other 
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urban functions; therefore, we will not measure (b) separately. From (c) to (f), we use tagged 
values on OpenStreetMap that are mapped to each urban function (see Table 8).  

Note that there is not a single commonly accepted mapping of amenities to urban functions 
in the literature, nor what is considered to be an acceptable number of amenities. For 
instance, does having a single theatre in a 15-minute radius count as fulfilling the need for 
entertainment? For simplicity, the results shown here are calculated using a single amenity in 
each urban function as a threshold. For a broader perspective, the results should be 
compared to similar studies using OSM (Bruno et al., 2024). As our code is open, it is 
straightforward to change the list of OSM tags and urban functions to explore results with 
different assumptions.  

Most studies on accessibility and walkability focus on a fictional “average” individual walking 
with around 4 km/h into every direction, erasing the differences in accessibility based on 
physical capacities. To see how older adults and other populations could be affected by such 
capacity differences, we explore the difference in accessibility for walking at 2 km/h or 5 
km/h, in a 5-minute city or a 15-minute city.  

Table 8. List of accepted OSM keys and tags for each urban function  

Urban function  OSM keys and tags  

Commerce  shop: [convenience, food, greengrocer, 
department_store, mall]  

Education  amenity: [kindergarten, school]  

Entertainment  amenity: [library, arts_centre, cinema, 
community_centre, music_venue, theatre, bar, cafe]  
leisure: [sports_centre, sports_hall, dance, 
fitness_centre]  
tourism: [museum]  

Healthcare  amenity: [clinic, doctors, hospital]  

  

A walking speed and time imply a walking distance, here 167 m or 500 m at 2 km/h, and 417 
m or 1250 m at 5 km/h, respectively. As we can already see, a 5-minute city at 5 km/h would 
be close to a 15-minute city at 2 km/h, giving us a good idea of the potential gap in 
accessibility based on walking speeds.  

As we can see in Table 9, walkability and accessibility are highly dependent on the walking 
speed. Most of the population in Zaragoza (91.3%) is living in a 15-minute city for 5 km/h, but 
only half of them (45.1%) for 2 km/h. In Haifa, there is a near ten-fold increase in accessibility 
(from 5.6% to 49.6%) from 2 km/h to 5 km/h. This sensitivity has implications on walkability 
metrics and policy for the elderly population: To account for all demographics, data and 
models must be created for different walking speeds.  

We can also see that city size is not enough to estimate accessibility. Even in a small city like 
Cugir only a third of the city (33.7%) can be considered a 15-minute city for a 5 km/h walking 
speed.  

Table 9. Share of kilometres in cities that are accessible within 5 or 15 minutes, walking at 2 km/h and 5 

km/h, respectively.  

City  Total length  
(Million kms)  

5-minute city   
(%)  

15-minute city   
(%)  

Amsterdam  7.8  0.1 / 7.6  14.5 / 60.9  

Braga  1.6  0.1 / 8.1  12.4 / 51.9  

Cugir  0.2  0 / 0.2  4.0 / 33.7  
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Haifa  2.0  0 / 2.9  5.6 / 49.6  

Kozani  0.2  0 / 2.8  8.6 / 78.6  

Milan (Muni.)  11.5  0.3 / 15.9  25.0 / 72.0  

Riga  12.4  0.4 / 11.8  18.9 / 62.7  

Southwark  1.7  0.4 / 24.3  36.0 / 86.4  

Vilnius  12.7  0.1 / 5.8  10.4 / 45.0  

Vratsa  0.5  0 / 6.4  10.5 / 48.0  

Westminster  1.6  2.7 / 34.8  47.4 / 96.7  

Zaragoza  3.2  2.6 / 33.4  45.1 / 91.3  

 

The results should be interpreted carefully due to potential data quality issues. OSM is close 
to perfectly complete for the road network (in European countries), sometimes more than 
authoritative data, but still highly heterogeneous and inconsistent in more granular and 
specific data. A small city like Cugir is likely to have less granular data than a rich district of a 
capitol, like Westminster in London, making comparisons between cities difficult.  

Case study Amsterdam 

In Amsterdam we use a precomputed dataset created with the Urbanity Python package. 
Urbanity is using solely open-source data, including OpenStreetMap for the street network 
and amenities, Meta Data for Good High Resolution Population Density Maps for population 
estimation, and the Mapillary Vistas Dataset for Street View Imagery indices.  

Elderly population distribution  

The Meta Population Density map is not only estimating population worldwide but also the 
share of men, women, children, and older adults. Using this data, we can not only know 
which part of the city is checking the criteria of a 15-minute city, but also who is living there. 
In Amsterdam, based on the Meta dataset, the 'Elderly' attribute is relatively well spread over 
the city and represents 79,522 out of 551,277, or 14.4% of the total population.  

Accessibility to amenities  

Urbanity is creating its own categories for urban functions, based on OSM amenities. Using 
them, we take as urban functions the attributes 'Food', 'Healthcare', and 'Entertainment', and 
then run the same analysis as in the general analysis above. As we are not taking into 
account education, we should expect to have a higher accessibility than previously. We get 
0.6 / 10.9% of all kms as a 5-minute city and 16.3 / 54.6% of all kms as a 15-minute city 
when walking at 2 km/h or 5 km/h, respectively.  

Compared with the results of Table 2, Amsterdam is a relatively accessible city, especially for 
small distances, thus low walking speed.  

The results are visualised in Figure 47 and Figure 48. What could be seen as surprising is 
that the most accessible zones are not only and obviously at the heart of the city centre, as 
one could expect. This can be partially explained by the necessity of having all kinds of 
amenities, including some that might not be reachable quickly in more touristic areas 
focusing on commercial activities such as healthcare and education. Another striking result is 
that for a walking speed of 5 km/h, we get a large, connected component connecting most 
edges that are following the 15-minute city definition, but not for 2 km/h.  
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Figure 47. Map of Amsterdam that is a 5-minute city or a 15-minute city when walking at 2 km/h.  

  

  

Figure 48. Map of Amsterdam that is a 5-minute city or a 15-minute city when walking at 5 km/h.  

  

Assessing the accessibility for the population, 2,826 citizens or 0.5% have access to 
necessary amenities within the 5-minutes range at 2 km/h, increasing to 67,655 or 12.3% at 
5 km/h. 100,227 or 18.2% have access to necessary amenities within the 15-minutes range 
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at 2 km/h, increasing to 330,355 or 59.9% at 5 km/h. Except for the 5 minutes walking at 2 
km/h, we observe that the areas of higher accessibility are more populated. We get very 
similar results for the total population (under the 'PopSum' attribute), older adults only 
('Elderly'), and younger adults only ('PopSum' removing 'Elderly' and 'Children'). By changing 
the walking speed from 2 km/h to 5 km/h there is a 35-fold increase in the satisfied 
population for the 5-minute city, and a 5-fold increase for the 15-minute city.  

Street appeal  

Walkability is not only about having the necessary amenities nearby, as also a favorable 
public environment will increase the desire to walk. Using Street View Imagery, we can 
measure the amount of Greenery and Visual Complexity that are respectively positively and 
negatively correlated with desirability of a street. These metrics can be combined to create a 
desirability index based solely on street view imagery, see Figure 49.  

This index is well correlated with the presence of green areas such as Sloterpark, but can 
also be misleading, classifying the large industrial harbour Westpoort as highly desirable.  

Contrasting Figs. 3 and 4, we see that the presence of greenery is not well correlated with 
high accessibility. The highest desirability for a 5-minute city at 2 km/h is at 53% of the 
highest desirability (at the Uilenstede station), while at 5 km/h it is at 80% of the highest 
desirability (at the park Frankendael). One obvious limitation of using only greenery as a 
proxy for desirability, especially visible in the case of Amsterdam, is that it is not taking into 
account blue areas that are also considered desirable.  

 
Figure 49. Map of the desirability of streets in Amsterdam.  

  

5.8 Potential future work  

Topography as a barrier  

With access to data on the topography of a city, one could know how steep each street is. A 
too steep street can act as an inhibitor or even as a barrier for some demographics, including 
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older adults. What happens to the street network if we remove every street of steepness 
higher than a certain threshold? When and where does it disconnect, how is the circuity 
impacted? Such aspects could change the accessibility indices by making amenities either 
unreachable, or reachable only through a long detour. Open topography data can be found at 
a worldwide scale in the Shuttle Radar Topography Mission dataset.  

Comparison to known indicators  

Walkscore® is a well-known walkability index privately computed, measuring the distance to 
nearby amenities classified in different categories. This is a similar methodology to the one 
demonstrated by our method. To validate our results, it could be useful to compare ours to 
the one made by a well-positioned tool in the field.  

Mobility and incidents  

Knowing the origins and destinations of the population or specifically older adults, we could 
know which areas they frequent, and which streets are taken. By linking this knowledge to 
the locations of incidents within the city, we could highlight the areas to prioritize for 
increased safety, visibility, and security. Studies on safety, security, and visibility, are very 
dependent on such granular data that is typically not open.  

As shown throughout the report, there is a large array of publicly available datasets that can 
provide rich insights but require a wide array of skills in GIS, Network Science, and Computer 
Vision. Some datasets could be enhanced with administrative data, such as the population 
distribution, which might be of varying quality in different countries. Adding Origin-Destination 
matrices, a mapping of known incidents, or emotive measures of pedestrians, could enrich 
the analysis and allow for a deeper understanding of the specific challenges of walkability for 
older adults.  
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Figure 50. Overview of requirements and applicability of GIS analysis on walkability, accessibility, 
visibility, safety and security 
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6. Conclusions 

This deliverable provides an exhaustive and practical summary of the work carried out for 
Task 3.1, entitled “Analysis of the needs and mobility behaviours of active road users and 
integration with cross-domain data”, which forms part of Just Streets Work Package 3, titled 
“Just Improve”. 

The document illustrates methods and tools for analysing the needs, behaviours and mobility 
patterns of active road users, with a particular focus on the social groups that are most 
exposed to traffic risks and that are traditionally less involved in decision-making processes 
regarding the use of public spaces. It proposes approaches and guidelines for making urban 
areas safer, more inclusive and welcoming, and for promoting active mobility and responding 
to the needs of marginalised communities, in line with the JUST STREETS project's 
objectives. 

Adopting a multidisciplinary approach ranging from transportation engineering to the social 
sciences, the document combines theoretical reflections and explanations of various 
qualitative and quantitative methodological approaches with practical examples of how these 
can be applied. 

The quantitative and qualitative methods presented in this document are not intended to be 
mutually exclusive, but rather to be combined synergistically to reinforce each other. The 
quantitative approach is based on statistical analysis and the collection of numerical data, as 
well as the construction of predictive models. This allows trends and correlations to be 
identified, the impact of interventions to be measured, and decisions to be guided in the 
planning and design phase. In contrast, the qualitative approach focuses on understanding 
behaviours and the social dynamics that influence them, using methods such as interviews, 
participant observation and focus groups. This type of investigation considers the 
experiences of the people and communities who live with and use public spaces on a daily 
basis and, therefore, has the potential to promote processes of participation and shared 
learning. Integrating the two approaches offers a richer, deeper perspective on urban 
mobility: quantitative data enables us to describe and generalise phenomena, while 
qualitative analysis helps us understand the motivations, contexts and perceptions behind 
them. Together, these methods can provide a solid basis for a better understanding of 
mobility needs and behaviours. This knowledge is essential for developing policies and 
interventions that can make streets safer, more inclusive and more sustainable. 

This deliverable is therefore an essential resource for the pilot and follower cities directly 
involved in JUST STREETS, as well as for urban planners, road engineers, policymakers, 
community organisations, and researchers who wish to collect and analyse data and 
knowledge to create fairer, safer, healthier, and happier streets. 


